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Chapter 1 Hello_World

This example realizes printing out “Hello World” from serial port, which
does not involve the development of the FPGA terminal, but ZYNQ s ARM and FPGA
development are very close, through Hello World you can be familiar with the
development environment of the FPGA.

1.1 New Vivado Project

Click on "Create Project" to build a new project

# Vivado 20201
Fle Fow Tods Window Help ‘Q-GuickAccess

VVADO!

HLx Editions

Quick Start

'-'-F'.._ oject Y
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Click Next

VlVADO [ Create a New Vivado Project

HLx Editions This wizard will guide you through the creation of a new project.

To create a Vivado project you will need to provide a name and a location for your project files. Mext, you
will specify the type of flow you'll be working with. Finally, you will specify your project sources and
choose a default part

& XILINX

ALL PROGRAMMABLE.

@

Enter project name and save path

A New Project x|

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. '

Projectname:  hello_world
Project location: D:/FZ3/4GB E

Create project subdirectory

Projectwill be created at: D:/FZ3/4GBMello_world
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Click Next

Project Type
Specify the type of project to create. ‘

« RTLProject
You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis,
implementation, design planning and analysis.

Do not specify sources at this time

Post-synthesis Project: You will be able to add sources, view device resources, run design analysis, planning and
implementation.

10 Planning Project
Do not specify design sources. You will be able to view partipackage resources.

|mported Project
Create a Vivado project from a Synplify, XST or ISE Project File

Example Project
Create a new Vivado project from a predefined template

@

Click Next

Add Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new
source file on disk and add it to your project. You can also add and create sources later.

+

a

Use Add Files, Add Directories or Create File buttons below

Add Files | ‘ Add Directories ‘ ‘ Create File

Targetlanguage:  Verilog w Simulator language:  Mixed i

@
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Click Next

Add Constraints (optional)

Specify or create constraint files for physical and timing constraints. ‘

Use Add Files or Create File buttons below

Copy constraints files into pro

A Ne x ]
Default Part |
Choose a default Xilinx part or board for your project [

Parts | Boards
Reset All Filters
Category. Al v Package: | sic784 v Temperature: E v
Family | Zynq UliraScale+ MPSoCs - Spesd: | -1 ~ Staticpower. | All Remaining v
Search: O -
Part UOPin Count  Available I0Bs  LUT Elements  FlipFlops  BlockRAMs ~ UltaRaMs DSPs  GbTranscelvers GTPE2 Transcel
xczu2cg-sfvc784-1-e 784 252 47232 94484 150 0 240 o 0 -~
xczuzeg-sfc784-1-e 784 252 47232 94464 150 0 240 o 0
Xczuldcg-sivc784-1-e 784 252 70560 141120 216 0 360 o 0
Audeg-shCTB4-1s 784 262 70560 141120 216 o w0 0 0
xzudcg-sheTad-le 784 252 87840 175680 128 8 728 4 0
xczudeg-sfc7B84-1-e 784 252 87840 175680 128 48 728 4 0
xczudev-sfuc784-1-2 784 252 87840 175680 128 48 728 4 0
Xucg-shcTad1-e 784 282 17120 234240 144 84 1248 4 0
acuBeg-shCTB4- 1o 784 252 17120 234240 144 5 128 4 0 ‘
R - - - - - - v

| - ' ]

@

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com 8 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/

MYi R IRIREBX MYD-CZU3EG
Make Your Idea Real FPGA F & FM

Click Finish

VIVADO g New Project Summary

HLx Editions

o Anew RTL project named "hello_world” will be created.
Mo source files or directories will be added. Use Add Sources to add them later.
Mo constraints files will be added. Use Add Sources to add them later.

€ The default part and product family for the new project:
Default Part: xczu3eg-sfvc784-1-e
Product Zyng UltraScale+
Family: Zyng UltraScale+ MPSoCs
Package: sfvc784
Speed Grade: -1

o
‘A XI LI NX To create the project, click Finish

ALL PROGRAMMABLE.

@

Generated vivado project

¢ hello_world - [Ci/Users/tw/Desktop/hello_world/hello_worldxpr] do 2017,
File  Edit Flow Tools Window Layout View  Help Q- Quick Access
= » B B ¥

4

Flow Navigator d PROJECT MANAGER - hello_world

~ PROJECT MANAGER

Sources 2 _0O00 X Project Summary
ﬂ Settings
a T ¢ + 0 o _ _
Add Sources Settings  Edit
Design Sources
L T late j
anguage Templates s Constraints Project name: hello_waorld
T Catalog - Simulation Sources Project location: C:/UsersfiwiDesktop/hello_world
sim_1 Product family: Zyng UltraScale+
¥ IPINTEGRATOR Project part xczuleg-shciss-1-e
Create Block Design Top module name: Mot defined
T t1 Veril
Open Block Design argetlanguage eniog
Simulator language: Mixed
Generate Block Design
Hierarchy  Libraries Compile Order .
v SIMULATION Siiers
Run Simulation Properties > _Omx Status: Mot started
'ﬂ Messages: Mo errors or warnings
¥ RTLANALYSIS Part xczu3eg-sivc784-1-e
> Open Elaborated Design Strategy: Vivado Synthesis Defaults
Report Strategy: Vivado Synthesis Default Reports
~ SYNTHESIS
P Run Synthesis Select an object to see properties
> Open Synthesized Design DRC Violations

Run implementation to see DRC results
~ IMPLEMENTATIOM

P Run Implementation

> OpenImplemented Design TclConsole | Messages | Log | Reports | Design Runs  x
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1.2 New Block Design

Click Create Block Design

¢ hello_world - [D/FZ3/4GB/hello_world/hello_warld.xpr] - Vivado 2020.1
File Edit Flow Tools Reparts Window Layout View Help Q- Quick Access
&, L - 2 >

Flow Navigator e PROJECT MANAGER - hello_waorld

~ PROJECT MANAGER

Sources 2
Q = & + 0

Design Sources

L Settings
Add Sources

Language Templates “ Constraints

IF IP catalog constrs_1
w Simulation Sources
¥ |P INTEGRATOR gim_1

Create Block Design +.. ’ Utilty Sources
Open Block Design

Generate Block Design

Hierarch Libraries Compile Order
v SIMULATION v -

Run Simulation X
Properties 2

~ RTL ANALYSIS

> Open Elaborated Desiagn

Click OK

¢ Create Block Design X

Please specify name of block design.

Design name: ps_module
Directory: « =Local to Project= 4
Specify source set: Design Sources w

@
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1.3 Add PS IP Core and Configure

Click Add IP to add IP core

Diagram 200X
om0 + ® C bl
V- 4
This design is empty. Press the + button to add IP.
Add IP
Enter mpsoc, then double-click Zynq UltraScale + MPSoC to add the MPSoC core
Diagram ?00X
HoN o + = C &%
Search: - mpsoc (1 match)

4F Zynq UltraScale+ MPSoC

This design is empty. Press the =4 button to add IP.

ENTER to select, ESC to cancel, Cirl+Q for IP details

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com
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The Zyng MPSoC core is shown in the following figure

Diagram  x Address Editor  x 00
Q F Q + = # B C YU &
r 2y ultra_p: ] 1

u
YNQ M_AXI_HPMO_LPD +
; - )
+
C HHraSLALE? 4

Double-click zyng MPSoC core to import configuration file

The first interface is the architecture diagram of the zynq hard core. You can see its structure
clearly. You can refer to the ugl1085 document, which has a detailed introduction to zyng. The
green parts in the figure are configurable modules. You can click to enter the corresponding
editing interface, or you can enter editing interface in the left window. The following describes

the configuration of each window, refer to pg201.

| Zynq UltraScale+ MPSoC (3.3) ' |
L
! @ Documentation IP Location
UI Page Navigator - PS UltraScale+ Block Design
- Configurable ——0
|| Switch To Advanced Mode FFD —
P8 UltraScale+ Block Design APU |
PS-PL
1i0 Configuration M
(o] CClI H
| pe
X
s [[0d] e
<>l ooz aewe o] S 0 L
g 1 — :
g £
) ] =
- _— 3y
i
! 5
| FPD_DMA i
<rLome [[canrv] : i
-—
‘ iy 2
z
, ¥ |
:
q L] it
r, L r
g5
2l
csu PMU DDR Contraller _a
] Lol (DDR3, DDR4, LPDDR3, LPDDR4) R

:

1. Voltage configuration
In the T / O configuration window, configure the voltage of bank0 "~ bank2 as

lvemos18 and bank3 as lvcmos33.
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4 4% Re-customize IP
I
Zyngq UltraScale+ MPSoC (3.3)
@ Documentation IP Location
Page Navigator - 1i0 Configuration
() Switch To Advanced Mode ~ MIO Voltage Standard
Bank0 [MIO 0:25] | | Banki [MIO 26:511 | | Bank2 [MIO 52:77] |  Bank3 [Dedicated]
PS UltraScale+ Block Design
LVCMOS18  « LVCMOS18 LVCMOS18  + LVCMOS33
1i0 Configuration
Clock Configuration «|Q = ]
1 Search: O
i€ DDR Configuration
Peripheral o Signal
P pspL Configuration > Low Speed
> High Speed
» Reference Clocks
i
E
E
P
b
s
al
al
al
o
-

ped

Direction

Pull Type

10 Type  Drive Strength(mA)  Polarity Speed

2. Low Speed configuration

Check QSPI and set it to

”single” mode and data mode to “X4”

3 4% Re-customize IP x H
I
Zyng UltraScale+ MPSoC (3.3) s/
@ Documentation IP Location
Page Navigator - 'O Configuration
("] Switch Te Advanced Mode ~ MIO Voltage Standard
Bank0 MIO 0:25] | | Bank1 [MIO 26:51] | Bank2 [MIO 52.77] | Bank3 [Dedicated]
PS UltraScale+ Block Design
LVCMOS18 LVCMOS18  « LVCMOS18 LVCMOS32
10 Configuration
Clock Configuration - Q E %
4 " Search: Q-
i¢ DDR Configuration
Peripheral 1o Signal {0 Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
P
PSPLC: < Low Speed A
~ Memory Interfaces
v[v) aspP Single v
QSPI Data Mode x4 ~
> QSPIIO MCo.5
3 () Feedback Clk
It —
>[_] NAND
v 8D
> sDo MIO13 .22 v
-
=
v[@ SD1 MIO 46 . 51 v
B
1 Slot Type SD20 v
: Data Transfer Mode | 4Bit ~
H MIO 45 v
- — )
! < »
m
-
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Select SD 0 and configure EMMC. Select miol3.. 22, slot type EMMC, data transfer

mode 8bit,

check reset, and select mio23.

Re-customize IP

[

@ Documentation IP Location

Page Navigator
("] Switch To Advanced Mode
PS UltraScale+ Block Design
110 Configuration
Clock Configuration

i€ DDR Configuration

PS-PL Configuration

Zynq UltraScale+ MPSoC (3.

X B
3) ‘
/O Configuration
~ MIO Voltage Standard
Bankd [MIO 0:25] | | Bank1 [MIO 26:51]| | Bank2 MIO 52:77)| | Bank3 [Dedicated]
LVCMOS18 LVCMOS18  ~ LVCMO318 LVCMOS33 ~ I
« Q0 = %
Search: | O
Peripheral o Signal 0 Type  Drive Strength(mA)  Polarity Speed  Pull Type  Direction
> [) NAND ~ L
-
~ 8D
v sDo MO 13, 22 -
Data Transfer Mode | 8Bit ~
[+ Reset MO 23 ~
SD10 MIO13 sdio0_data_out[0] schi v | 12 w | Del v St w | pullu v || inout
SD0 MIO14 sdio0_data_out[1] schl ~ 12 w  Del «~ sk ~ pullu ~ | inout -
SD0 MO15 sdio0_data_out[2] schl «» 12 w | Del w st v  pullu s | inout
sD0 MIO16 sdio0_data_out[3] schi » 12 w  Del v~ sl v  pullu & | inout
SD0 MIO17 sdio0_data_out[4] schl ~ 12 w  Del «~ sk ~ pullu ~ | inout -
SD0 MO18 sdio0_data_oul[5] schl «» 12 w | Del w st v  pullu s | inout
( snn Min1a sdinf data ol arhi s || 12 w Dl sl e ol ae inont ;.V

Select SD 1 and configure SD card. Select Mio 46.. 51, slot type SD 2.0, data
transfer mode 4bit, CD to detect SD card insertion, mio45, WP, mio44 for SD card
write protection .

4 4% Re-customize IP xR
I
Zynq UltraScale+ MPSoC (3.3) ‘
@ Documentation IP Location
Page Navigator - /O Configuration
("] Switch To Advanced Mode ~ MIO Voltage Standard
P8 Ulragesle Blsck Design Bankd [MIO 0:25] | | Bank1 [MIO 26:51]| | Bank2 MIO 52:77)| | Bank3 [Dedicated]
LVCMOS18 LVCMOS18 LVCMOS18 LVCMOS33 I
IO Configuration r
Clock Configuration « 0 £ =
i€ DDR Configuration Searcn: |-
Peripheral o Signal /0 Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
A PS-PL Configuration 5[] NAND ~ R
~ 8D
>[v sD0 Mo 13 22 -
v[v]SD1 MIO 46.. 51 -
Slot Type sD20 ~
; Data Transfer Mode
MIC 45 ~
[ Pawer
£ @ wp MIO 44 v
‘; s01 Mo44 sdiol_wp schi v || 12 v | Del v faz o pulu v n o
5 SD1 MIO45 sdiol_cd_n schl » 12 w  Del v faz +~  pullu ~ | in v
;: 301 MIO46 sdio1_data_out[0] schi | 12 v | Det w sk v pullu v | inout
A n sD1 Moa7 sdio1 data out[1] schi « || 12 w || Del w | slc ~ | pullu s || inout \)/V
o
-
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Tick can 1 and select Mio 24.. 25
Tick I2C 0, select Mio 42.. 43; tick I2C 1, select mio32.. 33
Tick serial port UART 0, select MIO 34.. 35, tick gpiol MIO, gpioO MIO

3| #% Re-customize IP x
Zynq UltraScale+ MPSeoC (3.3) '

@ Documentation '~ IP Location

Page Navigator - IO Configuration

() Switch To Advanced Mode ~ MIO Voltage Standard

Bankd [MI0 0:25] | | Bank1 [MIO 26:51] | | Bank2 [MIO 52:77] | | Bank3 [Dedicated]
PS UltraScale+ Block Design

LVCMOS18 LVCMOS18  ~ LVCMOS18 LVCMOS33  ~
/0 Configuration

=z | a
= 5

Clock Configuration « Q

Search: Q-
DDR Configuration
Peripheral 1o Signal VO Type  Drive Strength(mA) ~ Polarity Speed  Pull Type  Direction

PS-PL Configuration > GAND ~

B > [ CAN 1 Mo 24 .25 v

v 12C

> 12C0 MO 42 43 v

> (¥ 12C 1 W0 3233 “

) PITAG
> [ PMU
[Jesu
v Pl
> sPlo
T >[]SPI1

~ UART

> [¥] UART 0 MO 34.35 v

>[J UART 1
v GPIO

] GRIOEMIO

d > [¥] GRIOD MIO MO0 .25 v

> ¥ GPIOT MO MIO 26 .. 51 v

(] GPIOZMIO

> Processing Unit
-

Tick SWDT 0. SWDT 1
Tick TTC 0°TTC 3
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4 4% Re-customize IP xR
I
Zyngq UltraScale+ MPSoC (3.3) ‘
@ Documentation IP Location
Page Navigator - 1i0 Configuration
() Switch To Advanced Mode ~ MIO Voltage Standard

Bank0 [MIO 0:25] | | Bank1 [MIO 26:51]] | Bank2 [MIO 52:77] | | Bank3 [Dedicated]
PS UltraScale+ Block Design

LVCMOS18  « LVCMOS18 LVCMOS18  + LVCMOS33
10 Configuration -

Clock Configuration « O = %

Search: O

DDR Configuration
Peripheral o Signal "0 Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
PS-PL Configuration S UART ~ B

» GPIO

~ Processing Unit

—
~ SWDT

> W) SWDTO
L > ) SWDT 1
>[]) Trace
~ TTC

> TTCO

> High Speed
! » Reference Clocks
o < b

3. High Speed configuration
The High Speed part first configures PS Ethernet, tick GEM 3, select MIO 64..75, tick
MDIO3, select MIO 76..77

4 4% Re-customize IP xR
I
Zyngq UltraScale+ MPSoC (3.3) ‘
@ Documentation IP Location
Page Navigator - 1i0 Configuration
() Switch To Advanced Mode ~ MIO Voltage Standard

Bank0 [MIO 0:25] | | Bank1 [MIO 26:51]] | Bank2 [MIO 52:77] | | Bank3 [Dedicated]
PS UltraScale+ Block Design

LVCMOS18  « LVCMOS18 LVCMOS18  + LVCMOS33

1i0 Configuration r
Clock Configuration «|Q = ]
i€ DDR Configuration Search: | Q-
Peripheral o Signal "0 Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
P Ps-PL Configuration > Processing Unit 18
~ High Speed
~ GEM

> GEMO

»[] GEM1
s 5[] GEM2
1 [~ GEM 3 MO 64 .75 v

> MDIO 3 MO 76 .77 v

- Gem 3 MIOB4 rgmii_tx_clk cme v || 12 ~w Del « |slc »+ opullu v out
E
a Gem 3 MIOBS rgmii_txd[0] cme v || 12 ~w Del « |slc »+ opullu v out
A Gem 3 MIOGE rgmii_bed[1] cme v || 12 ~w Del « |slc »~ opullu v out
L Gem 3 MIOBT rgmii_bxd[2] cme v || 12 ~w Del « |slc »~ opullu v out
| Gem3 MIOES rgmii_txd[3] cme v || 12 v Del v slc v pulu v | out o
a
H < )v

tick USB 0, select MIO 52..63, tick USB 3.0, select GT Lanel
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A 4% Re-customize IP
Zyngq UltraScale+ MPSoC (3.3)
@ Documentation IP Location
i Page Navigator - 10 Configuration
() Switch To Advanced Mode ~ MIO Voltage Standard
Bank0 [MIO 0:25] | | Banki [MIO 26:511 | | Bank2 [MIO 52:77] |  Bank3 [Dedicated]
PS UltraScale+ Block Design
LVCMOS18  « LVCMOS18 LVCMOS18  + LVCMOS33
1i0 Configuration
Clock Configuration «|Q = ]
Search: O
DDR Configuration
Peripheral o Signal 110 Type
- P3-PL Configuration > Low Speed
' ~ High Speed
> GEM
b ~ USB
~ USBO
> usBO MO 52 .63 -
i »[¥UsSB 3.0 GT Lanet -
> UsSB1
M » USBReset Boot Pin ~
| » v PCle
1 Display Port
a > [ SATA
{
£ » Reference Clocks
5
I
I
Il
i

Drive Strength(mA)

Direction

Polarity Speed

Pull Type

Tick PCle, Lane Selection select x1, Reset select MIO 31;
select MI0 27..30, Lane Selection select Dual Higher

tick Display Port, DPAUX

A 4% Re-customize IP X
Zyngq UltraScale+ MPSoC (3.3) [
@ Documentation IP Location
i Page Navigator - 10 Configuration
() Switch To Advanced Mode ~ MIO Voltage Standard
Bank0 [MIO 0:25] | | Banki [MIO 26:511 | | Bank2 [MIO 52:77] |  Bank3 [Dedicated]
PS UltraScale+ Block Design
LVCMOS18  « LVCMOS18 LVCMOS18  + LVCMOS33
1i0 Configuration
Clock Configuration «|Q = ]
Search: O
DDR Configuration
Peripheral o Signal "0 Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
-l P8-PL Configuration ~ High Speed "
f > GEM
> UsSB
b [ PCle
» Rootport Mode Reset MO 31 v
Reset Polarity Active Low v
i Lane Selection x1 -
PCle Lane0 GT Lane0
M
1 » DPAUX MO 27 30 ~
1 ~ Lane Selection Dual Higher v
3 DP Lane0 GT Lane3
{ DP Lanel GT Lane2
t
J ) .
D < >
I
Il
i
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At this point, the 10 part of the configuration is complete.

4. Clock configuration

In the Clock Configuration interface, Input Clocks window configures reference clock,
Among them, PSS_ REF_ Clock is the reference clock of arm, which is 33.333MHZ by
default; PCle select Ref CIkO, 100MHz; Display Port select Ref Clk2,27MHz; USBO select
Ref Clkl, 26MHz.

Zynq Ultracale+ MPSoC (3.3) / |

@ Documentation IP Location
‘«I Page Navigator - Clock Configuration

[+ Switch To Advanced Mode | 'PutClocks J Ouiput Clocks

« Q = %
PS UltraScale+ Block Design

Search: Q-
1i0 Configuration
o Name Source
p——
I Clock Configuration I + Input Reference frequency "

P8S_REF_CLK PS_REF_CLK 33.333 27.00:60.00

| DDR Configuration - GT Lane Reference frequency
4 PS-PL Configuration FCle RefCIKO  ~ 100 ~ 100
| Display Port RefClk2 v || 27 v |27
‘C_ Advanced Configuration

usBo RefClk1 v || 26 v 26
7| PCle Configuration Peripheral Reference frequency

Isolation Configuration

m

The clock of PL remains the default, which is the clock provided for the PL
logic.

TTC2 AFPB ~ 100.000000 100.000000 0.0000

TTC3 AFPB ~ 100.000000 100.000000 0.0000

~ PLFabric Clocks

[+ PLO RPLL ~ 100 8 1 99.999001 0.0000...
i; [prLr RPLL 100 8 1 99.999001 0.0000...
| [JPL2 RPLL 100 g 1 99.999001 0.0000...
~| [JPL3 RPLL 100 4 1 100 0.0000...

~ System Debug Clocks
DBG_LPD 10PLL v 250 6 240.097498 0.0000...

For the Full Power part, the others will remain the default, and the DP_VIDEO will be
changed to VPLL, DP_ Audio and DP_ STC changed to RPLL.
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~ Full Power Domain Clocks
> ProcessoriMemory Clocks

~ PeripheralsilO Clocks

DP_VIDEO VPLL ~ | 300 5 1 299.997009 0.0000
Ni DP_AUDIO RPLL ~ | 25 18 1 24999750 0.0000
1 DP_STC RPLL ~ 27 15 1 26 666401 0.0000
,‘_,' PCIE 10PLL ~ 250 2 249997498 0.0000
:‘ SWDT1 APB 99.999001 99999001 0.0000
a » System Debug Clocks
b > Advance Clocks M
ol
The bottom interconnect is modified as follows
1 ~ Advance Clocks
IE- > Low Power Domain
Ni ~ Full Power Domain

~ Interconnect and Switch clocks

!- FPD_DMA DPLL ~ 600 2 599994019 0.0000
i
i) DPDMA DPLL ~ 600 2 599994019 0.0000
; TOPSW_MAIN DPLL ~ 533333 3 399 996002 0.0000
o TOPSW_LSBUS 10PLL ~ 100 5 99999001 0.0000
1l ud
Dl
Dl
ol

The other parts remain the default, so far, the clock part is configured.

5. DDR Configuration
In the DDR Configuration window, Load DDR Presets select
“DDR4_MICRON_MT40A256 M16GE_083E”

A4 Re-customize IP ®
Zyngq UltraScale+ MPSoC (3.3) [
@ Documentation IP Location
Page Navigator - DDR Configuration
[ Switch To Advanced Mode Enable DOR Controller
PS UltraScale+ Block Design Load DDR Presets | Custom v
DDR4_KINGSTON_KVRZ15E1558
/0 Configuration Clocking Options
Clack Configuration Requested Device F DDR4_SAMSUNG_K4ABG165WB_BCRC Frequency -1199 988037
Custom

DOR Controller Options

- PS-PL Configuration
Memory Type  DDR 4 ~ Effective DRAM Bus Width 64 Bit ~

Components  Compaonents ~ ECC Disabled ~

DDR Memory Options

Speed Bin (use tooltip) DDR4 2400P DRAM IC Bus Width (per die) 16 Bits ~

I Cas Latency (cycles) 16 DRAM Device Capacity (per die) | 8192 MBits v
RAS to CAS Delay (cycles) (16 Bank Group Address Count (Bits) |1

| Precharge Time (cycles) 16 Bank Address Count (Bits) 2
? Cas Write Latency (cycles) 12 Row Address Count (Bits) 15
]? tRC (ns) 4532 Column Address Count (Bits) 10
-i tRASMIN (Ns) 32 Dual Rank O
D v
i

The parameters are modified as follows
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M 4 Re-customize IP
Zyngq UltraScale+ MPSoC (3.3)
@ Documentation IP Location
i Page Navigator - DDR Configuration
(] Switch To Advanced Mode Requested Device Frequency (MHz) 1200 Actual Device Frequency :1199.988027
PS UltraScale+ Block Design
DDR Controller Options
1i0 Configuration
Memory Type DDR 4 - Effective DRAM Bus Width 64 Bit
Clock Configuration
Components Components v ECC Disabled
DDR Configuration
- PS-PL Configuration DDR Memary Options
L Speed Bin (use tooltip) DDR4 2400R DRAM IC Bus Width (per die) 16 Bits
- Cas Latency (cycles) 16 I DRAM Device Capacity (per die) | 8192 MBits
RAS to CAS Delay (cycles) 16 Bank Group Address Count (Bits) |1
Precharge Time (cycles) |16 Bank Address Count (Bits) 2
i Cas Write Latency (cycles) 12 I?nwAddress Count (Bits) 16
u tRC (ns) 4532 Column Address Count (Bits) 10
| tRASMIN (ns) 32 Dual Rank O
4 TFAW (ns) 300
{ DOR Size (in Hexa) 0xFFFFFFFF (4GB)
1 Additive Latency (cycles) 0
3
D ~ Other Options.
I
I
I
I

6. PCle Advanced Configuration

Click on the Switch To Advanced Mode, select PCle Configuration, DEVICE PORT TYPE

select ROOT PORT.

Zynq Ultracale+ MPSoC (3.3)

@ Documentation IP Location

‘«I Page Navigator - PCle Configuration

Switch To Advanced Mode Enable PCle under /O Configuration->High Speed-=PCle before you can configure it.

PS UltraScale+ Block Design « QO = =
/0 Gonfiguration Search: Q-
Name Select
Clock Configuration - Basic Sefiings
DDR Configuration Device Port Type Root Port ~
umber of Lanes X1
-1 PS-PL Configuration Link Spesd 5.0Gbis -
¢ Advanced Configuration Max Payload Size 256 bytes ~
CRS Software Visibility O

~ Device IDs

~ Initial ID Values

Isolation Configuration

VendorID 0x10EE

i% Device ID w0011
Revision ID 0x0

’\1 Subsystem Vendor ID Ox10EE

I Subsystem 1D 0x7

;[,  Class Code

1

£ Base Class 0x08

k| Sub Class 0x80

Dl

il Interface 0x0

o

n

o
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Click OK to complete the configuration and connect the clock as follows:

zyng_ultra_ps_e_1

M_AXI_HPMO_FPD +|ii
maxihpm0_fpd_aclk pl_resetn0
® pl_clkO

UltraSCALE*

Zynq UltraScale+ MPSoC

1.4 Generate synthesis files

Right click ps_module->Generate Ouput Products->Generate

BLOCK DESIGN - ps_module

Sources % Design Signals 2 _ 0O

Q = £ 4+ A 1 ]
w Design Sources (1)
’ copsT Source Mode Properties... Cirl+E

> Constraints
& OpenFile Alt+C
> Simulation &

% Utility Sourc Create HOL Wrapper...

Yiew Instantiation Template

Generate Qutput Products...

Hierarchy IP ¢ Reset CGutput Products...
Source File Prope W
ps_module. bd o
Femave File from Project... Delete &
Enabled X
Location: ) di
Disable File =
Type:
Hierarchy Update 3 w
< >
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Click Generate
# Generate Output Products .
The following output products will be generated. ‘
Preview -
Q = =
v 2 [8] ps_module.bd (O0C per IP) A d
= Synthesis
= Implementation
~L Simulation
gt
Synthesis Options
() Global
(@) Qut of context per IP
‘ () Out of context per Block Design [
Run Settings
Mumber of jobs: | 3 [
® [ o
-
1.5 Generating top-level file of FPGA
Select ps_module.bd, Right click --CreateHDL Wrapper
BLOCK DESIGN - ps_module
Sources % Design Signals 2?2 _ O Diagram % Address Editor x
o = 2 4+ y | @ g 3 & O Q +
~ [ Design Sources (1)
) ps_moﬂnln e maadola BAY Y
N Constraints (- Source Mode Properties... Ctrl+E
5 = Simulation S /= OpenFile Al+-O
» [ Utility Sources Create HDL Wrapper...

View Instantiation Template

Generate Output Products...

Reset Qutput Products...
Hierarchy IF So
Source File Propert 4
ps_module.bd | % Remove File from Project... Delete }
Y
Enabled
Mimakla Fila 3 w:!-ﬂ
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Click OK
¢ Create HDL Wrapper > ~
You can either add or copy the HDL wrapper file to the project. Use copy
option if you would like to modify this file. '
F

Options i
::: ::: Copy generated wrapper to allow user edits

@ LetVivado manage wrapper and auto-update

©

1.6 Generate bit files

¢ hello world - [D:/FZ3/4GB/hello_world/hello world.xpr] - Vivade 2020.1
File  Edit Flow Tools Repors  Window  Layout  View  Help Q- Quick Access

&, (] e =

F

Flow Navigator

M4
[
)

2  PRC Generate Bitstream |o_world

~ PROJECT MANAGER

Sources 2?2 _ 001 X Projec
'ﬂ' Settings -

a T & + 0 @ | oven

w Design Sources (1)

Add Sources

Language Templates

> @ 2. ps_module_wrapper (ps_module_wrapper.y) (1) Settir
IF P Catalog > Constraints (1) Proje
> Simulation Sources (1) Proje
¥ |P INTEGRATOR » Utility Sources Prod
Create Block Design Proje
T
Open Block Design op!
Targ
Generate Block Design .
Simu

Hierarchy | IF Sources Libraries Compile Order

W 2RI AT R
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Click Yes

Mo Implementation Results Availabl ||

There are no implementation results available. OK to launch synthesis and implementation?
‘Generate Bitstream” will automatically start when synthesis and implementation completes.

|:| Don't show this dialog again

Click OK
# Launch Runs >
4
Launch the selected synthesis or implementation runs. '
-
Launch directory: | & =Default Launch Directory= 4 L
Options B
:jﬁj: Launch runs on local host: Mumber of jobs: | 3 w
[} Generate scripts anly

SRR, {8

=

E] Cion't show this dialog again

Click Cancel

Bitstream Generation Completed >

o Bitstream Generation successfully completed.

Next
@) Open Implemented Design
() View Reports
() Open Hardware Manager
() Generate Memory Configuration File

E] Dont show this dialog again
TEBR TR IHEE
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You can see that bitstream compiled successfully

Tcl Console Messages Log Reports Design Runs b

Q = = + %
Mame Constraints ~ Status WHNS TNS WHS THS TPWS
w o synth_1 (active) constrs_1 synth_design Complete!

& impl_1 constrs_1 write_bitstream Complete! MA MA A MA 0.000
w Out-of-Context Module Runs

» & ps_module Submodule Runs Complete

1.7 Export Hardware Profile

Click File->Export->Export Hardware->OK on the menu bar to export the hardware
configuration file

¢ hello world - [D:/FZ3/4GB/hello_world/hello world.xpr] - Vivado 2020.1

File Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access

Praoject o S < BN
I Add Saurces... i+ | PROJECT MANAGER - hello_warld
1 Close Project E— PR
Q T ¢ + : o
w Design Sources (1)
Checkpoint 4 » @ 5 ps_module_wrapper (ps_module_wrappery) (1)
P N » [ Constraints (1)
) » Simulation Sources (1)
. Text Editor ' ¥ Utility Sources
Export Export Hardware. ..
Export Bitstream File...
Exit Expott Simulation.. .

+ | Hierarchy | P Sources  Libraries  Compile Order
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Select fixed, click Next

’

Export Hardware Platform =

Export Hardware Platform

VIVADO’

Ly Egitions This wizard will guide you through the export of a hardware platform for use in the Vitis or Petalinux

software tools

To export a hardware platform, you will need to provide a name and location for the exported file and
specify the platform properties

Platform type

(@ Eixed
A platform supporting err fhwar nent only.

) Expandable
A platform supporting acceleration

T O T T |

w

&2 XILINX.

Select include bitstream, click Next

/

Export Hardware Platform >

Output

Setthe platform properies to inform downstream tools of the intended use of the target platform’s hardware design. '

() Pre-synthesis
This platform includes a hardware specification for downstream software tools.

(@ Include bitstream
This-platform includes-the complete-hardware imptementation-and bitstream; in-addition to- the-hardware specification for-———---
software tools.

FEinish Cancel

Select the generated xsa file name and file path, where the xsa name remains unchanged,

and the path is the vitis subfolder under the original path.

i}

’

Export Hardware Platform *

Files

Enter the name of your hardware platform file, and the directory where the XSA file will be stored. '

XSAfile name: ps_module_wrapper

Export to: DuFZ3/4GBhello_worldivitis) ”I‘

The XSA will be written to: DAFZ3WGB\hello_worldwitis\ps_module_wrapperxsa

‘ Finish ‘ ‘ Cancel ‘

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com 26 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/

MYi R JIRKIREB = MYD-CZU3EG
Make Your Idea Real FPGA FFRFMH

1.8 Start Vitis and create new project

Vitis is an independent software, which can be opened by double clicking the vitis
software, or by selecting Tools -- Launch Vitis in vivado software to open Vitis software

HilimeVitis

I ¢ hello_world - [Dy/FZ3/4GB/hello_world/hello_world.xpr] - Vivado 2020.1
File  Edit Flow Tools Reports  Window  Layout View  Help Q- Quick Access

u Create and Package New IP...
Flow Navigator Create Interface Definition. .
v PROJECT MANAGER Enable Dynamic Function eXchange... i
? 00 X Project Summary
o Settings Run Tcl Script...

) - o Overview | Dashboar
Add Sources Property Editor Cirl+J

I Associate ELF Files...
Language Templi

|_module_wrapperv) (1) Seftings  Edit
o Generate Memory Configuration File...
IP Catalog .
Compile Simulation Libraries FOEEHIEE
Project location:
~ |P INTEGRATOR XHub Stores Product family:
Create Block Des Custom Commands r Project part:
i Top module name:
Open Block Desic Launch Vitis IDE P

Target language:
Generate Block D, & Language Templates

& Sefings.. e
Compile Order

Simulator language:

Select the previously created vitis folder and click "Launch"

=) Eclipse Launcher *

Select a directory as workspace

Vitis IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: D:'\Fzg\llGB\hE”D_WDr|d\1.l'iti5 V‘ | Browse...

» Recent Workspaces
» Restore other Workspace

b Copy Settings

® Launch Cancel

After starting Vitis, the interface is as follows.Click "Create Application project". This
option will generate app project and platform from project. The platform project is
similar to the hardware platform of previous versions, including relevant files of
hardware support and BSP.
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«J vitis - Vitis IDE - ] bd
File Edit  Search Xilinx Project Window Help
& [0 Welcome 53 | =5

& Uims
VITIS
IDE

— — —
PROJECT PLATFORM RESOURCES
Create Application Project Add Custom Platform Vitis Documentation
| Create Platform Project Hilinx Developer
I Create Library Project

Import Project

1:he first page is the introduction page. Skip it directly and click next

« New Application Project O X F

Create a New Application Project E %

This wizard will guide you through the 4 steps of creating new application projects.

b i

1. Choose a platform or create a platform project from Vivado exported XSA
I 2. Put application project in a system project, associate it with a processor
| 3. Prepare the application runtime — domain

4. Choose a template for application to quick start development
P

Platform
Project

Processor I Domain

XSA
]
.
- A platform provides hardware information and software environment settings.
= A system project contains one or more applications that run at the same time. t
= A domain provides runtime for applications, such as operating system or BSP.
- A workspace can contain unlimited platforms and unlimited system projects. i

[Jskip welcome page next time. (Can be reached with Back button)

| @ = Back Next = Finish ]

Select “Create a new platform from hardware(XSA)”, open “Browse”, Select the xsa file
you just exported.
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«f New Application Project O =
4 Platform E
Note: A platform project will be generated automatically in workspace for the selected XSA. It can be customized later.

Select a platform from repository | i1 Create a new platform from hardware (XSA)

i Hardware Specification
-| DAFZ3\4GBVhello_world\witis\hello_world.xsa
vek190
26702  Create Platform from XSA X
XSA File: | ;c706 Browse..

Zeu102 &~ v 4 <« 4GB » hello_world » vitis » ~ ] O EmEitis"

zed

mae  mE -y
B ~E A =3

Platiorm name: [helly [ B metadata 2020/11/4 15:11 i
Gormrate boot o = RemoteSystemsTempFiles 2020/11/4 1511 ot
3 = [ hello_world.xsa 2020/10/26 11:59 XSA 3TH#
b B ID ps_module wrapper.xsa 2020/11/4 15:15 XSA i I
o =E ST, XA
- Fh: 728 KB
w FEEE (C) PSR 2020/11/4 1515
- I (D)
- FHEREE (B3 1
- O (F) ol >
ITEFE(N): | ps_module_ wrapperxsa V| *xsa;".dsa; ~ 1

@ < Back Next = Finish Cancel

At the bottom is the Generate boot components option. If this option is clicked, the
software will automatically generate the fsbl project. We generally choose to check it by
default.

-« New Application Project O x

@]

 Platform
Note: A platform project will be generated automatically in workspace for the selected XSA. It can be customized later.

Select a platform from repository |7 Create a new platform from hardware (XSA) E

Hardware Specification

DAFZ3\4GEB\hello_world\vitis\ps_madule_wrapper.xsa

| vek130
| | zc702 E
XSA File: | 2706 Browse...

zcul02
{ zod

DAFZ3\4GB\hello_world\vitis\ps_module wrapperaxsa

Platform name: | ps_module_wrapper

Generate boot components |

@ < Back Next = Finich Cancel
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Fill in the app project name hello_ world. Click in the box to select the corresponding
processor. We will keep the default here. (note that the app project name cannot be the

same as the platform project name, otherwise an error will occur)

¢
— % New Application Project m} Xk
| Application Project Details i
|| Specify the applcation project name and its system project properties
Application project name: [hello_world |
System Project
Create a new system project for the application or select an existing one from the workpsace (@
Select a system project System project details
== Create new...
System project name: | hello_world_system
Target processor
Select target processor for the Application project.
Processor Associated applications
psu_cortexa53_ 0 helle_world 1
psu_cortexa53_1
psu_cortexa53_2 }
psu_cortexa53_3
psu_cortexr5_0
psu_cortexr5_1
psu_pmu_0
psu_cortexa53 SMP
i Show all processors in the hardware specification [i ] L
@ < Back Mext » Finish Cancel
I — O TS AT T TP T ST TS TS T DTG

In the following interface, you can modify the domain name, select the operating system,
arm architecture, etc. here, the default is maintained, and the operating system is
selected as stand-alone, that is, bare machine.

]‘ -« New Application Project [m] e
1 L
Domain
| Select a domain for your project or create a new domain o
| Select the domain that the application would link to or create a new domain r
Note: New domain created by this wizard will have all the requirements of the application template selected in the next step
R
Select a domain Domain details
4 | 4=Create new...
Name: [domain_psu_cortexas3 0 |
Display Name:  |domain_psu_cortexas3_0 |
Operating System: |standalone v
Processor: psu_cortexa53_0
Architecture: 64-bit v
]
t
i
1 ® < Back Mext = Finish Cancel
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Select the "Hello world" template and click "finish" to finish.

]_ ) New Application Project O X

«
Templates
"] Select a template to create your project.

| Awailable Templates:

~ SW development templates Let's say 'Hello World' in C.

Empty Application

Empty Application (C++)

- I Hello World I
IwlP Echo Server

IwlP TCP Perf Client

IwlP TCP Perf Server

IwlP UDP Perf Client

IwlP UDP Perf Server
Memary Tests

Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

| @ Next = Finish Cancel

After completion, we can see that two projects have been generated, one is the
hardware platform project, that is, the platfrom project mentioned before, and the other
is app project.

 vitis - hellofhello.pr - Vitis IDE - o x
File Edit Search Xiinx Project Window Help
mld [ B - R0 -iF- DB D [Quick Access] [ Design | 4 Debug
. Explorer 31| BEis ¥ = O |[&helosystem [Khello 31| = 8 (% outine | =
app i | . . . An utline is not available.
El Includes General Options
&= src
v Project name: hello View current BSP settings, or configure settings like STDIO peripheral
- selection, compiler fiags, SW intrusive profiing, add/remove libraries,
5 f 1 o Platform:  hello world | -~ assign drivers to peripherals, change versions of OS/libraries/drivers etc.
X hello_system.sprj .
hello_world Runtime: PP Navigate to BSP Settings

Domain: domain_psu_cartexa53_0
FHFATE
CPU: psu_cortexaS3_0

Hardware Specification: View processars, memory ranges and peripherals.
o Assistant 5 = 8
EER@RO%H T
[ hello_system [System]
hello_world [Flatiorm]
B Console 57 |2 Problems [ Vidis Log () Guidance e EEEDIELEE =R

Build Console [hello_system, Debug]

[Build Console [hello_system, Debug]

hello_warld

After you expand the platform project, you can see that there are BSP projects and
zyng_ Fsbl project (the result of selecting generate boot components), double-click
platform.spr You can see the BSP project generated by the platform. BSP means board
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support package, which contains the driver files needed for development, which is used

for application development.

« vitis - hello world/platform.spr - Vitis IDE - o x
file Edit  Search Xilnx Project Window Help

Hmilhd |® -]~ O@it-0O-iy-in T ‘@Design 1 Debug
L Explorer sﬂ BGlin * = O |[&hellosystem K hello | helloworld 5 | = 0 (5= outine 2] =0
> [ hello_system  hello world | e i = BEIETER An outline is not available

v B hello_world
> (& bitstream

[ hello_world

Platform: hello_world

> & export v} psu_cortexa53.0 Name: hello_world
> = hw « 2 zyngmp_fsbl Hardware Specification: hello_world xsa
> & logs BSP ) Board Support P Description: hello world
> [z psu_cortexa53_0 o ~ [} domain_psu_cortexa5
(= resources FSBL [2 Board Suppart Pac L4
3 @ zynqmp._fsbl M 4,;;“ pmu0
-8
> (= zyngmp_pmufw ~ [ zyngmp_pmufw Samples: Browse... Q
-« platform.spr [2 Board Support Pac
Generate boot components.
Pre-built Components.
FSBL: Browse...
Wi | BEE@R 0% Y50
PMU Firrmware: Browse.

v ¥ hello_system [System]
» {2} hello (Application]
hello_world [Platform]
< >

Main| Hardware Specification
& console x}lﬁ Problems [E] Vitis Log (i) Guidance

Platform Tcl Console

platform read {D:\hello_world\vitis\helle_world\platform.spr}
platform active {hello_world}

W
4]
m

#B8--=0

(& /hello_world/resources.

Click BSP to see the peripheral drivers of the project. Documentation Link is the
description document of the driver provided by Xilink, and Import Examples is the
example project provided by Xilinx to speed up learning.

5 hello system  Khello | hello world % | =B

type filter text E B X|| goard Support Package

B hello_world
v {} psu_cortexa53_0
v 2 zyngmp_fsbl
[2 Board Support Package

View current BSP settings, or configure settings like STDIO peripheral selection, compiler flags, SW intrusive profiling, add/remove libraries, assign
drivers to peripherals, changs versions of OS/libraries/drivers etc.

Modify BSP Settings...|  Reset BSP Sources

vE

domain_psu_cortexa53_0 ) } ) ) ) o . ) ) N )
A BSP settings file is generated with the user options selected in the settings dialog. To use exising settings, click the below link. This operation

clears any existing modifi 15 done. All the subsqg
Load BSP settings from file
Operating System

|2 Board Support Package
v {7} psu_pmu_0
~ [22 zyngmp_pmufw
[2 Board Support Package

changes are applied on tap of the loaded settings.

Name: standalone

Version: 7.2
Descrintion: Standalon is a simple, low-level software layer. It provides access to basic processor features such as caches, interrupts and
PHOM: axceptions as well as the basic features of a hosted environment, such as standard input and output, profiling, abort and exit.

Documentation: standalone v7_2

Drivers  Libraries
Name Driver Documentation Examples @
psu_acpu_gic scugic Documentation Link Import Examples
psu_adma_ 0 zdma Documentation Link Import Examples
psu_adma_1 zdma Documentation Link Import Examples
psu_adma_2 zdma Documentation Link Import Examples
psu_adma 3 zdma Documentation Link Import Examples
psu_adma_4 zdma Documentation Link Import Examples
psu_adma 5 zdma Documentation Link Import Examples
psu_adma 6 zdma Documentation Link Import Examples
psu_adma_7 zdma Documentation Link Import Examples
psu_afi 0 generic - - .

Select the App project, right-click Build Project, or click the "hammer" button in the

menu bar to compile the project
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& hellosysiem 53 | W hello o hello workd

i System Project Settings Active buid confgurst

General aptians
Syoct:
Roer g,

Kernel Imager

Application Preject Nome Build Configuration
bl Detug
o aasistare EER80% ~
v % belle_system 55
@) helle
bello_wrarld
i 8 MB-rH-r=a
otz
e bis e
20 e e s
Fintshed butlding: hello.elf.size
18:58:14 Bulld Finished (took 7s.87Ins)
& hello
—_—

After compiling, an elf file is generated

© Console £ |[EL Problems [ vitis Log (D) Guidance CoEBRE-ERlMB-0-=0

Build Console [hello, Debug]

'Invoking: ARM v8 Print Size'

aarchb4-none-elf-size hello.elf |tee "hello.elf.size”

text  data bss dec
20668 2048
‘Finished building: hello.elf.size’

18:58:14 Build Finished (took 7s.672ms)

<

hex filename
20676 52392 ccag hello.elf

-

Connect JTAG cable to development board and UART USB cable to PC

Using putty as a debugging tool for serial port

=% PUTTY Configuration
Category:
=8 533551’0r1 | Basic options for your PuTTY session
- Logging Specify the destination you want to connect to
= Teminal .
. Keyboard Seral line Speed
- Bell [coms| | [ 115200
- Features Connection type:
= Window ()Raw () Telnet () Rlogin () 55H (@) Serial
.gp;aea_rance Load, save or delete a stored session
- aviour
... Translation Saved Sessions
- Selection | |
- Colours -
Default Settings
= Connection ComM3a s i
- Data COMS
. Prosty COM& Save b
- Telnet Delete
- Rlogin
- 55H
) F
¢ - Senal Close window on exit : |
0 Mlways ) Newer (@) Only on clean exit

T hello”, A5, FTLAERIRZIED, AL EH2IX H K “Run as”, BLEIIERF
BATHEER, “Runas”HL X CAHIRXTEDT, L5 —1“Launch on Hardware(Single Application
Debug)”, i | KGR, E#2I21T7FEF - Select "hello” and right-click to see many options.
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In this experiment, "Run as" is used to run the program. There are many options in "Run
as". Select the first "Launch on Hardware (single application debug)" to run the program
directly.

EP COMS - PuTTY - O ®

In order to ensure the reliable debugging of the system, it is best to right-click “Run
As -> Run Configuration...”

We can take a look at the configuration. The Reset entire system is selected by
default, which is different from the previous SDK software. If there is a pl design in the
system, you must also select "program FPGA".

‘| = Run Configurations m] x
u
= Create, manage, and run configurations P E
Debug a program using Application Debugger. W/
) EICE

Name: | Debugger_hello-Default I| F

| $#7 Main [[7] Application [® Target Setup ._®= Arguments| 8 Environment| 5% Symbol files| & Source| & Path Map| [ Common
v £ single Application Debug

T

£, Debugger_hello-Default E

Tir

£, Single Application Debug (GDE) Hardware Platform: |${sdxTcfLaunchFilesproject=hellosfileType=hws} || search.. Browse.. L
B seM Analysis Bitstream Fles | idefbitstream/hello_world.bit || search.. Browse.. || Generate..

FPGA Device: [Auto Detect || select..

PS Device: [Auto Detect || select..

[ Use FSBL flow for initialization

FSBL File: [$tsdwTefLaunchFilesproject=hellosfieType=fsbl) || scarch.. Browse...

FSBL Exit Function: | XFsbl_Exit |

Summary:
Reset entire system Following operations will be performed before launching the debugger. ”
[Reset APU 1. Resets entire system, Clears the FPGA fabric (PL).

2. Program FPGA fabric (PL).
3 [WRe=eirl 3PS wil be ntalized using FSBL
[JEnable RPU Split Mode |4, The following processors will be reset and suspended.
1) psu_cortexas3_0
5. All processors in the system will be suspended, and Applications will be downloaded to the following
[Iskip Revision Check | 5rocessors as specified in the Applications tab.
[ Initialize using FSBL 1) psu_cortexa53_0 (Dhello_werld\vitis\hello\Debugihello.cH) -

Program FPGA

Filter matched 4 of 4 items

@ Run Close

)
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1.9 Generate BOOT.bin file

Since the Generate boot components option is selected when creating a new one,
the platform has imported the fsbl project and generated the corresponding ELF file

- vitis - hello_world/zyngmp_fsbl/xfsbl_main.c - Vitis IDE

-

File Edit Search Xilinx Project Window Help
s |- &- D f@iHE-0~iF TG
. Explorer Kﬂ BBl ~

=

=]

[=] hello_system [ hello_warld |
v & hello_world
(= bitstream

~ = export
+ (= hella_warld
= hw
~ = osw
w = hello_world

= generic.readme
2] hello_world.bif
pmufw.elf
(= domain_psu_cortexa53 0
= gemu
1= hello_world.spfm
2 hello_worldxpfm
= hw
= logs
(= psu_cortexa53 0
(= resources
(= zyngmp_pmufw
«J platform.spr

Modify debug macro definition fsbl_ DEBUG_ INFO_ When Val to 1, some status

information of fsbl can be output at
lead to longer startup time.

 vitis - hello_world/zynamp._fsbl/xfsbl_config.h - Vitis IDE

startup, which is conducive to debugging, but it will

Flle Edit  Search Xiinx Project Window Help
i [B-4- D g@W%H-0 -5 0o~
4, Explorer 5 | S5 72 O || & hellosystem  HKhelo s helloworld | (8l xfsbl configh 5 | (2 sfsbl maine
v (= zyngmp _febl Al ss Further FSBL by default doesn't have any debug prints enabled. If user
o zynamp.febl_bep 56 want to enable the debug prints, they can define the following
- 57 aptions
g psu_init.c 58 FSBL supports three types of debug levels.
8 psu_inith 59 - FSBL_DEBUG Defining this will print basic information and
[@ febl authentication.c o : any
[h) xfsbl_authentication.h 62
@ X‘Sbl_bmard‘c 63 - FSBL_DEBUG_DETAILED Defining this will print information with
: t
8 xdsbl_boardh = 311 data exchanged.
[g] xfsbl bs.c 66 #define FSBL_PRINT_VAL ()
B xfs 57 #define FSBL DEBUG VAL 2u
i o8 i
69
L] X 7@
[ xfsbl_csu dma.h 718
: tions
[§) xfsbl_ddr init.c g FSBL Debug option
[R) xfsbl_ddr_init.h 74
@ x‘gbl_debug_h 75 #if ESBlipRINTi\/AL
[& fsbl_dfu_utilc 7 [Glotine FSS1_PRINT
[0 xfsbl_dfu_utilh 78
[n) xfsbl_errorh 72 #if FSBL_DEBUG_VAL
. 80 #define FSBL_DEBUG
[§ xfsbl_exit.S 51 #endif =
[€] xfsbl_handoff.c 82
[4) xfsbl_hooks.c 83 #if FSBL_DEBUG_INFO_VAL
@x‘sblihmmks‘h :-51 :i:;::e FSBL_DEBUG_INFO
[H sfsbl_hw.h 36
[€] xfsblimage_header.c 87 #if FSBL_DEBUG_DETAILED VAL
) xfsbl image_headerh 55 #define FSBL_DEBUG_DETAILED
-mage_header. 82 #endif
() xfsbl initialization.c 98
&) dsbl_main.c 918 /
[ FSBL t: s
8 xdsbl_main.h o] 22| ; @name FseL cote snclude option
- —— En FSBL by default all the code is included.
asstont 31 | EB®R 0% = o5 Unwantsd code can be excludsd from the e1f by defining here
 B* hello system Syt 96 Below blocks can be excluded from the code.
ollo system [System] 97 - FSBL_NAND_EXCLUDE NAND code will be excluded
{8} hello [Application]

Right click the hardware platform project hello_ World, select Build Project.
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[=5] hello_system [ hello_world ]
hello_waorld

Click system of APP project and right click to select Build Project

[z=] hello_system [ hello_world
hello world

At this time, a debug folder will be created and the corresponding BOOT.BIN

. Explorer EE] = ‘G‘:;}u\:ﬂ V=0

v [z hello_system [ hello_world 1
v {2} hello [ domain_psu_cortexa53_0]
4 Binaries
[l Includes
(== Debug
= src
@ ide
% hello.prj
= _ide
v = Debug
% = sd_card
| BOOT.EIN
2| README txt
=| hello_system_Debug.build.ui.log
makefile

readelf.log

0 [ & [

= system.bif
= writebiflog
E hello_system.sprj
hello_world

Another method is to right-click the system of APP project and select Create boot
image. In the pop-up window, you can see the path of the generated BIF file and
BOOT.bin File. The bif file is the configuration file for generating the BOOT file.The

BOOT.bin file is the boot file we need. It can be put into SD card to start or burn to QSPI
flash.
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) Create Boot Image *

Create Boot Image
1, BIF file already exists at the specified path and will be overwritten with the modified contents. Use 'Preview Bif Changes' button to view the changes in bif cantents before @

ovenwriting.
Architecture: | Zyng MP

() Create new BIF file @ Import from existing BIF file

Import BIE file path: ‘D:/FZ3;’4GB/he\lu_wmrld,fvitis,’heHo_wur|d_system,t‘_idefbomtimage{hellm_wor\d_system.bif | Browse...

Basic  Security

Output BIF file path: |D:,’FZS,MGE,’heHniwor\djvitis,i'hellmiwnrldisystam,‘iide,’bmotimsga,’ha\\oiwmrldisystem‘bii ‘ Browse..
UDF data: | ‘ Browse...
[Osplit Output format: |BIN  +

Output path: |D:,’FZS,MGB,’heHniwor\djvitis,fhellmiwnrldisystam,’iide,’bmotimaga,’BODT‘bin ‘ Browse..

Boot image partitions

File path Encrypted Add
(bootloader) D:/FZ3/4GB/hello_worldvitis/ps_module_wrapper/export/ps_module_wrapper/sw/ps_module_wrapper/boot/fsbl.elf none
D:/FZ3/4GB/hello_world/vitis/hello_world/ ide/bitstream/ps_module_wrapper.bit none e

| DAFZ3\4GBYhello_world\vitis\hello_world\Debug\hello_world elf none Edit
® Preview BIF Changes Create Image Cancel

7E Boot image partitions F1|3& HHH BA R SCAF, 2— N X F—5E & bootloader X
ik, e LA RN fsblelf SCfF, 26 A2 FPGA FLE SCAF bitstream, FEASE
Bt 7% FPGA 1) bitstream, ANFREGM, H=RBMABERF, EAKE TN
hello.elf. 517 Create Image “£J% BOOTbin. There are files to be synthesized in the Boot
image partitions list. The first file must be a bootloader file, which is generated above
fsbl.elf file, the second file is the FPGA configuration file bitstream. The third is the
application program. In this experiment, the hello.elf . Click create image to generate
BOOT.bin .

« « 4[> WEE > S (D) > helloworld » vitis > hellosystem > ide > bootimage vio | P oaw
2% ESidl )
# e -
mEE » |Boorbin BIN i 5605 k8|
N [ hello_system.bif BIF S2#t 1KB
! b " [ readelflog e 0KB
5] >z 5 writebiflog ] 2 kB
= BR #*
bin
[72]
MVIR_ PACKAGE

Set the development board to SD card startup mode, and then copy the BOOT.bin to SD card and
run it on the development board.
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Chapter 2 gpio_emio

This chapter describes how to export GPIO through Emio and control D11
flicker in Vitis

1.1 Create project and configure IP core of PS

With Based on the hello_world project, save it as ps_emio project, open zynq configuration
and check GPIO EMIO. Since there is one LED on the PL side, select the bit width of EMIO as 1 bit
in MIO configuration. After configuration, click OK.

¢ hello_world - [D:/FZ3/4GB/hello_world/vivado/hello_world.xpr] - Vivado 2020.1

File  Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access

Project Mew...

I Add Sources... Open... _world
Close Project Open Recent »
?7 006 X
Open Example...
Save As... ﬁ
Open Log File
Checkpoint » . 4
Open Journal File
P »
Write Tcl...
Text Editor »
Archive...
Export »
1
~ SIMULATION | Hierarchy @ Libraries Compile Order

If " Create project subdirectory " is checked, subdirectories will be created under the
directory, and checking "Include run results" will contain the compiled results
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¢ Save Project As >

Save this projectto a new name and location.

L Project name: gpio_emio

Project location:  DnFZ3/4GB

Create project subdirectary
Project will be created at: D/FZ3/4GB/gpio_emio

[ Include run results

T DRU VIOIEUoNS

Double click ps_module.bd and open block design

Sources x Design | Signals |Board |Platformin | 2 _ g 3
Qa = 2 + 0 o
v Design Sources (1)

~ @ 5 ps_module_wrapper (ps_module wrapper.v) (1)

‘v = PS_module_i - ps_module (ps_module bd) (1 }”

~ @ ps_module (ps_module.v) (1)
» TFE zyng_ultra_ps_e_1:ps_module_zyng_ultra_ps_e_
> Constraints (1)
> Simulation Sources (1)

> Utility Sources

Hierarchy |P Sources Libraries Compile Order

Open ZYNQ configuration and check GPIO EMIO. Due to one LED on the PL side,
select the bit width of EMIO as 1 bit in MIO configuration. After configuration, click OK.
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#  Re-customize IP B 3
Zynq UltraScale+ MPSoC (3.3) /
@ Documentation IP Location
Page Navigator - /0 Cenfiguration
() Switch To Advanced Mode ~ MIO Voltage Standard
Bank [MIO 0:25] | | Bank1 [MIO 26:51] | | Bank2 [MIO 52.77] | Bank3 [Dedicated]
PS UltraScale+ Block Design
LVCMOS18  « LVCMOS18  « LVCMOS18 LVCMOS33
/O Configuration
Clock Configuration « | = <
Qs
DDR Configuration Search: |C
Peripheral Vo Signal 'O Type  Drive Strength(mA)  Polarity Speed Pull Type  Direction
PS-PL Configuration O Peripherals A
> CAN
> 12C
() PJTAG
> () PMU
[ csu
> SPI
> UART
~ GPIO
[ GRIOEMIO | 1 v
> [¥] GPIOO MIO MO0 .25 v
> [v] GPIOT MIO MIO 26 51 v
() GPIO2 MIO “

Click GPIO_ 0 port, Right click and select make external to export the port signal.

Block Interface Properties...

Highlight

Copy

Search...
Select All
AddIP..

Add Module...

Make External

.
zyng_ultra_ps_e_1

A N M_AXI_HPMO_FPD 4[| B
maxihpm0_fpd_ack Z YNQ GRe0+
pl_resetn0

1 pl_clk0 Q

UltraSCALE - %

Zynq UltraScale+ MPSoC |+

D\

=

Click on the pin and change the pin name to LED, and save the design.

Pinning
IP Settings...

Validate Design
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So x Desig Signa|Board Platf | » _ 3 Diagram x Address Editor  x

a = = + ( & @ a X E o Q + X # C o = Default View v
~ = Design Sources (1) ~
@~ ps_module_wrapper (ps_module
=[5 ps_module_i- ps_module (ps
~ @ ps_module (ps_module v) (1

> [ zyng_ultra_ps_e_1: p

> Constraints (1)

> = Simulation Sources (1) zynq_ultra_ps_e_1

5 = Utility Sources

M_AXI_HPMO_FPD o4 {f

Hierarchy = IP Sources  Libraries 1 ) = mexihpm0_fpd_adk GPIO_0 o |||t
- A pl_resetn0

External Interface Propert 2 _D00GX UltraSCALE+ pl_clk0
< led - & Zynq UltraScale+ MPSoC

Name:

Mode: MASTER

< >

General  Properies

1.2 Generate synthesis files

Click ps_module.bd ,then right click and select Generate Output Products to
regenerate the output file.

So x Desig Signal Board Platf | o nr I Diagram x_Address Editor x

Source Node Properties. Ctri+E

a = & + Q + E #, C o = DefaultView v
= OpenFile Alt+O
~ = Design Sources (1)
~ @ = ps_module_wrapf Create HDL Wrapper .
~ . [E ps_module_i: View Instantiation Template
~ @ ps_module (| Generate Output Products__
> TE zynq_ Reset Qutput Products.

> Constraints (1)
zyng_ultra_ps_e_1

> Simulation Sources (1)

> Utility Sources -
M_AXI_HPMO_FPD 4 |

< S i
i Z GPIo_0 +||
Hierarch; IP Sources L =
Y X Remove File from Project. Delete maxihpm0_fpd_ack Y N Q@ pl_resetn0

|_clk0
Source File Properties UltraSCALE* o=
Disable File Alt+H S
ps_module.bd Zynq UltraScale+ MPSoC
Hierarchy Update >
(v] Enabled C  Refresh Hierarchy
Location: G:IFPGAIFZ: IP Hierarchy >
Type: Block Desigr
<

General  Properties

After the end, the top-level file will update the new pin, which needs to be pin
bound.
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So x Desig Signa| Board Platf | 2 _ O 3 Diagram x | Address Editor »  ps_module_wrapper.v x
Q = & + 0 & G:/FPGA/FZ3/gpio_emio/gpio_emio.srcs/sources_1/bd/ps_module/hdlips_module_wrapper.v
~ Design Sources (1
4 — Q X B B X 4 E® 0
> 0N ps_module_wrapper(ps_rrmdule_wr| —
10+ “timescale 1 ps /1 ps
> Constraints (1) T
> Simulation Sources (1) 12 £ nodule ps_nodule_wrapper
> Utility Sources 13 3 (led_tri_io);
14 }‘ inout [0:0]leditri7iol, |
15
16 | wire [0:0]led_tri_i_o;
17 wire [0:0]led_tri_io_0;
{ 3 > 18 | wire [0:0]led_tri_o_0;
Hierarchy IP Sources Libraries < p = 19 ! wire [0:0]led_tri_t_0;
20 |
. . 21 I0BUF led_tri_icbuf_0
Source File Properties x ' - -
P % = (4[5 & 22 (. I(led_tri_o_0),
® ps_module_wrapper.v - & 23 .I0(led tri iol[0]),
: L0(led_tri i 0),
~ . .
) Enabled LT(led_tri_t_0));
' ps_module ps_module_i
Location: G:IFPGA/FZ3/gpio_emio/gpic 27 | (led_tri_i(led_tri_i_0),
e - 28 .led_tri_o(led tri_o_0),
ype: — B E EE led tri_t(led tri_t 0));
< > 30 & endnodule
General Properties 31 7

1.3 Generating top-level file of FPGA

Select ps_ module.bd. Right click -- Create HDL Wrapper to generate FPGA top-level file.

BLOCK DESIGN - ps_module
Sources w Design Signals 2 _ 0O Diagram w Address Editor 3
Q T |24 ) | @ Q@ 1 x O Q
~ [ Design Sources (1) &
~ @5 ps_module_wrapper (ps_module_wrapperyv) (1)
W pS madoala i ne raadule foe caodola bAb F40
'Y Source Mode Properties.. Ciri+E
5 & OpenFile Alt+0 ke
v Cnnstraimsl Create HDL Wrapper... |
e consirs_ View Instantiation Template
| sIcX
T Generate Output Products. .. w
| « S—— . L
lierarchy | S Reset Output Products...

1.4 Adding xdc pin constraints

Left click to select Constraint, right click--Add Source.
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Sources w= Design Signals 2 _ 0O s Diagram w  Addr
Qx|+ 8| @ a 20
“r Design Sources (1)
~ i 5 ps_module_wrapper (ps_module_wrapperv) (1)
> = ps_module_i: ps_module (ps_module.bd) (1)
o Constrainf
> constr
3 Simulatior Hierarchy Update 3
5 Utility Soul & Refresh Hierarchy
IP Hierarchy 3
-------------- Edit Constraints Sets. . e
Hierarchy IR
Edit Simulation Sets...
Constraint SetE |-} Add Sources._. A4 0 5
constrs_1 Report IP Status .|:|.
Select Add Create Constraints
y Add Sources e
P Add Sources
VlVﬁQEQ This guides you through the process of adding and creating sources for your project
(®) Add or create constraints
3 () Add or create design sources
Ig
=2 () Add or create simulation sources
D
)
w
& XILINX
5
©) g i

Select Create File
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¢  Add Sources e

Add or Create Constraints

Specify or create constraint files for physical and timing constraint to add to your project. '

Specify constraint set: constrs_1 (active) o

- +

Fl
Constraint File  Location

srexdc DIAFZ34GB\gpio_emio\gpio_emio.srcs\constrs_1\new

rd

Add Files || Create File |

E] Copy constraints files into project

@ Mext = | Einish | | Cancel |

Create a src.xdc file

| # Create Constraints File )4
Create a new constraints file and add it to
your project ‘
i
File type: - XxDC w
File name: gpio_emio
File location: | & =Local to Project= 4
Ok
@ o | e
sy |
Click Finish
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¢  Add Sources

Add or Create Constraints

Specify or create constraint files for physical and timing constraint to add to your project.

Specify constraint set: constrs_1 (active) o

- +,

ConstraintFile  Location

gpio_emioxdc | =Local to Project=

3 Add Files || Create File |

C] Copy constraints files into project

s \

*

| Einish

| | Cancel |

Add the following content to src.xdc, the port name must be consistent with the top-level

file port.

BLOCK DESIGN - ps_module

Sources  x Design | Signals 2 _00 x | Address Editor

a T £ + : o

= Design Sources (1)

Diagram % | ps_module_wrapper.v

Q -~

x B B X N/ B Q
~ i hsfmoduleﬁwrapper {ps_module_wrapper.v) (ﬂ|

» =[5 ps_module_i: ps_module (ps_module.bd) (1)
~ = Constraints (1)
~ = constrs_1 (1) |
I" gpio_emioxdc
> Simulation Sources (1)

> = Utility Sources

Hierarchy  IP Sources Libraries Compile Order

1.5 Generate bit files

Generate bit file

¥ PROGRAM AND DEBUG

Vit Generate Bitstream

> Open Hardware Manager <

D:/FZ3i4GBigpio_emio/gpio_emio.sres/constrs_1/new/apio_emio.xdc

« gpio_emioxde  x

1 ! set_property IOSTAUDARD LVCMOS33 [get_ports {led_tri_io[0]}]
2 . set_property PACKAGE PIN AM3 [get_ports {led tri_io[0]}]
5
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1.6 Export Hardware Profile

Click File > export > export hardware > OK on the menu bar to export the hardware
configuration file.

#  gpio_emio - [DyFZ3/4GB/gpio_emio/gpio_emio.xpr] - Vivado 2020.1

Eile Edit Flow Tools Repors Window Layout View Help

Project , |® = O, O X
I Add Sources... ALt BLOCK DESIGN - ps_module
1 Close Project
Sources = Design Signals

a = 2 +

o Design Sources (1)

Save Block Design As...

Close Block Design « @ -~ ps_module_wrapper (ps_mc

> B ps_module_i: ps_modul

w Constraints (1)

1 ~ constrs_1 (1)
Checkpoint s I gpio_emioxdc
1P 3 > Simulation Sources (1)
Uttility Sources
Text Editor [ ? ty
Hierarchy IP Sources Libraries
1 Export I Export Hardware. .. I
Print... Ctrl+P Export Block Design...
) Export Bitstream File...
Exit
R RS B S R P - Export Simulation...

The platform type select Fixed

# Export Hardware Platform s

@

Export Hardware Platform

¢ VIVADO'

HL Editions This wizard will guide you through the export of a hardware platform for use in the Vitis or Petalinux
software tools

To export a hardware platform, you will need to provide a name and location for the exported file and
specify the platform properties.

Platform type

() Fixed
A platform supporting embedded software development only.

O Expandable
A platform supporting acceleration.

& XILINX.

FEinish Cancel

S —

To export hardware, select "Include bitstream".
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4 Export Hardware Platform =

Output

Setthe platform properties to inform downstream tools ofthe intended use ofthe target platform’s hardware design p

() Pre-synthesis
This platform includ a hardware 1 for downstream software tools

(@) Include bitstream

‘This p des-th p pl a4 . toth @

software tools

=N |

Select the export file name and export path. Here, the file name is selected by default, and
the path is the newly created Vitis folder under the project file.

¢ Export Hardware Platform x
9 Files
Enter the name of your hardware platform file, and the directory where the XSA file will be stored. '
XSAfile name: ps_module_wrapper
Export to: D:IFZ314GBIgpio_smiokitis |E
di The XSA will be written to: DAFZ3WWGB\gpio_emiowitis\ps_module_wrapperxsa
s
O
B! Mext > ‘ Einish ‘ ‘ Cancel ‘
pa ¢

AUUIT BXIT SO0
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1.7 Launch Vitis and create new platform project

Click Tools > launch Vitis ide on the menu bar to launch Vitis

¢ gpio_emio - [DWFZ3/4GB/gpio_emio/gpio_emio.xpr] - Vivado 2020.1
File Edit Flow Tools Repors Window Layout Wiew Help Q- Qluick Acce
=4 Create and Package Mew IP...
Flow Navigator Create Interface Definition...
~ PROJECT MAMAGER Enable Dynamic Function eXchange...
L} Settings BRun Tcl Script...
Add Sources Property Editor Ctrl+J
Associate ELE Files...
Language Templ: ) _ _module_wrapper.w
Generate Memory Configuration File...
<F |P Catalog . . . . .
Compile Simulation Libraries. ..
~ |P INTEGRATOR #Hub Stores...
Create Block Des Custom Commands *
Open Block Desig Launch Vitis IDE
Generate Block D| @  Language Templates
£¥ Settings..  ssosoooooooe
= Compile Order
Click File->Switch Workspace—> Other...,
 vitis - ps_module_wrapper/platform.spr - Vitis IDE - o x
Fle| Edit  Search Xiinx Project Window Help
New AIESHIRENS | v @ w1 gf it (o v o v [Quick Access| | |[ Design | %5 Debug
Open File...
O || ps_module_wrapper sﬂ = O ||Bz Outline sﬂ = g
Close Ctrl+W =
Close Al Ctrl+Shift+W yeefiterte = B % %] platform: ps_module_wrapper An outline is not available.
Save Crrl+s v B ps_module_wrapper
Save As.. ~ '} psu_cortexa53_0 Narme:
Save Al Ctrl+Shife+S ~ 8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
Move. B Board Support P4 pescription: ps_module_wrapper
v [ standalone on psu_¢
(e [ | Board Support Py
§1 Refresh Fs v} psu_pmu 0
Import... v [22 zynaqmp_pmufw Samples: Browse.. | |Q,
Export. | Board Support Py
Hport.. [ Generate boot components
P Alt+Enter pre-bult Components
Switch Workspace > DA\FZ3\4GB\axi_gpic\vitis FsBL: Browse...
Restart D:\FZ2\4GB\gpio_emiolvitis EMU Firmwares Browse..
Exit DAFZ3\4GBhello_world\vitis

ML e
{8} axi_uart [Application]
ps_module_wrapper [Platform]

Di\witis
DAMPSOC\3EG\gpio_emio\vitis
DAMPSOC\3EG\gpio_emio
DAMPSOC\EV hello_world\vitis
DAMPSOCA\3EG\hello_worldivitis
DAFZ3\4GB\uart_cycle\vitis

Other...

v

Llog (1) Guidance

IR #B8~-g~=10

lre\vitis\ps_module_wrapper\platform.spr}
per}

0 items selected
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elect the path, select the vitis folder under gpio_emio project. Click launch

TR —— T

% Eclipse Launcher *
Select a directory as workspace
Vitis IDE uses the workspace directory to store its preferences and development artifacts.
Workspace: |P:\FZ3\4GB\9PiC'_EmiC'\\-"itiE VIl Browse...
» Recent Workspaces
» Restore other Workspace
b Copy Settings
@ e | e
Click Create Platform Project
«J vitis - Vitis IDE - ] bd
Fle Edit  Search Xiinx Project Window Help
ERITT— p—
W XILINX
a VITIS.
I I I
PROJECT PLATFORH RESOURCES

Create Application Project

Create Platform Project

Create Library Project

Import Project

Add Custom Platform Vitis Documentation

Xilinx Developer

The project name uses the same name as the xsa file.

Click next.

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com

49 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/

MYi R IRIREBF MYD-CZU3EG
Make Your Idea Real FPGA F & FM

4
7| «d New Platform Project m} x

=| Create new platform project

Enter a name for your platform project

Project name: | ps_modul e_wrapperI

Use default location
Location: | DAFZ3\4GB\gpio_emio\vitis\ps_module wrapper Browse

Platform
Project

= A system project is a container for multiple
applications that would run on different domains of
a platform at the same time.

= A domain is the BSP/OS that controls one or

[ i . .
Processor I Domain more isomorphic processors.

- A platform contains one or more domains.

XSA » A workspace can contain unlimited platforms and
unlimited system projects
t
1
® = Back MNext = Finish Cancel

Select Create from hardware specification(XSA),click NEXT

4
| «d New Platform Project O x

=| Platform Project

Create new platform project

Create a platform project from the output of Vivado [Xilinx Shell Archive (XSA)] or from an existing platform. A platform will enable you to
specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for
embedded software developers.

(®) Create from hardware specification (XSA)

Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

(O Create from existing platform

Load the platform definition from an existing platform. You can choose any platform from the platform repository as a base for your
platform project.

@ <Back | Next> Finish Cancel
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Open Browse..., select the previously generated xsa file

o vitis - Vitis IDE a4 New Plattorm Project o . = .
File Edit  Search Xilinx Project Window Hel Platform Project Specification
"= [ Welcome 2 Provide the hardware and software specification for the new platform project =
n Hardware
| | W XILINX
|
f VITIS =
«J Hardware Specification File x [
« v g <« ¥fEE (D) » FZ3 > 4GB » gpio_emio 5 vitis v O L2 #Eitis B
mR v FEEEE = m @ L
@ OneDrive ~ ER . 1B EE =) b
= e metadata 2020/11/3 16:42
;_ RemoteSystemsTempFiles 2020/11/3 16:42
Boowe |1 ps_module wrapperxsa 2020/11/3 16:22 730 KB
B wn
= 8F
1 o]
¥ = |
tion
»ER
W =E
e TS (C) 3
— FiDE D)
= IS (E)
- T (F)
| - T ()
- B ) Finish Cancel R
o FE Vo< >
1.7 Saibitszit SZHE(N): | ps_module_wrapper.xsa | wsatdsar v‘ Frieh
1 SSHRERE TS o -
() B e—
1.9 oK, SRRish ,

Leave the default and click finish.

»

d
“| & New Platform Project O x|
:| Platform Project Specification
| Provide the hardware and software specification for the new platform project |
Hardware Specification
WA file: |D:\FZ3\4GB\gpio_emio\vitis\ps_module_wrapper.xsa | | Browse...
Software Specification
Operating system: |5tanda|one V|
Processor: | psu_cortexa53_0 ~ |
Architecture: | 64-bit ~ |
Mote: A domain with selected operating system and processor will be added to the platform. The platform project can be
madified later to add new domains or change settings.
Generate boot companents
t
1y
® MNext = Finish | | Cancel |
|
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1.8 New gpio_emio Project

Right click the blank space of the project navigation bar on the left and select
NEW->Application Project.

4 vitis - ps_module_wrapper/platform.spr - Vitis IDE
File Edit
(g

Search Xilinx Project Window Help

|8 - |- O WO~ E D

[m} x

[k acee) | [bean] # oobus

<. Explorer £t | B % 7 = O |(~dpsmodulevrapper 52 | & gpio emio system K apio_emio = 6 |(Eouinesx] =5
> 5] gpio_emio_system [ ps module wrapper | An outline is not available.

e filter tex =+
> [B] ps_module wrapper el B B % % | Board Support Package

~ B ps_module_wrapper
~ {} psu_cortexas3_0
v 22 zynqmp _fsbl

View current BSP settings, or canfigure settings like STDIO peripheral selection, compiler flags, SW
intrusive profiling, add/remove libraries, assign drivers to peripherals, change versions of
08/libraries/drivers etc.

P settings file is generated with the user options selected in the settings dialog. To use exising
Ings, click the belaw link. This operation clears any existing modifications done. All the

Standalone is a simple, low-level software layer. It provides access to basic
processor features such as caches, interrupts and exceptions as well as the
basic features of a hosted environment, such as standard input and output,

[z > [ Project. Fify BSP Seftings... | Reset BSP Sources
Paste Cul+V | [§ File
K Delete 9 Folder
] Refresh = Application Projs quent changes are applied on top of the loaded settings.
i1 Import Sources.. Hw Kernel Project.. 852 settings from fe
i Export as Archive E2 Library Project... rating System
Build Project B Platform Project. Name: standalone
N— Clean Project 9 Example.. Version: 7.2
- Assistant
Tepy e s e s (e @iz .
v B gpio . Description:
9PI®_ &, Update Hardware Specification
> Ehop profiling, abort and exit.
psmi  Team ’ Documentation: standalone v7 2
Run As ¥
3| ==
Debug As
rdware Specification|
Properties =
=CoTRole zﬂl:; Problems [ Vitis Log (i) Guidance

Platform Tcl Console

latform active {ps module wrapper}
get_hw_path

get_mss_path

platform read {D:\FZ3\4GB\gpio_emio\vitis\ps module wrapper\platform.spr}

regenerate_psinit D:/FZ3/4GB/gpio_emio/vitis/ps_module_wrapper/hw/ps_module_wrapper.xsa

ps_module wrapper

Skip to the second page and select the platform project created above (default), next

»l New Application Project

Platform

[m]

| (&) The selected platform has unbuilt changes in the workspace. Please generate the platform to use the latest version.

X

i

Select a platform from repnsitory} |77 Create a new platform from hardware (XSA)
Name Board Flow Vendor Path
@ pe_module_wrapper [custom] Embedded SW Dev ilinx DAFZ3\AGB\gpio_emio\witis\ps_module_wrapper\exportips ||
bt
o
¢
< > n
Platform Info
General Info Acceleration Resources Domain Details
A
Name: ps_module_wrapper 2 The selected platform does not have Domains o
) acceleration capabilities [ i Details
Part: xczuleg-shvc784-1-e 5 b
| standalane_domain | cPU: psu_cortexas3 01 1
Eamily: Zynquplus F
b
Description: |
ps_module wrapper
b v 2
< > B
@ < Back Next = Finich Cancel L

Project name enter gpio_emio, Next
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&) New Application Project m] e
3 Application Project Details
| Specify the application project name and its system project properties L
|
Application project name: [gpic_emic| | [
. fti
System Praject
Create a new system project for the application or select an existing one from the workpsace @@
Select a system project System project details pt
b
== Create new...
System project name: gpio_emio_system
Target processor
Select target processor for the Application project. L
n
Processor Associated applications
psu_cortexa53_0 gpio_emio
b
4 B
b
4 B
b
b
Show all pr rs in the hard pecification [ ] [ ] p!
@ N | ol | |

Next

-« New Application Project m| X b

Domain
Select a domain for your project or create a new domain 7
]

Select the domain that the application would link to or create a new domain

Note: New domain created by this wizard will have all the requirements of the application template selected in the next step ke
h
Select a domain Domain details
standalone_domain
MName: standalone_domain
+Create New... =
Display Narne: standalone_domain
Operating Systern: [standalone ~ :
Pracessor: psu_cortexa53_0
e
E
E
E
E
E
E
' ]

| @ ] [

Select Empty Application, Finish
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-« New Application Project

Templates

Select a template to create your project.

m}

X

Available Templates:

Find: l:l Z = Empty Application

~ SW development templates Ablank C project.

Empty Application (C++)
Hello Warld

IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server
IwiP UDP Perf Client
IwiP UDP Perf Server
Memory Tests
Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

T

| kiagisibg bikd b o)

| @ < Back New - | [[Crmeh ]

Cancel

Copy the files in the example project to src, select the project, and click the compile buttom.

4 vitis - gpio_emio/sre/hellowerld.c - Vitis IDE - [m] X
i file Edit  Search Xilinx Project Window Help
JaRARTICR W) K0 H RaE AR 2 Design | 45 Debug
Debug’ for project 'gpio_emio’ |
L Explorer &2 e ~rPs module wrapper & gpio_emio system % gpio_emio | (8 helloworld.c 27 | = B (8 outine = a8
9 o - =1 PrINLy MELIO WOrIOWI )]
1 v [=] gpic_emio_system [ ps_madule wrapper | Al e 7* Initialize the GPIO driver. =/ @ SRR I S
~ {2} gpio_emio [ standalone on psu_cortexa53.0] 71 ConfigPtr = XGpioPs_LookupCenfig(GPIO_DEVICE_ID); u stdioh
3 72
> Binaries L latform.h
ol 73 Status = XGpioPs_CfgInitialize(&Gpie, ConfigPtr, _J platierm
> () Includes 72 ConfigPtr->BaseAddr); Ul printth
> (& Debug 75 if (Status = XST_SUCCESS) { U xgpiops.h
P ;5 , return XST_FATLURE; o deeph
> [2) helloworld.c el # GPIO_DEVICEID
> [B] platform configh 798 /% @ Gpio: XGpicPs
s [@ platform.c L] * Set the direction for the pin to be output and o maind:int
P 81 * Enable the Output enable for the LED Pin. main( :in
> [B] platform.h 52 +
T Iscriptld 83 XGpioPs_SetDirectionPin(&Gpio, 78, 1);
) README.txt 84 XGpioPs_SetOutputEnablePin(8Gpio, 78, 1);
i b 85
> @5 ide a6 while(1){
% gpio_emio.prj vl &7 /* Set the GPIO output to be low. */
< > 88 XGpioPs_lWritePin(&Gpio, 78, Bx8);
89 sleep(1) 5
- Assistant £2 =l @ | 0 = 9 J* set the GPIO output to be high. */
91 XGpioPs_lritePin(&Gpio, 78, Ox1);
v 2% gpio_emio_system [System] 9z sleep(1) ;
sf| > {Z gpie_emio Application] o
ps_medule_wrapper [Platform] a5 cleanup_platform(};
96 return 8;
97 }
98 v
B Console zﬂ\f_‘ Problems [E] Vitis Log (i) Guidance
Platform Tcl Consele
platform read {D:\FZ3\4GB\gpio_emio\vitis\ps_module wrapper\platform.spr}
platform active {ps_module_wrapper}
t_hw_path
generate_psinit D:/F23/4G8/gpic_emio/vitis/ps_module_wrapperhw/ps_module_wrapper.xsa
t_mss_path
{2} gpio_emio
T

1.9 Generate BOOT.bin file

Right-click the system of APP project and select Create boot image.
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~ vitis - gpio_emio/sre/helloworld.c - Vitis IDE
File Edit Search Xiinx Project Window Help

- [m] x

H-HE 8- K- OFW O i D [Goick Access] | [ Design 4 Debug
. Explorer 3 | B[S 7 = O |[wpemodule wrapper X gpio_emio_system K gpio_emio | (6 hellowerld.c 53 | = 0 |[E= outine 2| =n
o 55 PrINLL AELLD WOFLO\T J3 k
= QP‘D_E’"‘D_SY““'“'"':‘ medle e 1 , jtielize the GPIO driver ” BV e % 7
ps_module_ wra e Ptr = XGpioPs_LookupConfig(GPIO_DEVICE_ID); u stdioh
Add Application Project. & platformh
Add Library Project. - XGpioPs_CfgInitialize(&Gpie, ConfigPtr, B
fbrary Project... Configptr->Baseaddr); 2 x| printth
Add Hw Kernel Project... ftus != XST_SUCCESS) { u xgpiops.h
fturn XST_FAILURE; u
Paste Crl+v U slecph
GPIO_DEVICE_ID
® Delete # 10 DEVICE |
@ Gpio: XGpioPs
) Refresh the direction fer the pin te be output and o maing:int
ble the Output enable for the LED Pin. :
3 Import Sources...
4 Export as Archive 's_SetDirectionPin(&Gpic, 78, 1);
's_SetOutputEnablePin(&Gpio, 78, 1);
Close System Project
1L
Build Project Set the GPIO output to be low. */
pioPs_WritePin(&Gpio, 78, 8x@);
Clean Project kep(2) 3
- nt 5% L set the GPIO output to be high. */
Create Boot Image pioPs_writePin(&Gpio, 78, exl);
v ¥ gpio_emio_syst B Program Flash Eep(1) ;
15} gpio_emio I C/C++ Build Settings
ps_module wra b_platform();
Team > |e;
Run As > v
Debug As >
Properties | Problems [F] Vitis Log (1) Guidance REER MB--=08
Platform Tel Console

platferm active {ps_module_wrapper}
tiscw::get_hw_path

115cw:iget_mss_path

platform read {D:\FZ3\46B\gpio_emio\vitis\ps_module_wrapper\platform.spr}

:isowiiregenerate_psinit D:/FZ3/468/gpic_emio/vitis/ps_module_wrapper/hw/ps_module wrapper.xsa

[=] gpic_emio_system

In the pop-up window, you can see the path of the generated BIF file and BOOT.bin
file. The bif file is the configuration file for generating the BOOT file . The BOOT.bin file is
the boot file we need. It can be put into SD card to start or burn to QSPI flash.

Click Create Image to generate BOOT.bin Startup file

|« Create Boot Image

-

Create Boot Image

Creates Zynq MP Boot Image in .bin format from given FSBL elf and partition files in specified output folder.

Architecture: |Zyng MP

1ok

() Create new BIF file @ Import from existing BIF file p
Import BIF file path: ‘D:fFZS.MGB[gpiu_emiufvitingpicl_emiuf_idefbuotimagafgpiu_emiu.bil | Browse...
Basic  Security
Output BIF file path: |D:/FZB,’dGB,n’gpin_emin,-’vitis,n’gpin_emin,-’_ide,fboﬂtimagejgpim_emio.bif | Browse...
UDF data: | | Browse...
- Osplit Output format: BIN  ~
] Output path: |D:/FZS,’A‘IGB,n'gpioiemior'vitis,n'gpiDiemior'iide/bootimagejBDDT‘bin | Browse..

Boot image partitions

File path

D:/FZ3/4GB/gpic_emio/vitis/gpio_emio/_ide/bitstream/ps_module_wrapper.bit
D:/FZ3/4GB/gpio_emio/vitis/gpio_emio/Debug/gpio_emio.elf

Encrypted Authenti| | Add |
(bootloader) D:/FZ3/4GB/gpic_emio/vitis/ps_module wrapperfexport/ps_module wrapper/sw/ps_module wrapper/boot/fsbl.elf

® Preview BIF Changes Cancel R

none none -
Delete
none none F
none none :
Edit
Up
3 Down

—E

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD card

and run on the development board.
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o vitis - gpio_emio/sre/hellowarld.c - Vitis IDE
File Edit Search Xilinx Project Window Help

MR ® -/ -i-0-F/- DT -~

. Explorer E@] 5, | pug

=

[—]

8

~ [==] gpic_emio_system [ ps_module_wrapper ]
~ {&} gpio_emio [ standalone on psu_cortexa53_0 ]
> # Binaries
> Y Includes
» = Debug
» = src
> @£ ide
¢ gpio_emio.prj
~ = _ide
¥ (= bootimage
[ = Eo0TEn ]

=| gpic_emio_system.bif

=| readelflog
|| writebif.log
&, gpio_emio_system.sprj
» ps_module_wrapper

ol ps_module_wrapp

47

45 #include <sti
49 #include "pli
58 #include "wi.
51 #include "xg
52 #include “"sL
53

54 #define GPIO
55

568 [f*

57 * The follo
58 ¥ easily ac
59 *f

58 XaGpioPs Gpio,
61

2= int main()

54 init_pla

56 int Stat
67 XGpioPs_1

59 print{"H
78 S* Initdi
71 ConfigPt

73 Status =
74 1
75 if (stat
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Chapter 3 axi_gpio

Vivado comes with many IP cores, such as CAN, UART, SPI, etc. if the CPU does not have
enough resources, it can be extended on the PL side. Information about these IP cores can be
found in DocNav. Docnav will be automatically installed when installing vivado software. DocNav
also contains many other materials, such as the use of Vivado and SDK, and video tutorials. This

chapter will introduce how to use Xilinx's GPIO core to implement a GPIO controller in PL to
control LED.

1.1 Create project and configure IP core of PS

Based on "ps_hello" project, save as axi_gpio project.

4 a%i_gpic - [DYFE3/AGH axi apic/as gpic wpr] - Vsda 20201
£ ES Flow  Took  Repats  Wnoow  Lamut  Wew  Hep
=, » W& E

[ s e 2

~ PROJECT MANAGER

2 D% Projctemany 20D x
& sefiings
@ Overview | Dasnbosr
it Sourees
Languags Tamplates Sattegs  Ean
T P Cataiog Projectname: ai_gpi
Frojectncation OFZNGES_gpio
¥ FINTEGRATOR Froausteamily ascal
(Create Siock Design Projectpat tcTad-1e

Open Biock Design Tap moouls nama:
Twgetianguags:

Sanulator anguage

Genarate Bsock Duzign

~ GmuLATION

Synesss Imgsmantaton Summary | Foute Stzs
Run Simusion Properties o EEe
o s Mot stanes s Notstanea
v RILAHALYSS Messages Messag
> Open Elaborated Design Far Pat
sstegy swategy
v sYNTHESS Repan srategy: Repar syatmgy
waremana) saesls. 1ooe Wncramental mlsmentton
¥ Runsminesis .
»
BRC Violations. Timeng Setwg | Hold | Pulse Widh
~ WPLENENTATION Run Imclsenantaton

¥ Run Impiementsnen

w5 Designiuns
Q ¥ # + %
 PROGRAM AND DEEUG

A Name Consyaints  Stahes VNS THS WHS THS TPWS ToluPuwer FalecRouis LUT FF BRAM URMM DSP Stn Elspsed  Run Strstegy

Repo Srstegy
v osmit coms¥sl  Notstared v

Vg

» Opan Haraware Mansger mpL1 conawst Notstaned Pertermance_ExraTimingOpt (\ado implementation 2018)  Vhato impkemenesad

Click Open Block Design on the left navigation bar to open block design

—
&, ® @ b B & T = DataA L
R
pp— — P —
rp— ——
aQa = 4 L] a a i ko a + B 4 C o | = Ostwtvew
B 1P Catalog yma_ultra_ps_e_1

~ IPINTEGRATOR

zynq_ultra_ps e 1
any wsign M_AXI_HPMD_FPD 4 [
marhpmd,_d_ack olresein] &
¥ SIMULATION - ploikd

Run Sriston P =T UltraSCALE*

~ RTLANALYSIS

> Open Eiaberaied Design

~ SWTHESIS
P RunSyrinesis.

> op
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1.2 Add axi_gpio IP core and configure it

Click Add IP .Enter axi_gpio, then double-click AXI GPIO to add axi_gpio core.

Diagram x Address Editor x

@ a2 ml el a ® # C ¢ |=Defautview v

Itt AXI GPIO I

zynq_ultra_ps_e_1

M_AXI_HPMO_FPD i}
maxihpm0_fpd_aclk pl_resetnd
® pl_clko

UltraSCALE*

Zyng UltraScale+ MPSoC

ENTER to select, ESC to cancel, Ctrl+Q for IP details

Double-click the axi_gpio core to set parameters.

# Designer Assistance available. Run Connection Automation

axi_gpio_0

A+ s ax
s_ax_aclk Grio + |||
g s_a_aresetn

AXI GPIO

zyng_ultra_ps_e_1
maxihpm0_fpd_aclk E YNQ
®

UltraSCALE*

Zyng UltraScale+ MPSoC

check all Outputs, GPIO Width to set to 1, and click OK.
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#% Re-customize IP >
AXI GPIO (2.0) P
@ Documentation IP Location
§
[ show disabled ports Component Name axi_gpio_0
A
GPIO
(] AllInputs
All Outputs
GPIO Width 1 [1-22] ’;
Default Output Value  0x00000000 @ [0x00000000,0xFFFFFFFF] N
+ 5 X Default Tri State Value 0xFFFFFFFF 3] [0x00000000,0xFFFFFFFF] '
s_axi_aclk GPIO
o i " [_] Enable Dual Channel [
0 s_axi_aresetn
P
GPIO 2 L
All Inputs
All Qutputs T
v GPIO Width 32 [1-32]
Default Output Value  0x00000000 @ [0x00000000,0xFFFFFFFF]
E hd
[_] Enable Interrupt
It
Click Run Block Automation - > OK to connect automatically
,‘ Designer Assistance a\failable.l Run Connection Automation
r axi_gpio_0 ’
4+ S_AXI
k GFIO +
etn
L AXI GPIO -
Check all the options and click OK
#  Run Connection Automation x
Automatically make connections in your design by checking the boxes ofthe interfaces to connect. Select an interface on the leftto display its configuration options on p
the right.
]l a = =
~ h | Automation (2 out of 2 selected)f
~ [ ¥ axi_gpio_0
[ GPIO
&) O S_AX1
L
N
Select an intsrface pin on the left panel to view its options !
T® o
sle . .
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Click "optimize routing" to optimize the layout. At the same time, you can see that
there are two more modules. One is the processor system reset module, which provides
the reset signal of the same clock domain for the synchronous reset module. Axi

interconnect module is an Axi bus interconnection module, which is used for the cross
interconnection of Axi modules.

Diagram  x Address Editor  x

200
@ e u® o a s+ s E oA C = Defauttview . o
EiE
OEHER
zynq_ulra_ps_e_1
‘ ps8_1_axi_periph
- @
M_AXI_HPMO_FPD |} e
maxihpm0_fpd_ack pl_resetnd ACLK
pl_clko ARESETN [ b |
+ S00_ACLK H=E Moo Ax + i
UttraSCALE gt N B
Zyng UlraScale+ MPSoC MOO_AGLK
System Net: zyng_ultrd ps_e_1_pl_clko N
TSI_psB_1_Oum C
AXI Interconnect
slowesl_syne_ck mb_reset
ext_reset_in bus_struct_reset[0:0]
0 aux_reset_in peripheral_reset[0:0]
= mb_debug_sys rst intercannect_aresetn[0:0]
= dom _locked peripheral r
Processor System Reset
Sfusih
Change the name of GPIO port to led.
BLOCK DESIGN - ps_mocuie * 2 x
s Design o Signals 2 _ DO | | Degam  x AddressEdior x oo
Q = A o a a I & o Q : + E &, C o = DefaulVew -
ps_modue
o Estemal intertacas
» = gplo_m_0
Interizce Connectons yna_uire_ps.e_1

> pe8_1_axi_periph
. - G
» % an_gpo_0 (& M_AXI_HPMO_FPD) 4 |1 £+ so0axi
S axbont_tod sck pLrosss acix ax_gpio_0
> 181 ps&_1_ai_parip! pleko ARESETH zu | |
s et

st psa_1_om . . UltraSCALE+ "l san
ama_ula_ps._e_1 -

Zynq Ulrascales MPSaC

Lansck  GPIO +
100_ACLK Pp—
1A00_ARESETH
External Interface Properties. ? 00X ‘—m_p!EJ_BSM ~ AXI Wterconnect g
< gpie_t_0 - o et _syme_c mb_tesat

S00_ACLKC BW wooan +|
soo_aneseTi g X g

]

I g e ——
x_rosel_in I_resedf0-0]
N C e perotu
o o vt o
Mode  WASTER g < o s

Connaction |- ani_gpio_U_GPIO

General | Fropemes

1.3 Generate synthesis files

Right click ps_module.bd ->Generate Ouput Products->Generate
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Sources x Design Signals ?2 _0O0G Diagram x Address Editor x
Q = =+ 0 #| @ a I m o Q =
« - Design Sources (1) 1
~ @ & ps_module_wrapper (ps_module_wrappery) (1)
v Zl}s_module_i - ps_module (ps_m- "t l
- — Source Node Properties.. Ctrl+E zZyn
v @ ps_module (ps_maodulev) (1)
> 4F[E zyng_ultra_ps_e_1:ps_n f= OpenFile Al
» Constraints (1) Create HDL Wrapper...
1_ack
» [ Simulation Sources (1) View Instantiation Template
» Utility Sources
Generate Qutput Products... |
e — Ul
Hierarchy = IP Sources  Libraries  Compil Reset Output Products... Zynq U
" . rs
Source File Properties
ne modile hd A slowest_sync_clk

Select Out of context per IP and click generate

¢  Generate Qutput Products >
The following output products will be generated. ‘
= |
Preview
A (e} - - e
il —
: o =] ps_module.bd (OOC per IP) o i
=l Synthesis
= Implementation
) = Simulation
. el
Synthesis Options
) Global
I 2t of context per IF I
{1 Out of context per Block Design
Run Settings
Mumber of jobs: | 2 ~ I
@ [ wn
! =
ma 1l +ra me a 14TMata a+ cO=-AOO0 Oonn | /4R | s

1.4 Adding xdc pin constraints

Right click Constraints-->Add Sources
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Sources % Netlist | Device Constraints 2 _ 00 Package % | Device »  ps_module_wrapper.v ¥ src.dc ¥
Q = £ 4+ 2 3 o D:FZ3/4GB/axi_gpiofaxi_gpio.srcsisources_1/bd/ps_module/hdlips_module_wrappery
w Design Sources (1) Q N E o
~ @ . ps_module_wrapper (ps_module wrappery) (1) — o -
10 Rights Reserved.
¥ [E] ps_maodule_i : ps_module (p=_moadule bd) (1) . w py
> IConstraims 1 I| 3 ‘ Version: v. 2020.1 iw d 2902540 Fed May 27 1 249 MDT 2020
» [ Simulation So 4 21503
> Utility Sources Hierarchy Update » : ; 049 5200)
6 d
' Refresh Hierarchy i
IP Hierarchy » 3,
5G /
Edit Constraints Sets... 10 | “timescale 1 ps / 1 ps
Edit Simulation Sets. . 1
125 moduls ps_moduls_wrapper
_________________ 4+ AddSources.. Alt+A I 13 (led_tri_o);
Hierarchy  IF Sol 14 output [0:0]led tri_o:
% Report IP Status }_ 15 |
T ! i 0:0]1ed_tri_o;
Source File Properties .  Clock Regions 2 _ 00 1? ' wire D:lled trie
17 .
ps_module.bd - £ 15 psmodule pemodulei
19 1 (. led tri_o(led tri_a));
~ !
Enabled 200 endmodule
Select Add create constraints and click Next.
¢  Add Sources e

Add Sources

VIVADO!

MLy Editions This guides you through the process of adding and creating sources for your project

Add or create constraints

Add or create design sources

Add or create simulation sources

£ XILINX. |
©

TEg DT AT T T L2 B = -1 e e oo TTET TV g TTEW TYPE

Einish

Click Create File
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T
¢  Add Sources e

Add or Create Constraints

Specify or create constraint files for physical and timing constraint to add to your project. '
Specify constraint set: constrs_1 (active) o
+

Fl
Constraint File  Location

srexdc DIAFZ3dGB\axi_gpiot\axi_gpio.srcs\iconstrs_Tinew

Add Files || Create File

E] Copy constraints files into project

@ Mext = | Einish | | Cancel |

TEg DT AT T T L2 B = -1 e e oo TTET DTV E T TTEW TYPE

Enter the name of the new xdc file and click OK

3_ ¢ Create Constraints File )4
Create a new constraints file and add it to
your project ‘
al
File type: - XxDC w
File name: srd
File location: | & =Local to Project= 4
®
sy |
Click Finish
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T
¢  Add Sources e
1
Add or Create Constraints
Specify or create constraint files for physical and timing constraint to add to your project. '
Specify constraint set: constrs_1 (active) o
+A
Constraint File  Location
'I- srexdc DIAFZ3dGB\axi_gpiot\axi_gpio.srcs\iconstrs_Tinew
i
g
Add Files || Create File
E] Copy constraints files into project
@ Mext = | Einish | | Cancel |
THEg T T T TIRET DA oo VLU VTET  DTIVE SwETTgT oW Ty
Add xdc file
Sources % Netlist Device Constraints 2 _ 00O Package % | Device ¥ | ps_module_wrapper.y w sroxde
Q = $ 4+ B 3 - Du/FZ3/4GB/axi_gpio/axi_gpio.srcs/constrs_1inew/srcxdc
~ - Design Sources (1) o - ¥ B B X N/ E O

@ 2. ps_module_wrapper (p=_module_wrapperv) (1)

b [E ps_module_i: ps_module (ps_module.bd) (1)

w Constraints (1)

~ o constrs_1(1)

sroxde (target)

b Simulation Sources (1)

o W e

set_property IOSTANDARD LVCMOS33 [get_perts {led_tri_o[0]}]
set_property PACKAGE_PIN AA13 [get_ports {led tri_o[0]}]

> Utility Sources
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1.5 Generate bit files

[ axi_gpio - [D/FZ3/4GB/axi_gpiofaxi gpioxpr] - Vivado 2020.1

Eile Edit Flow Tools Reporls Window Layout Yiew  Help - Quick Access

=, - B xab‘ll,-nbz ¥
low Navigator "5 ELABORATED DESIGN - xczu3eg-sfic7g4-1-e
PROJECT MANAGER A
Sources  x Meflist | Device Constraints ? _ O | Package x|Device x| ps_module wrapperv x| srexdc
£ Settings .
Q = &£ 4+ 1 3 o DAJFZ3/4GB/axi_gpiolaxi_gpio.sresiconstrs_Unewlsrexdc
Add Sources

~ = Design Sources (1

Language Templates ~ @ 2~ ps_module_wrapper (ps_module_wrappery) (1

¥ IP Catalog > ps_medule_i: ps_module (ps_medule.bd) (1)

= Constraints (1)

* 1P INTEGRATOR - constrs_1 (1
Create Black Design I srexac target)
> Simulation Seurces (1
Open SlockDesian 5 = Utilty Sourcas

Generate Block Design

 SIMULATION

Runsimulation | oo
Hierarchy  IF Sources Libraries ~ Compile Order

RTL ANALYSIS.

Source File Properties  » Clock Regions 2 _0Oo
~ Open Elaborated Design
I srexde - -3
Report Methodology
~
Report DRC Enabled
Report Noise Loeation D:IFZ3/4GB/ax_gpio/ax_gpio.sresiconstrs_1imew
— V]
*1 schematic L . 2

General  Properiies

1.6 Export Hardware Profile

Q -« » B B X N E Q

@k W e e

| set_property IOSTANDARD LVCMOS33 [get_ports {led_tri_o[01}]
| set_property PACKAGE PIN AA13 [get_ports {led tri_o[0]}]

Click File - > Export - > Export Hardware - > OK on the menu bar to export the hardware

configuration file

¢ axi_gpio - [DyFZ3/4GB/axi_gpio/axi_gpioxpr] - Vivado 2020.1

File Edit Flow Tools Reports Window Layout

View  Help - Quick Access

) 4

?2 00

o =
Project » |! >, A )
Add Sources... Alt+A }AB‘ORATED DESIGN - xczu3eg-sfvcigd-1-e
1 Close Project
wurces  x MNetlist | Device Constraints
Close Elaborated Design -
o = = + @ 3
Constraint:
Lonstraints ' b Design Sources (1)
~ @ 2 ps_module_wrapper (ps_module_wrappery
- - ; SAle B )
Checkpoint y » = [m ps_module_i: ps_module (ps_module. bd) (1)
v Constraints (1)
IP
P - ' w constrs_1 (1)
Text Editor 3 " srcxdc (target)
Import b Simulation Sources (1)
I Export II Export Hardware ...
Print .. Cirl+P Export Constraints...
] . Export IBIS Model..
Exit
Run Simulation - 1 BxportliO Ports..
iraries Compile Order
~ RTL ANALYSIS | Export Simulation... o

Package x | Device

DuFZ3/14GBlaxi_gpiolar

Q

[ R

-

set_property I0
set_property P&
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1.7 Launch Vitis and create new platform project

Click Tools > launch Vitis ide on the menu bar to launch Vitis

/’

File  Edit  Flow

=

Fl

Flow Navigator

~ PROJECT MANAGER

Tools

Reports Window

axi_gpio - [%/FZ3/4GB/axi_gpio/axi_gpio.xpr] - Vivado 2020.1

Layout  View  Help Q- Quick Access

Create and Package New IP... |

Create Interface Definition...

Enable Dynamic Function eXchange...

? 00X Pra
L+ settings Run Tc! Script...
P Edit: C ﬁ o
rope itor Ctrl-+J
Add Sources perty
Associate ELF Files...
Language Templ: o module_wrapperv) (1) S
Generate Memory Configuration File...
F P catalog pdule (ps_module bd) (1) P
Compile Simulation Libraries... _
ydule.v) (5) P
v IP INTEGRATOR XHub Stores... P
Custom Commands »
Create Block Des = P
. it T
Open Black Desig Launch Vitis IDE
T
Generate Blockp| & Language Templates
)
£ (selings.. 00 s
5 Compile Order
Vv SIMLUIATION I
Click File=>Switch Workspace—> Other...,
 vitis - ps_module wrapper/platform.spr - Vitis IDE - o x
Fle| Edit  Search Xiinx Project Window Help
New AsSHIEND |+ @ v i g0 w180 v v [Quick Access| | |[ Design | %5 Debug
Open File... -
O || ps_module_wrapper sﬂ = O ||Bz Outline sﬂ = g
Close Ctrl+W =
Close All Ctrl+Shift+W. type filter te. [ = %/| platform: ps_module wrapper An outline is not available.
Save Crrl+s v B ps_module_wrapper
Save Al Ctrl+Shife+S ~ 8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
o El Board Support P4 pescription: ps_module wrapper
v [ standalone on psu_(
(e [ | Board Support Py
§1 Refresh Fs v} psu_pmu 0
Import... v [22 zynaqmp_pmufw Samples: Browse.. | |Q,
Export. | Board Support Py
port.. Generate boot components
P Alt+Enter pre-bult Components
Switch Workspace > DA\FZ3\4GB\axi_gpic\vitis FsBL: Browse...
Restart D:\FZ2\4GB\gpio_emiolvitis EMU Firmwares Browse..
Exit DAFZ3\4GBhello_world\vitis
T EUSTLSySE IS pagitis
> €} axi_uart [Application] . DAMPSOC\3EG\gpio_emio\vitis
ps_module_wrapper [Platform] DAMPSOC\3EG\gpio_emio B
DAMPSOC\AEVihello_world\vitis.
DAMPSOC\IEG\hello_warldwitis Log (@) Guidance BREE| 2--=0
DAFZ3\AGB\art_cyclelvitis
Giher lare\vitis\ps_module_wrapper\platform.spr}
- per}
0 items selected

elect the path, select the vitis folder under gpio_emio project. Click launch.
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TR —— T

% Eclipse Launcher *
Select a directory as workspace
Vitis IDE uses the workspace directory to store its preferences and development artifacts.
Workspace: I DAFZ3AGE\axi_gpio\vitis ~ I Browse...
» Recent Workspaces
» Restore other Workspace
b Copy Settings
@
Click Create Platform Project
«J vitis - Vitis IDE - ] bd
Fle Edit  Search Xiinx Project Window Help
ERITT— p—
W XILINX
a VITIS.
I I I
PROJECT PLATFORH RESOURCES

Create Application Project

Create Platform Project

Create Library Project

Import Project

Add Custom Platform Vitis Documentation

Xilinx Developer

The project name uses the same name as the xsa file.

Click next.
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4
7| «d New Platform Project m} x

=| Create new platform project

Enter a name for your platform project

Project name: | ps_modul e_wrapperI

Use default location
Location: | DAFZ3\4GB\gpio_emio\vitis\ps_module wrapper Browse

Platform
Project

= A system project is a container for multiple
applications that would run on different domains of
a platform at the same time.

= A domain is the BSP/OS that controls one or

[ i . .
Processor I Domain more isomorphic processors.

- A platform contains one or more domains.

XSA » A workspace can contain unlimited platforms and
unlimited system projects
t
1
® = Back MNext = Finish Cancel

Select Create from hardware specification(XSA),click NEXT.

4
| «d New Platform Project O x

=| Platform Project

Create new platform project

Create a platform project from the output of Vivado [Xilinx Shell Archive (XSA)] or from an existing platform. A platform will enable you to
specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for
embedded software developers.

(®) Create from hardware specification (XSA)

Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

(O Create from existing platform

Load the platform definition from an existing platform. You can choose any platform from the platform repository as a base for your
platform project.

@ <Back | Next> Finish Cancel
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Open Browse..., select the previously generated xsa file.

« MNew Platform Project O >
Platform Project Specification
| Provide the hardware and software specification for the new platform project b

9 Hardware Specification

XSA file: |

FTFHO) B

Browse...
4 sctiu=y Hardware Specification File >
P
N
Ope| € - 4 « FZ3 » 4GB » axi_gpio » vitis ~ [J] 2 = vits”
Prod smin ~  grEErees =~ M @
& OneDrive ~ = fERTEEE =5
O e .metadata 2020/11/4 9:30 T
T RemoteSystemsTempFiles 2020/11/4 9:30 ig==
S LS
I || ps_module_wrapper.xsa 2020/11/4 9:31 XSA 3T I
B s
= Bs
pex =
& T
b B
W =m
2 ammmmoeen ¢ € >
SZFE(N): | ps_module_wrapper.xsa \/| *xsa;*.dsa; ~

2l

@ <mack | Cancel

Leave the default and click finish.

) New Platform Project O *

Platform Project Specification

Provide the hardware and software specification for the new platform project

Hardware Specification

KSA file: | DAFZNAGB\axi_gpio\witis\ps_module_wrapper.xsa Browse...

{ Software Specification

L
Operating system: |standalone ~
Processor: psu_cortexa53_0 ~
Architecture: 64-bit ~

Mote: A domain with selected operating system and processor will be added to the platform. The platform project can be
madified later to add new domains or change settings.

Generate boot companents

Rl

® = Back Mext = Cancel
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1.8 New axi_gpio Project

Right click the blank space of the project navigation bar on the left and select

NEW->Application Project.

~ vitis - Vitis IDE

Project name: axi_apic

- Platform: ps_module_ wrapper
P R —
Damain: standalone on psu_cortexaS3_
N e —
N —

Hardware Sp. : View

«l Assistant &2 =g
ERS&R 0% -
~ % axi_gpio_system [System)
> {£} axi_gpio [Application]
ps_module_wrapper [Platform]

., memory ranges and peripherals.

View current BSP settings, or configure settings like STDIO peripheral
selection, compiler flags, SW intrusive profiling, add/remove libraries,
assign drivers to peripherals, change versions of OS/libraries/drivers
etc.

Navigate to BSP Settings

- a x
Fle Edit  Search Xiinx Project Window Help
D-ER ®-% S@iB-0-iF-ime- [2 Design | 45 Debug
4, Explorer 5 | D% 7 = O |[dpsmoduewrapper & axigpio system | % ax_apio | = 0 (82 outine 1| =5
o ; _ - - n out t availabl
> xi_gpio_system [ ps_module wrapper | K Application Project Settings Active buld configuration: |DeBUGIIY| ® n outline is not available.
+ B ps_module_wrapper
General Options

& Console sﬂ [£] Problems [E] vitis Log (i) Guidance

Build Console [axi_gpio, Debug]

"Finished building: axi_gpio.elf.size’

©9:54:28 Build Finished (took 2s.687ms)

0 items selected

Skip to the second page and select the platform project created above (default), next.

« New Application Project [m] P e
Platform
| {1y The selected platform has unbuilt changes in the workspace. Please generate the platform to use the |atest version. [
Select a platform from repositnry‘ [ Create a new platform from hardware (XSA) L
e — b G b
ol n
Narme Board Flow Vendor Path
|j ps_module wrapper [custom] Embedded SW Dev xilinx DA\FZ3\4GB\axi_gpio\vitis\ps_module_wrapperexporiyps_n|
< >
o | Platform Info
i Tl Acceleration Resources Domain Details
~
Name: s module wrapper “  The selected platform does not have Domains
! = P \eratt il
?) PP P | Domain name Details
part: xczuleg-sfuc7ad-1-e .
| standalone_domain | cPU: psu_cortexasa_ o
Family: Zynquplus
Description: L
ps_module_ wrapper L
v v L
< > )
@ < Back Next > Finish Cancel L

Project name enter axi_gpio, Next
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-« New Application Project [m] x
Application Project Details
| Specify the application project name and its system project properties [

=TT

Application project name: | axi_gpio |

4 System Praoject
ol

Create a new system project for the application or select an existing one from the workpsace @)
Select a system project System project details
o= Create new...
System project name: |axi_gpio system
Target processor
Select target processor for the Application project.
Processar Associated applications
| psu_cortexa53_0 axi_gpio
ol
Show all processors in the hardware specification [] @ 1
1@ < Back Next = Finich Cancel L
Next
-« New Application Project m| X b
Domain
Select a domain for your project or create a new domain 7
]
Select the domain that the application would link to or create a new domain
Note: New domain created by this wizard will have all the requirements of the application template selected in the next step ke
h
Select a domain Domain details
standalone_domain
MName: standalone_domain
+ Create new... =
Display Narne: standalone_domain
Operating Systern: [standalone ~ :
Pracessor: psu_cortexa53_0
e
E
E
E
E
E
E
\ ]
@ < Back Next Finish Cancel

Select Empty Application, Finish
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-« New Application Project

Templates

Select a template to create your project.

m}

X

Available Templates:

Empty Application

~ SW development templates
Empty Application (C++)
Hello Warld
IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server
IwiP UDP Perf Client
IwiP UDP Perf Server
Memory Tests
Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

Ablank C project.

T

| kiagisibg bikd b o)

Next =

[ ==

Copy the files in the example project to src, select the project, and click the compile buttom.

-~ vitis - axi_gpio/src/xgpio_example.c - Vitis IDE

fle Edit  Search Xilnx Project Window Help
iB-ER® FBHFE-0-F-iCe-- \ [ Design 4% Debug
L Exol [ Build ‘Debug’ for project 'axi_gpic’ | A - § = R =
_ Explorer 2 B odule wrapper & axi gpio_system % axi_gpio | [§ xgpio_example.c 52 B || 5 Outline 52 8
~ [ axi_gpio_system [ ps_module wrapper | 18 ~ BEAE o % ~
’?E‘ { standal rtexas3.0] 2 * Copyright (C) 2002 - 2020 Xilinx, Inc. All rights reserved w i "
ax_gpio [ standalone on psu_cortexads | 3 * SPDX-License-Identifier: MIT U xparameters.
> 4 Binaries 4 / u xgpioh
> @il Includes 5 , U il_printth
6
> = Debug 78 e # LED
v sre & * @file xgpio_example.c # GPIO_EXAMPLE_DEVIC
» [£] xgpio_example.c AN X X . . . # LED_DELAY
B lscriptld 10 * This file contains a design example using the AXI GPIO driver (XGpio) and LED CHANNEL
P! 11 * hardware device. It only uses channel 1 of a GPIO device and assumes that # LEDC
README.bt 12 * the bit 8 of the GPIO is connected to the LED on the HW board # XGpio_SetDataDirectic
> @ ide 13 0+ # XGpio_DiscreteRead()
R 14 * . .
% axi_gpio.prj 15 ¢ <pre> # XGpio_DiscreteWrite()
> @& _ide 16 * MODIFICATION HISTORY: # XGpio_DiscreteSet()
X axi_gpio_system.sprj 7 @ Gpio : XGpio
= 18 * Ve Who Date Changes
> B ps_module_ wrapper Yo s o CD0OTE O TEEE L = ® mainivoid) : int
20 * 1.00a rmm ©3/13/02 First release
af Assistant 52 = 8 21 * 1.8@a rpm ©8/24/83 Removed second example and invalid macro calls
R 22 * 2.802 jhl 12/15/83 Added support for dual channels
PE@R O 23 * 2,002 3y 4/20/05 Minor changes to comply to and coding guidelines
v B axi_gpio_system [System] 24 * 3.80a kfp 11/26/69 Minor changes as per coding guidelines.
o o 25 * 4.1 ]ks 11/18/15 Updated to use canonical xparameters and
> {6} axi_gpio [Application] 26 * clean up of the comments and code for CR 9@8381
ps_module_wrapper [Platform] 27 * 4.3 gk ©9/29/16 Modified the example to make it work when LED_bits are
28 * configured as an output. CR# 958644 ©

& Console sﬂ [£ Problems [E] vitis Log (i) Guidance

Build Console [axi_gpio, Debug]

"Finished building: axi_gpio.elf.size’

©9:54:28 Build Finished (took 2s.687ms)

45k 2 items selected

i e T

1.9 Generate BOOT.bin file

Right-click the system of APP project and select Create boot image.
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a vitis - ps_medule_wrapper/platform.spr - Vitis IDE

- [m) x

Fle Edit  Search Xlinx Project Window Help
T T R S [ pce] . R .ot
<L Explorer 5t B =0 [q ps_module wrapper 13 | & axi gpio system 3 axi gpio___[£) xgpio example.c = 8 |(2 outine 32| =g
> [&] axi_gpio_sys - N = + % =

> B ps_module_u Platform: ps_module_wrapper

) 4n outline is not available
Add Application Project...

! ) idule_wrapper
Add Library Project... cortexaS3 0 Name: ps_module wrapper
Add Hw Kernel Project... yngmp_fsbl Hardware Specification: ps_module wrapper.xsa
Paste Ctrl+V Board Support Pe  Description: ps_module_wrapper
® Delete tandalone on psu_c
) Refresh Board Suppoart Pz
| pmu_0
23 Import Sources...
(=] P
pnamp_pmuf Samples: Browse.. | Q
/i Export as Archive

Board Support P

) Generate boot components
Close System Project Pre-built Components

Build Project FSBL: Browse...

= — Clean Project
o Assistant 57 PMU Firrnware: Browse...
[ Create Boot Image

- Program Flash
+ B2 axi_gpio_sys g

» (3} axi_gpio [ C/C++ Build Settings s
ps_module v Team >
>
Run As > e Speciﬁcaﬁon‘
Debug As y =
M: Problems [E] Vitis Log (1) Guidance
Properties

nsale

platform read {D:\FZ3\4GB\axi_gpic\vitis\ps_module wrapper\platform.spr}
platform active {ps_module_wrapper}

[&] axi_gpio_system

Click Create Image to generate BOOT.bin Startup file.

+l Create Boot Image

Create Boot Image

Creates Zyng MP Boot Image in .bin format from given FSBL elf and partition files in specified output folder,

<

Architecture: | Zyng MP  ~

(O Create new BIF file @ Import from existing BIF file

Import BIF file path: |D:;‘FZSf4GB,’axi _gpiofvitis/axi_gpio_system/_ide/bootimage/axi_gpio_system.bif

| Browse...
Basic  Security
Output BIF file path: |D:fFZS,MGBfaxi_gpio,’vitis,’axiﬁpio_syslemf_ide{bootimage{axiﬁpio_syslem.bif | Browse...
| uDF data: | | Browse...
3 Osplit Output format: |BIN
Output path: |D:fFZ3/4GEfaxijpiofvitis,’axijpiDﬁsyslemfﬁide,‘bootimage,’BODT.bin | Browse...
Boot image partitions
File path Encrypted AutH | Add
(bootloader) D:/FZ3/4GB/axi_gpio/vitis/ps_module_wrapper/export/ps_module_wrapper/sw/ps_module_wrapper/boot/fsbl.elf none naon|
D:/FZ3/4GB/axi_gpiojvitis/axi_gpio/_ide/bitstream/ps_madule_wrapper.bit nane non|
D:/FZ3/4GB/axi_gpio/vitis/axi_gpio/Debug/axi_gpioc.elf none nony [ p i

L ® Preview BIF Changes Cancel

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD
card and run on the development board.
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-~ vitis - axi_gpio/src/xgpio_example.c - Vitis IDE
File Edit

D-EG ®-%

fg@i%-0

Search Xilnx Project Window Help

2T AL RCRAS

- a x

[2 Design | % Debug

L Explorer 2@1 G 7 = O || psmodulewrapper X axigpio_system % axi_gpio (@ xgpio_example.c zﬂ = B ||5 Outline >::<] =0
> il Includes - 18 ~ B o K ¥
N @D b 2 * Copyright (C) 2002 - 2020 Xilinx, Inc. All rights reserved w i "
& Debug 3 * spDX-License-Identifier: MIT H xparameters.
> = src a 7 u xgpioh
> @ ide N , Ul printth
- - 6
% axi_gpio.prj 70 7%= # LED
v (= de & * @file xgpio_example.c # GPIO_EXAMPLE_DEVIC
v (= bootimage 9 * # LED DELAY
I 10 * This file contains a design example using the AXI GPIO driver (XGpio) and LED CHANNEL
11 * hardware device. It only uses channel 1 of a GPIO device and assumes that # ¢
12 * the bit 8 of the GPIO is connected to the LED on the HW board # XGpio_SetDataDirectic
Teadeltog 13 # XGpio_DiscreteRead()
o 14 * . .
writebiflog 15+ # XGpio_DiscreteWrite()
A axi_gpio_system.spr] 16 * MODIFICATION HISTORY: # XGpio_DiscreteSet()
> B ps_module_wrapper 7 @ Gpio : XGpio
2 © 18 * Ver Who Date Changes P! "
@ B Yo s o CD0OTE O TEEE L . ° mainivoid) : int
20 * 1.00a rmm ©3/13/02 First release
af Assistant 52 = 8 21 * 1.8@a rpm ©8/24/83 Removed second example and invalid macro calls
22 * 2.802 jhl 12/15/83 Added support for dual channels
@R O% V| 23 +2leeazy edsze/es ninor changes to comply to Dowygen and coding guidelines
3 axi_gpio_system [Systen] 24 * 3.80a kfp 11/26/69 Minor changes as per coding guidelines.
o o 25 * 4.1 ]ks 11/18/15 Updated to use canonical xparameters and
> {6} axi_gpio [Application] 26 * clean up of the comments and code for CR 9@8381
ps_module_wrapper [Platform] 27 * 4.3 gk ©9/29/16 Modified the example to make it work when LED_bits are
28 * configured as an output. CRi 958644 ©
- e ‘ < >
&) Console sﬂﬁ: Problems [ Vitis Log (i) Guidance S EHE=-&KIB-08-=15
Build Console [axi_gpio, Debug]
*Finished building: axi_gpio.elf.size’ ~
©9:54:28 Build Finished (tock 2s.687ms)
v

[=] axi_gpio_system
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Chapter 4 axi_uart

This project mainly uses axi_uart core provided by Xilinx for rs485 data transmission.

1.1 Create project and configure IP core of PS

Based on "ps_hello" project, save as axi_ uart project.
Open PL interrupt.

~ Interrupts
Clock Configuration
~ PLta P8

DDR Configuration | 1RQO[0-7] |n - I
0

IRQ1[0-7]
e PS-PL Configuration
APU Leagacy Interrupts(IRQ, FIQ)

RPU Legacy Interrupts(IRQ, nFIQ) [ ]
» PStoPL
> Fabric ResetEnable ]
» Address Fragmentation
> Others
PS-PLInterfaces

Debug

:
I

44 Re-customize IP x
Zynq UltraScale+ MPSoC (3.3) P
@ Documentation IP Location
Page Navigator - PS-PL Configuration
O switchToAdvancedmode  * |Q | &
Search: Q-
P8 UltraScale+ Block Design
Name Select
1i0 Configuration ~ General

Check GPIO EMIO and select the bit width of EMIO as 1 bit in MIO configuration.
Click OK
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i /' Re-customize 1P X
'| Zyng UltraScale+ MPSoC (3.3) ‘
@ Documentation IP Location
5 Page Navigator - 10 Configuration
(") Switch To Advanced Mode ~ MIO Voltage Standard

Bank0 [MIO 0:25] | | Bank1 [MIO 26:51]| | Bank2 [MIO 52.77] | | Bank3 [Dedicated]
PS UltraScale+ Block Design

1/O Configuration

Clock Configuration « Q = =

LVCMOS18 LVCMOS18 LVCMOS18  » LVCMOS33  »

Search: Q-
DDR Configuration

Peripheral o Signal /0 Type  Drive Strength(mA)  Polarity Speed Pull Type Direction
= PS-PL Configuration > 12C “
[ PITAG

> () PMU

[Jcsu

> SPI

> UART

~ GPIO

GPIO EMIO | 1 - |

L > [¥] GRIOO MIO| £naple GPIO EMIO Peripheral | ~

» [¥] GPIOTMIO MIO 26..51 i

A () GPIO2Z MIO
> Processing Unit
> High Speed

> Reference Clocks v

Click GPIO_ 0 port, Right click and select make external to export the port signal.

zyng_ultra_ps_e_1 |

Block Interface Properties... Ciri+E

M_AXI_HPMO_FPD + )
maxihpm0_fpd_aclk I 0.0 + ’AI Highlight »
pl_ps_irqQ[0:0] pl_resetnl @
e

UltraSCALE+ =

Zynq UltraScale+ MPSoC B Cony ciri+C
Q, Search... Cirl+F
We  SelectAl Ctri+A
4  AddIP... Cirl+
Add Module...
ID" Make External Ctr+T
Pinning >

Click on the pin and change the pin name to rs485_en, and save the design.

~ ¥ zymq_ultra_ps_e_1 (Zynq UliraScale+ MPSoC:3.3
£ GPIO_D

0 M_AXI_HPMO_FFD 2yng_ultra_ps_e_1

= maxihem0_fpd_aclk

= ol cko o M_AXI_HPMO_FPD + i
maxihpm0_fpd_aclk GPIO_O + |[fomest
External Interface Properties 2 _0O0Ox plps_irg0(0:0] o plresetnd

e il UltraSCALE*

2ynq UltraScale+ MPSoC

Name:

Mode MASTER

Connection: [ == zynq_ultra_ps_e_1_GPIO_0

General  Properiies
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1.2 Add axi_uart IP core and configure it

Enter UART in the search bar and double-click AXI Uartlite to add the axi_uart core.

Search: Q- uart (2 matches)
F AXIUART18550

| # A Uarlite

zyng_ultra_ps_e_1

maxihpm0_fpd_aclk
pl_ps_irg0[0:0]
®

UltraSCALE*

M_AXI_HPMD_FPD -+ [3
GPIO_D +
pl_resetn0

pl_clko

rs485_en

Zyng UltraScale+ MPSoC

ENTER to select, ESC to cancel, Ctrl+Q for IP details
The added axi_uart core is shown in the following figure

¥ Designer Assistance available. Run Connection Autemation

axi_uartlite_0

UART +|||

) interrupt
O s_axi_aresetn

AXI Uartlite

zyng_ultra_ps e 1

maxhpm0_fpd_aclk
pl_ps_irg0[0:0) .

UltraSCALE*

pl_resetnd
plclko

M_AXI_HPMO_FPD i
GPI0_0 +||f

Zyng UltraScale+ MPSoC

rs485_en

Double-click the axi_uart core to set the baud rate to 115200
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Re-customize IP

AXI Uartlite (2.0)

o
€& Documentation IP Location
Show disabled ports Component Name axi_uartite_0

AX| CLK Freguency (Auto) 100 [10-200]MHz

Baud Rate 115200 -

Data Bits =3 5-g

Parity

& MNo Parity oad Even
oK | | Cancel
Click Run Block Automation - > OK to connect automatically

Diagram  x Address Editor  x 00
@ € i m ¢ Q + = 2 F C U

# Designer Assistance available| Run Connection Automation

zyng_ultra_ps_e_0

M_AXI_HPMO_FPD [

pl_resetn0 .
maxihpmO_fpd_aclk pl_clkD
®

pl_clk1

UltraSCALE* P

Zyng UltraScale+ MPSoC

r axi_uartlite_0 -1

L AXI Uartlite <

Check all the options and click OK

Run Connecticn Autol

Automatically make connections in your design by checking the boxes ofthe interfaces to connect. Select an interface on the leftto display its
configuration options on the right ’

Q T =
~ [ }n\lmw (2 out of 2 |
~ | &F axi_uartlite_0
24 S_AKI
) {ik UART

Select an interface pin on the left panel to view its options

After the automatic connection is completed, the following figure is shown.
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rst_ps8_1_88M

ps8_1_axi_periph

slowest_sync_dk
ex_reset_in
<@ aux_reset_in
— mb_debug_sys_rst
— dem_locked

mb_reset
bus_struct_reset{0:0]
peripheral_resetj0:0]
intercannect_aresetn{0:0]

+
i+ S00_AXI
ACLK
ARESETN
SO0_ACLK
SO0_ARESETN g

X

peripheral_

Processor System Reset

zynq_ultra_ps_e_1

HE Moo_AXI + [

AX| Interconnect

M_AXI_HPMO_FPD o | et

axi_vartlite_0 1

X1 Uartlite

ZYNQ™

maxihpm0_fpd_aclk cpPioo +|f > rs485_en
pl_ps_im0{0:0] pl_resetnd
pl_cko
UltraSCALE*
Zynq UltraScale+ MPSoC
hesis fil
1.3 Generate synthesis files
Right click ps_module.bd ->Generate Ouput Products->Generate
¢ axi_uart - [Dy/FZ3/4GB/axi_uart/axi_uartxpr] - Vivado 2020.1
File Edit Flow Tools Reports Window Layout View  Help Q- Quick Access
Y B X b W & T ¥
Flow Navigator A PROJECT MANAGER - axi_uart
v PROJECT MANAGER
Sources 2 _ 00O % Project Summary
& Seftings - .
a z =2 + o Overview | Dashboard
Add Sources
~ Design Sources (1)
Language Templates « @ = ps_module_wrapper (ps_module_wrappery) (1) Settings  Edit
IF 1P Catalag v O ps madiin i ne modula tne_maduls hd\(j\ D |
PY Source Mode Properties.. Ctrl+E
? P Project location [
R o] Fil Alt+0r
v |PINTECGRATOR ¥ Constraints ( = pen File Product family: i
Create Block Design > [ Simulation 3¢ Create HOL Wrapper.. Project part >
Open Block Design 4 Utility Sources View Instantiation Template Top module name: ]
Generate Output Products.. Targetlanguage Al
Generate Block Design Simulator | . !
_________________ Resst Output Products b imulator fanguage:
Hierarchy IP Sa
v SIMULATION
] Synthesis
Run Simulation Source File Propert » _ 0@ X
Status v
ns maodule hd o
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1.4 Adding xdc pin constraints

PROJECT MANAGER - axi_uart

% srexde  x

Sources 2 _0O0OX Preject Summary
Q = £ + 0 & G:IFPGAIFZ3/axi_uartivivado/axi_uart sres/constrs_1/new/src xdc
v = Design Sources (1 A
9 \) X B B X/ W 0
> @ = ps_module_wrapper (ps_module_wrapper v) (1)
set_property LOSTANDARD LVCHOS33 [get_ports [GPIO_O_tri_ie[0]}]
v [ Constraints (1) set_property PACKACE_PIN W14 [get_ports {CPIO_0_tri_io[0]}]
~ = constrs_1(1)
I sre.xde (target) set_property IOSTANDARD LVCHOS33 [get_ports uart_rtl_0_rxd]
t. ty IOSTANDARD LVCHOS33 [get_port: t_rtl_0_txd
» = Simulation Sources (1) set_property [get_ports uart_rtl_0_txd]
] v set_property PACKAGE_PIN AB15 [get_ports uart_rtl_0_rxd]
Hierarchy P Sources Libraries Compile Order set_property PACKAGE_PIN 4Bl4 [get_ports uart_rtl_0_txzd]
Source File Properties 2 000G X
I sre.xde &
PN
(] Enabled
Location: G:/FPGAFZ3/axi_uartivivado/axi_uart.srcs/constrs_1/new
Type: XDC B
R DAKB .
General  Properties 2
156G it fi
. enerate pit files
¥ axi_uart - [G/FPGA/FZ3/axi_uart/vivadofaxi_uartxpr] - Vivado 2020.1
Fle [Edt Flow Tools Repots Window Layout View Help O QuckAccess
3 B X » & = »
Flow Navigator PROJECT MANAGER - ax_uart
~ PROJECT MANAGER 2 -
Sources 2 _ O x |ProjectSummary x| srexde
& Settings
aQa T & + - GUFPGAFZ3axi_uartvivado/axi_uarl srcsiconsirs_1inew/src.xdc
Add Sources o 5 "
1)
SN Sures a X B WM X N E O
Language Templates = ps_module_wrapper (ps_module_wiapper v) | .
i fet_property I0STANDARD LVCNOS33 [get_ports [GPI0_0_tri_
& IP Catalog Constraints set_property PACKAGE PIN ¥14 [get_ports (GPI0_0_tri_io[0])]
constrs_1 (1
~ P INTEGRATOR [ src.xdc (target) set_property IOSTANDARD LVCNOS33 [get_ports uart_rtl_0_rxd]
Simulation Sources | set_property 10STANDARD LVCHOS33 [get_ports wartril 0 txd)
Create Block Design v set_property PACKAGE PIN AH15 [get_ports uart_rtl_0_rxd]
Hierarchy 1P Sources  Libraries  Gompile Order set_property PACKAGE PIN AH14 [get_ports uart_rtl_0_txd]
Open Block Design
Generate Block Design T — 5 _EEE
I srcxde
¥ SIMULATION @
Run Simulation ) Enabled
Location: G Z3/a_ _uart _1inew
¥ RTLANALYSIS am
Type: XDC 4
> Open Elaborated Design
\ Size N4k v
General  Froperiies i
v aVNTUCSE

1.6 Export Hardware Profile

SRS FRY File->Export->Export Hardware->0K 5 H il it B SC A
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¢ axi_uvart - [G/FPGA/FZ3/axi_uvartfvivado/axi_uart.xpr] - Vivado 2020.1
File Edit Flow Tools Reports Window Layout View Q-Q
Project » Ao X ¥
I Add SUQFCES... Alt+A, PROJECT MANAGER - aJ(i_uart
Close Project
Sources
Qa T & +
v Design Sources (1)
Checkpoint » > @ & ps_module_wrapper (ps_module
P , v Constraints (1)
v constrs_1 (1)
. Text Edtor ’ [0 srcxdc (target)
> Simulation Sources (1)
Export Export Hardware._ | -I_i-b-rér-itﬂ:s- o (-3-0r-"r
Print... Strl+P Export Bitstream File...
] Export Simulation. ..
Exit -
— R
1.7 Launch Vitis and create new platform project
Click Tools > launch Vitis ide on the menu bar to launch Vitis
¢ axi_uart - [Dy/FZ3/4GB axi_uartfaxi_uartxpr] - Vivado 2020.1
File Edit Flow  Tools Reports Window Layout  View  Help Q- Qluick Access
EA * Create and Package Mew IP...
Flow Navigator Create Interface Definition...
~ PROJECT MANAGER Enable Dynamic Function eXchange. ..
? 1
£+ Settings Run Tcl Script...
Property Editor Ctrl+J

Add Sources

Associate ELF Files ..
Language Templ:
Generate Memaory Configuration File. .

TF P Catalog
Compile Simulation Libraries. ..

v P INTEGRATOR XHub Stores...

Create Block Des LTSI TR

Open Black Desig Launch Vitis IDE

Generate BlockD| @  Language Templates

Click File=>Switch Workspace—> Other...,

| module_wrapperv) (1)

£ Setfings.. = feeeeeeeeeeeiees
3 Compile QOrder
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~ vitis - ps_module_wrapper/platform.spr - Vitis IDE

o x

File | Edit  Search Xiinx Project Window Help
New ARSSHILND | v @ w047 w100 G0 v o v [Quick Acce] | |7 Besign] 45 Debug
Open File...
O ||~ ps.module wrapper % | = O |[8: outine 5 | =0
Close Cirl+w =
: e filter te & .
Close Al Curlshiftew Eis EE % X1 platform: ps_module wrapper an outline is not available.
Save Cerl+s B
Save As.. ~ £} psu_cortexas3_0 Name: ps_module wrapper
Save Al Ctrl+Shife+S ~ =8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
e E| Board Support P Description: g e e—
v [ standalone on psu_(
(Renmie= = | Board Support Py
&) Refresh = « £} psu_prmu 0
s
Import... v [ zynamp_pmutw Samples: Browse.. || Q
Export. | Board Support Py
port.. Generate boot components
Properties Alt+Enter Pre-built Components
Switch Workspace > DA\FZ3\dGB\axi_gpic\vitis FBL: Browse...
Restart DAFZ3\4GB\gpio_emiolyitis. BMU Firmare: Browee..
Exit DAFZAGBAhello_worldivitis
AR UE T SYSTET TS Y STE Di\vitis
> {8} axi_uart [Application] DAMPSOC\3EG\gpio_emic\vitis
= .
ps_module_wrapper [Platform] DAMPSOC\3EG\gpio._emio B
DAMPSOC\AEV hello_worldvitis
DAMPSOC\3EG hello_worldwitis Log (D Guidance BRpEER B-mNr=8

DAFZ\4GB\uart_cyclevitis

Other...

lre\vitis\ps_module_wrapper\platform.spr}
per}

0 items selected

elect the path, select the vitis folder under axi_uart project. Click launch.

% Eclipse Launcher

Select a directory as workspace

Vitis IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | DAFZMAGE\axi_uartivitis

V‘ | Browse...

» Recent Workspaces
» Restore other Workspace

b Copy Settings

@

Launch

Cancel

Click Create Platform Project

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com

82 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/

RKINEE =

Make Your IdeaReal

MYiR

MYD-CZU3EG

FPGA JF & F it

«J vitis - Vitis IDE

Fie Edit  Search Xiinx Project Window Help

& [ Welcome 5 |

=1

XILINX

VITIS.

o

&
VITIS
IDE

PROJECT PLATFORM

Create Application Project Add Custom Platform

Create Platform Project

Create Library Project

Import Project

RESOURCES

Vitis Documentation

Xilinx Developer

T T m
The project name uses the same name as the xsa file. Click next.
o
“| = New Platform Project m] x [
| Create new platform project
| Enter a name for your platform project I
Project name: [ps_module wrappet |
Use default location
Location: | DAFZ3\4GB\gpio_emic\vitis\ps_module_wrapper Browse
Platt:orm = & S et e s o s e aediole
FrOJect applications that would run on different domains of
a platform at the same time.
h _ = A domain is the BSP/OS that controls one or
Processor I Domain maore isomorphic processors,
- A platform contains one or more domains.
XSA - A workspace can contain unlimited platforms and
unlimited system projects
t
iy
@ < Back Next = Finish Cancel
|
Select Create from hardware specification(XSA),click NEXT.
¥57 | ® mcemenon ) mom
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ad Mew Platform Project

=| Platferm Project

Create new platform project

O x |

embedded software developers.

platform project.

(@ Create from hardware specification (XSA)

(O Create from existing platform

Create a platform praoject from the output of Vivado [Xilinx Shell Archive (XSA])] or from an existing platform. A platform will enable you to
specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for

Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

Load the platform definition from an existing platform. You can choose any platform from the platform repository as a base for your

t
r
@ < Back Next > Finish Cancel
Open Browse..., select the previously generated xsa file.
N ) New Platform Project O *
Platform Project Specification
. Provide the hardware and software specification for the new platform project
Hardware Specification |
q
b XSA file: | Browse... r
Software 5§ W) Hardware Specification File *
L | € v « 4GB » axi_uart » vitis » v O P vitis”
\ Operatin
Process{ HiR ™ = = O @
= ~ o ER BB =]
=as .metadata 2020/11/4 1017 it
= RemoteSystemsTempfFiles 2020/11/410:17 it
¥ T | L] ps_module wrapper.xsa 2020/11/4 10:06 XSA 3% |
) =5
W =5
i AR (C)
- HE (D)
- AR (E) I
- (R < 5 2]
IEE(N): | ps_module wrapper.xsa V| *xsa;*.dsa; ~
b
F17(0) s '

= Back Mext =

Leave the default and click finish.
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! -« Mew Platform Project O > n
_| Platform Project Specification
7| Provide the hardware and software specification for the new platform project
Hardware Specification |
- WSA file: | DAFZ3\AGB\axi_uarfwitis\ps_module_wrapper.xsa Browse... L
Software ification
: Operating system: | standalone ~
Processor: psu_cortexa53_0 ~
Architecture: 64-bit ~
Mote: A domain with selected operating system and processor will be added to the platform. The platform project can be
modified later to add new domains or change settings.
Generate boot components
| ]
k1
B
i
£

= Back MNext = Cancel

1.8 New axi_uart Project

Right click the blank space of the project navigation bar on the left and select

NEW->Application Project.

-~ vitis - Vitis IDE - [m] b4
file Edit  Search Xilinx Project Window Help
i - EH @ - & SHiH-0-iF i~ [ Design | 4% Debug
L Explorer S@W BlS ey T = O ||wpsmodule wrapper & axiuart system 5 axi_uart [@ xuartlite_low level example.c 52] = B ||5 Outline >::<] = 8
> [E] axi_uart_system [ ps_module wrapper ] 97 * fgnote Nene. ~ BN o % ©
98 *
> [B] ps_module_wrapper . y % xparameters.h
1067 int main(void) o xstatush
101 U artlite Lh
102 int Status; PR
103 w il printfh
. 1048 /* w silioh
105 * Run the UartLite Low level example, specify the BaseAddress that is U sleeph
106 * generated in xparameters.h - X
107 *f % xgpiopsh
108 Status = UartLitelowlevelExample (UARTLITE BASEADDR); # UARTLITE_BASEADDR
109 if (Status != XST_SUCCESS) { # TEST BUFFER SIZE
11@ xil_printf(“Uartlite lowlevel Example Failed\r\n"); . .
111 return XST_FAILURE; ® Gpio: XGpioPs
112 } @ ConfigPtr : XGpioPs_C:
113 N . . y # GPIO_DEVICE_ID
114 il_printf("s i E )5 y - N
3| it Succshully rin Uacklise kel Cxsepleie\n’) % Usntielowteelam
- = =0 return XST 3 - i
o Assistant 116 } @ SendBuffer: ug[]
B SR 0% v 117 @ RecvBuffer : us]
: 118
v B axi_uart system [System] 119 / o mainlvoid) : int
> {8} o uart [Application] Ez— 1 o UariliteLowlevelExam
ps_module_wrapper [Platiorm] 122 * This function does a minimal test on the Uartlite device using the low-level ©
o : - ‘ ‘ ‘ ‘ < >
B Console 5% |21 Problems [F] Vitis Log (D) Guidance T4 B B T& B -8-=0
Build Console [axi_uart, Debug]
S G s e e =
10:36:51 Build Finished (took 2s.613ms)
v
< >
0 items selected

g L L e
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Skip to the second page and select the platform project created above (default), next

‘& New Application Project m] %
Platform
(i The selected platform has unbuilt changes in the workspace. Please generate the platform to use the latest version.
Select a platform from repositnryl /77 Create a new platform from hardware (XSA)
Name Board Flow Vendar Path |
[E5 ps_module_wrapper [custom] Embedded SW Dev silinse D\FZ3\AGB\axi_uart\vitis\ps_module wrapperiexportips m | |¢
i
of n
< >
Platform Info
General Info Acceleration Resources Domain Details
-
Name: ps_module wrapper " The selected platform does not have Domains
— application acceleration capabilities I [ e e
E Part: xczudeg-sfuc7Bd-1-e 5
| standalane_damain | CPU: psu_cortexas3_oi
4 Family: zynquplus
Description:
ol
ps_module_wrapper
A v
< >
@ < Back Next = Finish Cancel 3
TF T e
Project name enter axi_uart, Next
& New Application Project a x
Application Project Details
Specify the application project name and its system project properties
2 Application project name: |
1 System Project
Create a new system project far the application or select an existing one from the workpsace (@ L
E
Select a system project System project details i
o = Create new... r
System project name: | axi_uart_system ‘
Target processor
Select target processor for the Application project.
Processor Assodiated applications
psu_cortexa53_ 0 axi_uart
ol
Show all processors in the hardware specification [] (i ]
@ < Back Next > Finish Cancel £
TF T ]
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Next,
-« New Application Project m| X b
Domain
Select a domain for your project or create a new domain [
E
Select the domain that the application would link to or create a new domain
Note: New domain created by this wizard will have all the requirements of the application template selected in the next step ke
h
Select a domain Domain details
standalone_domain
MName: standalone_domain
+Create New... =
Display Narne: standalone_domain
Operating Systern: [standalone :
Pracessor: psu_cortexa53_0
e
E
E
E
E
E
E
' ]
| @ < Back Next Finish Cancel

Select Empty Application, Finish

-« New Application Project m| X b

Templates
Select a template to create your project. [
]

Available Templates:

Find: l:l Z = Empty Application

~ SW development templates Ablank C project.
Empty Application (C++)
Hello Warld
IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server f
IwiP UDP Perf Client it
IwiP UDP Perf Server
Memory Tests

T

Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

| kiagisibg bikd b o)

| @ < Back New - | [[CAmsh ]| cancel

Copy the files in the example project to src, select the project, and click the compile buttom.
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File Edit Search Xilinx Project Window

Help

TR R B R R R

o N viths - ani_uary/srefuartite Jow Jevel_example.c - Vitis IDE - o x
Fle Edit  Search Xiinx Project Window Help
D HE B R it 0 DI WG D [ ]| D88l ooy
. Explorer 31| BEi ¥ = O |[psmodie wiapper & axivortsystem S axivrt | [ suartite low level example.c ¥ | = 8 (% outine | =g
~ [&] axi_uart system [ ps_module wrapper | 97 : (Bnote None ~ Bl R o % ~
+ [E} xi_vart [ standalone on pss corexe53 01 ||| oo y U xparameters.h
> 4 Binaries 166= int main(void) o astatush
> @il Includes 01 { o xuartlite Lh -
> &= Debug s int Status; 0l printfh
V= src 16848 Vid o xilioh
s 1e5 * Run the Uartlite Low level example, specify the BaseAddress that is o sleeph
- 106 * generated in xparameters.h.
) Iscriptld o7 -/ 2 xgpiopsh
README.bxt 108 Status = UartLitelowLevelExample (UARTLITE_BASEADDR); # UARTLITE_BASEADDR
> % ide 169 if (Stiius !:f)(‘ST_SUCCESS) { . Ledirn®y # TEST_BUFFER SIZE
. . 110 xil_printf("Uartlite lowlevel Example Failed\r\n"); | -
K axi_vart.prj 111 return XST_FATLURE; @ Gpio : XGpioPs
L axi uart_system.sprj 112 3 @ Confightr : XGpioPs 0
> B ps_module_wrapper 113 L peinter . . N # GPIO_DEVICEID
o — | ety i etlite dalo emepleis i vorisowevican
o Assistant & =] 116 } - @ SendBuffer: usl
EES/RO%H ¥ ﬁ; @ RecvBuffer  ual
> % axi_uart_system [System] 119 / @ "‘Ei”(.‘”'idj it
ps_module wrapper [Platform] gf' o o UartliteLowLevelExam
122 * This function does a minimsl test on the Uartlite device using the low-level v
=2 |, 1 A R he feves ] o . N
& Console &2 | [£] Problems [E] vitis Lo Guidance L 4GB -&B-B-r=0
9
Build Console [2xi_uart, Debug]
LT pummney mas s e ~
1@:36:51 Build Finished (took 2s.613ms)
v
< >
{5} 2 items selected
T.bin fil
1.9 Generate BOOT.bin file
«J vitis - Vitis IDE - [m] X

[ Design | Debug

L Explorer S@W B S =B ](\d ps_module wrapper & axi_uartsystem % axi_uart [@ xuartiite_low level_example.c zﬂ = A |5 outline x%} = a
5[] axivarts - - o - 1= a2 L= anote Hone. ~ SHE- U T
New
> B ps_modul i ; 2 xparametersh
Add Application Project.. nain(void) B statush
Add Library Project... o uartlite Lh
Add Hw Kernel Project... int Status; 21 il printfh
Paste crl+v |/ U xilioh
* Run the Uartlite Low level example, specify the BaseAddress that is o slesph
# Delete * generated in xparameters.h. " consh
xgpiops.
i Refresh 4
Status = UartLiteLowLevelExample(UARTLITE_BASEADDR); # UARTLITE BASEADDR
E23 Import Sources... if (Stitus 1=f)(‘5T,SU((ESS) { 5 Loty # TEST_BUFFER SIZE
. xil_printf("Uartlite lowlevel Example Failed\ri\n"); . .
/1 Export as Archive retirn XST FATLURE; @ Gpio: XGpioPs
@ ConfigPtr : XGpioPs O
Close System Preject ) o Comtope v
== Build Project :g;ﬁ:‘;‘;(si;:?f“ny ran Lactlite lowleyel Exampleirin®); #+ UartlitsLowLevelExam
o Assistant &3 Clean Project - ® SendBuffer : u5]]
® RecvBuffer : ug]]
© B varts Create Boot Image y o mainivoid) : int
» {2} i uar A Program Flash ® UartliteLowLevelExam
N C/C++ Build Settings
ps_modul 9 is function does a minimal test on the Uartlite device using the low-level v
Team > ’ tr o o - o ! ’ ' ' . ‘ < >
Run As & 23] 2 Problems [E] Vitis Log (i) Guidance B-fg~-=8
Debug As > lle [axi_uart, Debug]
Properties - ~
1@:36:51 Build Finished (tock 25.613ms)
v
< >

[=] axi_uart_system

Click Create Image to generate BOQOT.bin Startup file.
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Create Boot Image X
g

L

Create Boot Image
Creates Zynq MP Boot Image in .bin format from given FSBL elf and partition files in specified output folder. @

Architecture: | Zyng MP  ~

(0 Create new BIF file @ Import from existing BIF file

Impart BIF file path: |D:,’FZ3f4GB,Faxi7uarljvilisfaxiiuarlisyslem,’iide,,’b:mlimagefaxiiuarlisyslem.bif | Browse...

Basic  Security

Output BIF file path: |D:,’FZ3f4GB,’axi_uar|Jvitis,'axi_uarl_syslem,’_ide,,’bnntimagefaxi_uarl_system.bif | Browse...
UDF data: | | Browse...
[ split Output format: |BIN  ~

Output path: |D:,’FZ3,|’4GB.Faxi_uarUvitis,laxi_uarl_system,’_ida,’bootimagefBOOT‘bin | Browse...

Boot image partitions

File path Encrypted Authentic| | Add
(bootloader) Dv/FZ3/4GB/axi_uart/vitis/ps_module_ wrapper/export/ps_module wrapper/sw/ps_module wrapper/boot/fsblelf  none none
Di/FZ3/4GB/axi_uart/vitis/axi_uart/_ide/bitstream/ps_module_wrapper.bit none none Delete
D:/FZ3/4GB/axi_uartjvitis/axi_uart/Debug/axi_uvart.elf none none Edit
Up

@ Preview BIF Changes Cancel
TT '|IJ

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD
card and run on the development board.

al vitis - axi_uart/sre/xuartlite_low level_example.c - Vitis IDE - o x
E
Flle Edit  Search Xiinx Project Window Help F
| . . . . - f
Bl B R i Oris MG @S G- [k Access] | [EZDedgn] 4 Dobug |
L Explorer 1| 5[Slia 7 = O |[wpsmodue wiapper & axivartsystem  Raxivart | [ xuartite low level example.c 5 = 5 |[2= outline 12 =g}
b
.|| v[] axi_uart system [ ps_module wrapper ] 97 * finote lone . ~ Bl R o% ¥ L
.
> {8 axi_uart [ standalone on psu_cortexas3 01 || 2o ; 2 xparameters.h b
v (= ide 166= int main(void) =1 xstatush
v = bootimage 101 { U uartlite Lh 4
o axi_uart_system.bif o nt Status; = il_printth
4 teas e U il ioh |
105 “ Run the Usrtlite Low level example, specify the BaseAddress that is U sleeph b
tebif] 186 * generated in xparameters.h. .
4 [2] writebiflog a7 . = xgpiopsh b
M A axi_uart_system.sprj 108 Status = UartlitelowlevelExample(UARTLITE_BASEADDR); # UARTLITE BASEADDR §
|| > Bl ps_module_wrapper 1e9 if (Status != XST_SUCCESS) { # TESTBUFFER SIZE
i 118 xil_printf("Uartlite lowlevel Example Failedirin"); o Grio. XCmor.
1 111 return XST_FAILURE; pio pioFs L
112 } & Confightr : XGpioPs C
113 1 arine(e . . . . # GPIO_DEVICEID 1
114 xil_printf( Suz:ess. ully ran Uartlite lowlevel Example\r\n™); & UartlieLowlevelExam |
. 7 = B 115 return XST_SUCCESS; - _
[ Assistant 16 3 ® SendBuffer:udl
E@e/ROow v | 7 @ RecvBuffer : uB[] §
(= axi_art_system [System] 119 / ® mainlvoid) : int [
ps_module_wrapper [?lztform] ﬁf' o @ UariliteLowLevelExam §
L p
122 * This function does a minimal test on the Uartlite device using the low-level
g & v b
o ' - : : ’ : < 2> L
| B Console 5 | [ Problems [E] Viis Log () Guidance
E Bootgen
- F
P
[INFO] : Bootimage generated successfully
v
z
[&] axi_vart system
4 T v T Jarcas YT TETIE Oy T
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Chapter 5 bram_test

The purpose of this article is to use Block Memory for data exchange or data sharing
between PS and PL, write data to BRAM through Master GPO port of Zynqg PS, read data through
Mater GP1 of PS, print and output the results to serial terminal display.

1.1 Create project and configure IP core of PS

Based on "ps_hello" project, save as bram_test project.

1.2 Add Bram and axi_bram_controller cores and configure

them

Enter Bram in the search bar and double-click Block Memory Generator to add the Bram core

Diagram x Address Editor x

@ & 22 W o4 Q0 + F » C o Default View v

Search: O- block (2 matches)

Block Memory Generator

SDAccel OpenCL Programmable Region
zyng_ultra_ps_e_1

M_AXI_HPMO_FPD - i
pl_resetnD
® pl_clkd

UltraSCALE*

Zyng UltraScale+ MPSoC

'-'__ ENTER to select, ESC to cancel, Ctrl+Q for IP details
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The Bram core is added, as shown in the following figure

Diagram

aQ Q

x Address Editor  x 200
M OO Q + = = *, C ¢ = Default View v F

zynq_ultra_ps_e_1

M_AXI_HPMO_FPD i
maxihpm0_fpd_aclk pl_resetn0
® pl_clk0

UltraSCALE*

Zynq UltraScale+ MPSoC

r blk_mem_gen_0

[4- BRAM_PORTA rsta_busy

L

L d

Block Memory Generator

Double-click the Bram core to set Memory Type to Dual Port RAM

Block Memory Generator (8.4) r)

@ Documentation IP Location

IP Symbol

Show disabled ports

Power Estimation Component Name blk_mem_gen_0

Basic  PortAOptions | PortBOptions | Other Options | Summary

Mode BRAM Contraller v /| Generate address interface with 32 bits

Memory Type | Dual Port ROM v Common Clock

Select the Primitive Type to be Used

BRAM URAM AUTO
ECC Options
ECC Type No ECC ~
Error Injection single Bit Error Injection -
|||+ BRAM_PORTA rsta_busy Virite Enable
|||+ BRAM_PORTE rstb_busy e e
Byte Size (bits) 8 -

Algorithm Options:

Defines the algorithm used to concatenate the block RAM primitives.
Refer datasheet for more information

Algorithm | Minimum Area v

Primitive  8k2 -
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Cancel the Check of Enable Safety Circuit

Block Memory Generator (8.4) '
@ Documentation IP Location
1P Symbol  Power Estimation Companent Name |blk_mem_gen_0
Show disabled ports
Basic | PortAOptions | PortBOptions | Other Options  Summary
Pipeline Stages within Mux | 0 | Mux Size: 2x1
Memory Initialization
Load nit File
CoeFile r Edit
Mem File no_mem Browse Edit
Fill Remaining Memory Locations
Remaining Memory Locations (Hex) 0
Il 4 Bram_PorTA [
" + BRAM PORTB Defines the type of warnings and outputs are generated when a
- read-write or writs-write collision oceurs
Collision Warnings  All -
Behavioral Simulation Model Options
Disable Collision Wamings Disable Qut of Range Wamings
Dynamic Power Saving
Sleep
Safety logic to minimize BRAM data corruption
Enable Safety Circuit
Diagram x Address Editor  x 200
a a ¥ M o Q + @ &, C o = DefaultView v &

Add IP (Ctrl+1)

zynq_ultra_ps_e_1

M_AXI_HPMO_FPD 4 i

maxihpmO_fpd_aclk ZYNQ pl_resetn0 .
® pl_clk0

UltraSCALE™*

Zynq UltraScale+ MPSoC

blk_mem_gen_0

||[+ BRAM_PORTA rsta_busy %

Block Memory Generator
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Enter axi_bram in the search bar and double-click AXI BRAM Controller to add the

axi_bram_controller core

Search: <- axi braml

7 AXI BRAM Controller

{1 match)

ENTER to select, ESC to cancel, Ctrl+Q for IP details

Double-click on axi_bram_controller to set parameters, and set Number of BRAM interfaces to 1,

as does another axi_bram_controller.

¢ Re-customize IP

AXI BRAM Controller (4.1)
IP Location

@ Documentation

(") Show disabled ports

]
s_axi_ack BRAM_PORTA + |||
s_axi_aresetn

Component Name axi_bram_ctrl_0

AXI Protocol
Data Width
Memory Depth (Auto)

ID Width (Auto)

El Support AXI Narrow Bursts ~ Yes

Read Latency

1

Read Command Optimization No
BRAM Options
BRAM Instance (Auto) External
Number of BRAM interfaces = 1 v

ECC Options
Enable ECC No
ECC TYPE Hamming

Enable Fault Injection = No

ECC Reset Value 0

v

[1-128]

ISESYET-FR X Jauve

Enables the ECC. ECC is available only for datawidths 32,

" B4and 128
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Click Run Block Automation - > OK to connect automatically

Diagram x Address Editor X 200
@ @ ¥ ® ¢ Q + = = *‘ C  ¢f = Default View v 3
J* Designer Assistance available. Run Connection Automation
2ynq_ultra_ps_e_1
—= ZYNQ ™ ™
o
UltraSCALE~*
Zynq Ulrascales MPSoC
axi_bram_ar_0
[l|+ Bram_poRTA
Block Memory Generator
Check all the options and click OK
# Run Connection Automation X

Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface on the left to display its configuration options on the right.

P

Q =z =
= =

v ) N Automation (4 out of 4 selected)

+ [v] ¥ axi_bram_ctri_0

BRAM_PORTA

v
“)

| 5_AX

Select an interface pin on the left panel to view its options

r
©)
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After the automatic connection is completed, the following figure is shown.

zynq_ulta_ps_e_1

[ - |
Interface Connection: axi_smc_MO00_AX] M_AxI_HPAO_FPD + ik
— —— pi_ressd
LT T N B0
UltraSCALE+ siomest_syne ok mb_reset

bus stuct reset0:o]
penpheral reset:o]
interconnect_aresei00] 4

ext_reset in

Zynq UliraScaler MPSOC

axi_bram_ctrl 0

| san
a_a_ock
a_axi_aresstn

BRAM_PORTA + ||| Processor Syslem Reset

AXTBRAM Contralier
axi_bram_ctrl_1

b saxn
o ai_ack
e

BRaM_PORTA + ||

AXTBRAM Contraller
blk_mem_gen_0

||+ aram_porTA
||+ eram_porte

Block Memory Generator

AXI SmariConnect

Setting Address
Diagram » Address Editor X 200
Qa = = 1 [] Assigned (2) (v Unassigned (0) [v) Excluded (0) o
Name Interface  Slave Segment  Master Base A . 1 Range Master High Address
~ & Network 0
~ 4 fzyng_ultra_ps_e_1
« BB /zynq_ultra_ps_e_1/Data (39 address bits - 0x00A0000000 [ 256M ] 00400000000 [ 4G ] ,0x1000000000 [ 224G ])
8 Jaxi_bram_ctrl_0 S_AXI Mem0 0x00_4000_0000 7 4K ~  0x00_AQ00_QFFF
8 Jaxi_bram_ctrl_1 S_AXI Mem0 0x00_4000_1000 7 4K ~  0x00_AQ00_1FFF
1.3 Generate synthesis files
Right-click ps_module->Generate Ouput Products->Generate
Sourc x Design | Signals | 2 _ Diagram % Address Editor x
- » [ |
Q T 2 + 0 @ e 2w o Q
_ Source Node Properties. . Ctri+E
v Design Sal
= OpenFie Alt+O
> cnE ps 1 _ |
> Constraint: Create HDL Wrapper... masdhpm.fpd_ ack f
> [ Simulation View Instantiation Template
2 Utility Sour Generate Output Products...
Reset Output Products. .
Hierarchy |F | a
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1.4 Generating top-level file of FPGA

BLOCK DESIGN - ps_module

Sourc x Design | Signals o

QT s+ 0
v Design Sources (1)

> 1 ps_module (ps_module
> Constraints (1)

» Simulation Sources (1)

> Utility Sources

Hierarchy IFP Sources Librar

R

Diagram x Address Editor

3

o] fa] Lt it £ (o]

Source Node Properties_ Ctrl+E

Open File Alt+O

Create HDL Wrapper...

View Instantiation Template
Generate Qutput Products...

Reset Qutput Products...

+ & *

zyng_ultra_ps e 1

-ZYNQ™”

UltraSCALE*

Zyng UltraScale+ MPSoC

axi_bram_ctrl_0

| §_AXI

————= 5 axi_ack

BRAM_PORTA + [}

— 3 _3I_aresetn
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1.5 Generate bit files

= Window  Layout View  Help O- Quick Access

© ® bW (8 =

BLOCK DESIGN -p Geperate Bitstream

Sourc x Design | Signals | 2 _ Diagram x Addre

x>

Q= 2 + 0 @ a i &

€

Design Sources (1)
> @ o ps_module_wrapper (ps_modul

> Constraints (1)

W

Simulation Sources (1)

> Utility Sources

Hierarchy |IF Sources Librari4 » = —
Source File Properties 2 _ OO X
ps_module bd & il
| oo
i
/| Enabled
Location: G/FPGA/FZ3/bram_test
Type: Block Designs (v

General FProperiies

1.6 Export Hardware Profile

Click File - > Export - > Export Hardware - > OK on the menu bar to export the hardware
configuration file
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¢ bram_test - [G:/FPGA/FZ3/bram_test/bram_test.xpr] - Vivado 2020.1

Eile Edit Flow Tools Reports Window Layout View Help
M
Project - Bos oz
I Add Sources.. Alt+A S3LOCK DESIGN - ps_module
1 Close Project
Sourc x Design Signals | 2 _ g |
Q= ¢+
Save Block Design As
~ = Design Sources (1)
Close Block Design > @ o ps_module_wrapper (ps_mo
> Constraints (1)
> Simulation Sources (1)
> Utility Sources
Checkpoint »
P y [¢ S———
Hierarchy IF Sources Librari < p
Text Editor »
Source File Properties 2 _ 00!
Export Export Hardware._ 2
Print i+ P Export Block Design...
Exit
FURTCANACTSIS L Im Export Simulation... f3/bram_test

1.7 Launch Vitis and create new platform project

Click Tools > launch Vitis ide o n the menu bar to launch Vitis

o bram_test - [DWFZ3/4GB/bram_test/bram_test.xpr] - Vivado 2020.1

File Edit Flow Tools Reports wWindow Layout View Help Q- Quick Access
h’; - Create and Package Mew IP.
Flow Navigator Create Interface Definition.
~ PROJECT MAMAGER Enable Dynamic Function eXchange...
? — 0O
¥ Settings Run Tcl Script...
Add Sources Froperty Editor +
Associate ELE Files...
Language Templi | module_wrapper.w) (1)
Generate Memory Configuration File. ..
¥ 1P catalog
Compile Simulation Libraries.
~ 1P INTEGRATOR HHUD Stores.
Create Block Des Custom Commands *
Open Block Desic Launch Vitis IDE
Generate Block D & Language Templates
£ Settings.. oo oo oo
= Comnile Order

Click File=>Switch Workspace—> Other...,
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~ vitis - ps_module_wrapper/platform.spr - Vitis IDE

- o

x

File | Edit  Search Xiinx Project Window Help
New ARSSHILND | v @ w047 w100 G0 v o v [Quick Acce] | |7 Besign] 45 Debug
Open File...
O ||~ ps.module wrapper % | = O |[8: outine 5 | =0
Close Cirl+w =
: e filter te & .
Close Al Curlshiftew Eis EE % X1 platform: ps_module wrapper an outline is not available.
Save Cerl+s B
Save As.. ~ £} psu_cortexas3_0 Name: ps_module wrapper
Save Al Ctrl+Shife+S ~ =8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
e E| Board Support P Description: g e e—
v [ standalone on psu_(
(Renmie= = | Board Support Py
&) Refresh = « £} psu_prmu 0
s
Import... v [ zynamp_pmutw Samples: Browse.. || Q
Export. | Board Support Py
port.. Generate boot components
Properties Alt+Enter Pre-built Components
Switch Workspace > DA\FZ3\dGB\axi_gpic\vitis FBL: Browse...
Restart DAFZ3\4GB\gpio_emiolyitis. BMU Firmare: Browee..
Exit DAFZAGBAhello_worldivitis
AR UE T SYSTET TS Y STE Di\vitis
> {8} axi_uart [Application] DAMPSOC\3EG\gpio_emic\vitis
= .
ps_module_wrapper [Platform] DAMPSOC\3EG\gpio._emio B
DAMPSOC\AEV hello_worldvitis
DAMPSOC\3EG hello_worldwitis Log (D Guidance BRpEER B-mNr=8

DAFZ\4GB\uart_cyclevitis

Other...

lre\vitis\ps_module_wrapper\platform.spr}
per}

0 items selected

elect the path, select the vitis folder under bram_test project. Click launch.

% Eclipse Launcher

Select a directory as workspace

Vitis IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: |P:\FZ3\4G B\bram_test\witis

Browse...

» Recent Workspaces
» Restore other Workspace

b Copy Settings

@

Launch

Cancel

Click Create Platform Project
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«J vitis - Vitis IDE - ] bd
File Edit  Search Xiinx Project Window Help
ERITT— ==
fl
] W XILINX
o
1 i; VITIS.
— — —
PROJECT PLATFORH RESOURCES
Create Application Project Add Custom Platform Vitis Documentation
. e
Create Library Project
1 Import Project
< >
T T m
The project name uses the same name as the xsa file. Click next.
o
“| = New Platform Project m] x [
| Create new platform project
| Enter a name for your platform project I
Project name: [ps_module wrappet |
Use default location
Location: | DAFZ3\4GB\gpio_emio\wvitis\ps_module_wrapper Browse
Platt:orm = & S et e s o s e aediole
FrOJect applications that would run on different domains of
a platform at the same time.
h _ = A domain is the BSP/OS that controls one or
Processor I Domain maore isomorphic processors,
- A platform contains one or more domains.
XSA - A workspace can contain unlimited platforms and
unlimited system projects
t
188
@ < Back Next = Finish Cancel
I
Select Create from hardware specification(XSA),click NEXT.
e . .
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O x |

=| Platferm Project
| Create new platform project I

Create a platform praoject from the output of Vivado [Xilinx Shell Archive (XSA])] or from an existing platform. A platform will enable you to

specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for
embedded software developers.

ad Mew Platform Project

(@ Create from hardware specification (XSA)

Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

(O Create from existing platform

Load the platform definition from an existing platform. You can choose any platform from the platform repository as a base for your
platform project.

t
@ =< Back MNext = Finish Cancel
Open Browse..., select the previously generated xsa file.
) Hardware Specification File x
« v 4 « 4GB » bram_test » vitis » v O £ its
|A v SRR =~ ™ @ |
B = ~ o ER EAEE =il -
=ar .metadata 2020/11/4 11:21 iE= I
= RemoteSystemsTempFiles 2020/11/4 11:21 Tit= L
&+ T I | | ps_module wrapper.xsa 2020/11/4 11:14 KSA 0 I
) B
W =F
L RS (C)
- HEE (D)
- TR (E)
- (R a =
ITEE(N): | ps_module wrapper.xsa v‘ *xsa;*.dsa; ~
FTHHO) g
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Leave the default and click finish.

-« New Platform Project m] X

=

Platform Project Specification

Provide the hardware and software specification for the new platform project

Hardware Specification

XSA file: | DAFZ3\4GB\bram_test\vitis\ps_module wrapper.xsa Browse...

Software Specification

Operating system: | standalone ~
Processor: psu_cortexa53_0 ~
Architecture: 64-bit ~

@R Note: A domain with selected operating system and processor will be added to the platform. The platform project can be
¥ maodified later to add new domains ar change settings.

Generate boot companents

1@ ook |G Coneel | [

1.8 New bram_test Project

Right click the blank space of the project navigation bar on the left and select
NEW->Application Project.

~ vitis - ps_module wrapper/platform.spr - Vitis IDE - [m] b4
file Edit  Search Xilinx Project Window Help

TR RN - -1 TR R R R [Qwick Access] | [ Design | 4 Debug
L Explorer 2 B Sy T = B ||« ps_modulewrapper sﬂ X bram test system % bram test = B || outline zz] =l
> [E5] bram_test_system [ ps_module wrapper ] =

type filter te [ e X

> [B] ps_module_wrapper Platform: ps_module_wrapper An outline is not available.

~ [ ps_module_wrapper (Initi:
v L} psu_cortexas3_0 Narme: ps_module wrapper
~ [78 zyngmp_fsbl Hardware Specification: ps_module_wrapper.xsa
£ Board Support Py

- = Description: ps_module wrapper
~ [ standalone on psu_¢
|Z Board Support Pi

w {7} psu_pmu_D
v B2 zyngmp_pmufw
|Z Board Support P:

Samples: Browse. Q

Generate boot components
Pre-built Components

FSBL: Browse...

«f Assistant &2 = g8
EEER 0% - PMU Firmware: Browse..
v [=F bram_test_system [System]
> {€} bram test [4pplication] < >
ps_module_wrapper [Platform]

<
Main| Hardware Specification|

& Console sﬂ [£] Problems [E] vitis Log (i) Guidance 5

Platform Tel Consale

platform read {D:\FZ3\4GB\bram_test\vitis\ps_module_wrapper\platform.spr}

0 items selected ! Initializing the platfor...nable editing N &

Skip to the second page and select the platform project created above (default), next
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« New Application Project a x
- Platform
(i) The selected platform has unbuilt changes in the workspace. Please generate the platform to use the latest version.

Select a platform from repository} {1 Create a new platform from hardware (XSA)

Name Board Flow Vendor Path
[E* ps_module wrapper [custom] Embedded SW Dev xilinx DAFZ3\AGB\bram_test\vitis\ps_module wrapper\export\ps. |

Platform Info

General Info Acceleration Resources Domain Details.
” ~

Name: ps_module_wrapper The §eleldad platforrr\ does nu‘t‘h‘ave Domains L

o 5 i application acceleration capabilities | G 5 Details
art: __xaue-;c -1-e E
9 |standalene_domain | CPU: psu_cortexas3 o

Family: zynquplus o

Description: -

ps_module_wrapper

<
<

® e [

i i o T ™

Project name enter bram_test, Next

 New Application Project [m] x
2 Application Project Details
Specify the application project name and its system project properties

Application project name: | bram_test |

System Praject

Create a new system project for the application or select an existing one from the workpsace (i ]

Select a system praject System project details

+Create new...

System project name: | bram_test_system | B

Target processor

Selact target processor for the Application project.

Processor Associated applications
psu_cortexa53_0 bram_test o
a
Show all processors in the hardware specification [] 0

@ o] [

KIREBF | @ sales.cn@myirtech.com ® www.myir-tech.com 103 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/

MYi R IRIREBX MYD-CZU3EG
Make Your Idea Real FPGA F & FM

Next
-« New Application Project m| X b
Domain
Select a domain for your project or create a new domain [
]
Select the domain that the application would link to or create a new domain
Note: New domain created by this wizard will have all the requirements of the application template selected in the next step ke
h
Select a domain Domain details
standalone_domain
MName: standalone_domain
+Create New... =
Display Narne: standalone_domain
Operating Systern: [standalone :
Pracessor: psu_cortexa53_0
e
E
E
E
E
E
E
\ ]
| @ < Back Next Finish Cancel
Select Empty Application, Finish
-« New Application Project m| X b

Templates
Select a template to create your project. [
]

Available Templates:

Find: l:l Z = Empty Application

~ SW development templates Ablank C project.
Empty Application (C++)
Hello Warld
IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server f
IwiP UDP Perf Client it
IwiP UDP Perf Server
Memory Tests

T

Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

| kiagisibg bikd b o)

| @ < Back New - | [[CAmsh ]| cancel

Copy the files in the example project to src, select the project, and click the compile buttom.
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—_——————

«J vitis - bram_test/src/main.c - Vitis IDE - [m] x
°| File Edit  Search Xilinx Project Window Help P
ko-ualefale-o-is-imgmec-o- [uick e ¢ [ 2 Bean] e vebus

. Explorer 31| B[Ei ¥ = O |[psmodie wiapper & bram testsystem K bramtest | (8 maine H | = 8 (% outine | =g

~ [&] bram test system [ ps module wrapper] A 1 #include <stdio.h> ~ AR o 8 ¥

{c} bram test [ standalone_domain 2 |#include "Xil—iulh” = dio.h
i bram test [standalone & T ] 3 #include "xparameters.h” o stdio
> @) Includes 2 U il ioh
[V 5= int main() = xparametersh
o 6 L
> €] main.c 7 int num; ® main() : int
T lscriptld 8 int rev;
[ README.bxt 2
. 10 xil_printf("------ The test is start...------ Am\rt);
> @4 ide 1 |
% bram_test.prj 12 for (num = @; num < 15; numi+)
& bram test system.sprj 13
= i . 14 Xil Out32(XPAR_AXI_BRAM CTRL @ S_AXI BASEADDR + num * 4, 8x16060060 + num); //
~ &l ps_module_wrapper (Out-of-date) s } - =T
> (= bitstream 16
> &= export 17 for (num = B; num < 15; numt+)
¥ s {
o s o = g8 19 rev = Xil_In32(XPAR_AXI_BRAM_CTRL_1_S_AXI_BASEADDR + num * 4);
sistant 20 xil_printf("The data at %x is %x \n\r", XPAR_AXI_BRAM CTRL_1_S AXI_BASEADDR + num * 4, re
pmedow ~| 2% F
> % bram_test_system [System] 23 xil_printf("------ The test is end!------ An\rt)
B dul Platf 24
ps_module_wrapper [Flatform] o retuen 0;
26 } v
< >
B Console 57 |2 Problems [ Vidis Log () Guidance LG EE=-&rB-H-=108
Build Console [bram_test, Debug]
{5} 2 items selected
T T

1.9 Generate BOOT.bin file

Right-click the system of APP project and select Create boot image.

«J Create Boot Image X
Create Boot Image
Creates Zynq MP Boot Image in .bin format from given FSBL elf and partition files in specified output folder. @
Architecture: |Zyng MP  ~
o (O Create new BIF fle @ Import from existing BIF file
; Import BIF file path: |D:,,’FZ3,.MGB,Fbramitesljvitis,’bram}estﬁsyslem;‘iide,fbootimEgefbram)eslﬁsystem.bif | Browse..

Basic  Security

Output BIF file path: |D:jFZ3,'4GB,fbram_lesb'vilisfbram_lest_syslem,‘_ide,fboolimage,’bram_tesl_syslem.bif | Browse...
UDF data: | | Browse...
[Jsplit Output format: BIN  ~ :
Output path: | Di/FZ3/4GB/bram_test/vitis/bram_test_system/_ide/bootimage/BOCT.bin | T il 3

s
Boot image partitions
~ | File path Encrypted Autl | Add |
| | (bootloader) D:/FZ3/4GB/bram test/vitis/ps_module_wrapper/export/ps_module_wrapper/sw/ps_module wrapper/boot/fsbl.eff none nan L
D:/FZ3/4GB/bram_test/vitis/bram_test/_ide/bitstream/ps_module_wrapper.bit none non Tase
D:/FZ3/4GB/bram_test/vitis/bram_test/Debug/bram_test.elf none non| [ ¢

Up

l ® Preview BIF Changes _ Cancel

L L VOGS 7 U0l TOocO rsouar OO T 77T |

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD
card and run on the development board.
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w4 vitis - bram_test/src/main.c - Vitis IDE

| File Edit Search  Xilinx

Project Window Help

Bo- Rl B -G~ % -0 -9~ DR G-

- o x

[ | [@oedn 0o

L Explorer 1| 2/Slia © = O |[psmodue wiapper & bram testsystem € bram test | [& main 1 | = 5 |[2= outline 12 =0
v [g] bram test system [ ps_module wrapper | 1 #include <stdio.h> ~ Bl R o% ¥
2 #include "xil_io.h” u .
> {5} b.ramilesl [standalone on psu_cortexa33.0|| 5 40 ol Tl s e = sidioh
v (= ide 1 o xlioh
v = b 55 :m main() o xparametersh
13 . .
7 int num; @ main:int
|Z| bram_test_system.bif 8 int rev;
2 readelflog 9
s 10 xil printf("------ The test is start...------ A\
[E] writebiflog ) 1
& bram_test_system.sprj 12 for (num = 8; num < 15; num++)
> B ps_meodule_wrapper 13
14 Xil_Out32(XPAR_AXI_BRAM_CTRL_@_S _AXI_BASEADDR + num * 4, £x1880080@ + num); //
1s ¥
16
17 for (num = 8; num < 15; num++)
< > 18 I
o s = =g 19 rev = Xil_In32(XPAR_AXI_BRAM_CTRL_1_S_AXI_BASEADDR + num * 4);
sistant 20 xil_printf("The data at %x is %x \n\r", XPAR_AXI_BRAM CTRL_1 S _AXI_BASEADDR + num * 4, re
cmelOo% ~| 2
> ©% bram test_system [System] 23 xdl_printf("------ The test is end!------ A\
& ps_module_wrapper [Platform; 24
e - pper | 1 25 return @;
% } v
- < >
B Console 5 | [ Problems [E] Viis Log () Guidance
Bootgen
~
[INFO] : Bootimage generated successfully
v

[=] bram _test_system

w = Lt

L5 T
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Chapter 6 uart_cycle

This section guides users to create a simple SOC design using vivado. By configuring PS and
calling the axi_uartlite IP core on the PL side, the communication between PS and PL is realized
through AXI GP Master.

1.1 Create project and configure IP core of PS

Based on "ps_hello" project, save as uart_cycle project.

1.2 Add axi_uart IP core and configure them

Search: < uart (2 matches)

T AXI UART168550

& AXI Uartlite

ZYN

UltraS(
Add two uarts, where the configuration directly selects the default
Diagram x Address Editor  x 200
@ e X & © Q + == 2, Cc o Default View v &

* Designer Assistance available. Run Connection Automation

zyng_ultra_ps_e_1

maxhpmi_fpd_adk
pi_pa_inq0{0:0)
®

UltraSCALE*
Zynq UltraScale+ MPSoC
r a
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MY 2 R IR IMEB=
l Make Your Idea Real
Add concat IP core and connect it to the interrupt ports.
Diagram % Address Editor x 200
@ Qe X W & Q + 1 )é‘ C  ¢f = Default View v o
 Designer Assistance available. Run Connection Automation
zynq_ultra_ps_e 1
Y i
g, . st M_a1 HPMD_FPD + [f
s LYNQ ™ i
UltraSCALE*
) ax_uarite 0 o

AX| Uariie
Connect the RX and TX of the two uarts, as shown in the following figure
Diagram % Address Editor  x 200
Q@ a N X & Q + M & C o = DefaultView v &
* Designer Assistance available. Run Connection Automation
¥ 2y _ulte_ps e 1
Y |
ZY N Q s e [
H_ressings
UltraSCALE* )
Zynq UimScae+ MPSaC
xi_uadide 0
+ 5 - : u
s CE
s —‘

Xl Uartite
xi_uadide_1

+ 5 am . : u

s CE
s

Xl Uartite
Click Run Connection Automation - > OK to connect automatically.
Run Connection Automation >
Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface on the left to display its configuration options on the right P

’

Q =
(=] }em Automation (2 out of 2 selected)|

[v] % axi_uartlite_0

) 4 S_AXI
[+ ¥ axi_uvartlite_1
) 4F s_AXI
Select an interface pin on the left panel to view its options
©) oK
7| ©® oo ®
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After the automatic connection is completed, the following figure is shown.

Diagram x Address Editor  x 200
@ a 3 kK © Q s + & 4, C o = Defaul View v L
Procssse Skn Ressl Block Pin: interconnect_aresetn
A e pe e pad_1_ad_periph
seconcat 0 A Y —
na_sous pnan_e2n + |+ se0
me ko ZYNQ ™ e
Tere UltraSCALE* | Iy
Zyng UlraScaler MPSoC »: e .A. Mo A
1.3 Generate synthesis files
BLOCK DESIGN - ps_module *
Sources x Design Signals 2 _ 0O Diagram x Address Editor x
Q = | = o S]] a o H M € Q
Source Node Properties.. Ctri+E
v Design Sourc
Open File Alt+C
> 2@ ps_mo = pef —
> Constraints ( Create HDL Wrapper...
> Simulation Sc View Instantiation Template
| _>_ - _l{tllrty_Sm:lr_ce Generate Qutput Products... - —
Hierarchy | IP 5S¢ Reset Qutput Products... rconeal 0
r— el
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1.4 Generating top-level file of FPGA

BLOCK DESIGN - ps_module

Sources x Design Signals 2 _ 0O Diag
q E e -l N I lndatinm ™ .1 a
Source Node Properties._ Ctrl+E
v Design Sourcs
= OpenFile Alt+0
> onE ps_mot
> Constraints (1 Create HDL Wrapper...
b Simulation So View Instantiation Template
> ' Utility Sources Generate Output Products...
Hierarchy  IF So Reset Output Products...
¢ uart_cycle - [[4/FZ3/4GB/uart_cyclejuart_cycle.xpr] - Vivado 2020.1
File  Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access
&, »|u|e =
Flow Navigator PRO Generate Bitstream _cycle
v
PROJECT MANAGER Sources 0 o —
'ﬂ‘ Settings
Q = = + o Overview
Add Sources
v Design Sources (1)
Language Templates > @ 5. ps_module_wrapper (ps_module_wrappery) (1) Settings
1F P Catalog > Constraints (1) Project
» Simulation Sources (1) Project|
~ |P INTEGRATOR > Utility Sources Product
Create Block Design Project}
Open Block Design Py
Target
Generate Block Design Simulat

Hierarchy | IF Sources Libraries

1.6 Export Hardware Profile

Compile Order

Click File - > Export - > Export Hardware - > OK on the menu bar to export the hardware

configuration file
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¢ uart_loop - [G/FPGA/FZ3/uart_loop/uart_loop.xpr] - Vivado 2020.1

File  Edit Flow Tools Reports  Window  Layout  View  Help - Quick A

Project ’ Im & b', b Z )4

I Add Sources. Alt+A SLOCK DESIGN - pS_mOdU'e

Close Project
Sources % Design Signals

Qa T ¢ +
Save Block Design As...

¢

Design Sources (1)
Close Block Design > - 1 ps_module (ps_module.bd) (1)
> Constraints (1)

> Simulation Sources (1)

> Utility Sources

Checkpoint ’ Hierarchy |P Sources Libraries Compile O
P >

Text Editor Source File Properties

ps_module bd
Export Export Hardware...
; ~ Export Block Design...
Print._. Ctrl+P port g 73juart_loop/uart_loop.sr
I
Ext

V—W-Ti E)(pﬂl"t Simulation...
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1.7 Launch Vitis and create new platform project

Click Tools > launch Vitis ide on the menu bar to launch Vitis.

¢ uart_cycle - [DyFZ3/4GBfuart_cyclefuart_cyclexpr] - Vivado 2020.1

File

=

F

Edit

-,

'l:l' Settings

Add Sources

1F |P catalog

*~ IPINTEGRATOR

Flow

Tools

Reports

Window  Layout

[# Validate Design

Flow Navigator

* PROJECT MANAGER

Language Templ:

Create Block Des

Create and Package MNew IP...

Create Interface Definition...

Enable Dynamic Function eXchange...

Bun Tel Script...

Property Editor

Associate ELF Files...

Generate Memory Configuration File...

Compile Simulation Libraries...

XHub Stores...

Help

Q- Cluick Access

b4

_module_wrapperv) (1)

adule

(ps_module.bd) (1)

. Custom Commands 3
Open Block Desig =
Generate Block D Launch Vitis IDE
&  Compile Order
O Language Templates

W .

SIMULATION 3 Settings..

? -0

Click File=>Switch Workspace—> Other...,
vitis - ps_module_wrapper/platform.spr - Vitis IDE - a X

ps. _wrapper/pl P

fle Edit  Search Xilnx Project Window Help
New AsSHRANS | © rigP Tita G ) - ! [ Design 4 Debug
Open File... | S W W
F O ||« ps_module_wrapper &2 = O ||&= Outline & = g
Close clsw b - - ° —
i ty filter te
Close All Cirl+Shiftsw ype filter te. & = %/| platform: ps_module wrapper An outline is not available.
Save Ctrl+S ~ [&] ps_module wrapper
Save Al Ctrl+Shife+S ~ 8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
- 5] Board Support P{  pescription: ps_module_wrapper
Ve ~ [ standalone on psu_¢ - -
(e [ | Board Support Py
&7 Refresh FS ~ {7} psu_pmu 0
S
Import.. v [22 zynaqmp_pmufw Samples: Browse... Q
B | Board Support Py
Generate boot components

P Alt+Enter pre-bult Components
Switch Workspace > DA\FZ3\4GB\axi_gpic\vitis FsBL: Browse...
Restart D:\FZ3\4GB\gpio_emiolvitis PMU Firmurare: Browse..
Exit DAFZ3\4GB\hello_world\vitis

ML e
{8} axi_uart [Application]
ps_module_wrapper [Platform]

Di\witis

DAMPSOC\3EG\gpio_emio\vitis
DAMPSOC\3EG\gpio_emio
DAMPSOC\EV hello_world\vitis
DAMPSOCA\3EG\hello_worldivitis
DAFZ3\4GB\uart_cycle\vitis

Other...

v

Llog (1) Guidance

BRpiR #B~-g~r=0

per}

lrt\vitis\ps_module_wrapper\platform.spr}

0 items selected

elect the path, select the vitis folder under uart_cycle project. Click launch.
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TR —— T

Create Application Project

Create Platform Project

Create Library Project

Import Project

Add Custom Platform

% Eclipse Launcher *
Select a directory as workspace
Vitis IDE uses the workspace directory to store its preferences and development artifacts.
Workspace: D:\FZ3\4GB\uarl_cycle\l.ritis ~ Browse...
» Recent Workspaces
» Restore other Workspace
b Copy Settings
@ Launch Cancel
Click Create Platform Project
«J vitis - Vitis IDE - ] bd
Fle Edit  Search Xiinx Project Window Help
ERITT— p—
W XILINX
a VITIS.
I I I
PROJECT PLATFORH RESOURCES

Vitis Documentation

Xilinx Developer

The project name uses the same name as the xsa file.

Click next.
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o
“| = New Platform Project m] x

| Create new platform project

Enter a name for your platform project

Project name: | ps_module_wrapper|

Use default location
Location: | DAFZ3\AGB\gpio_emic\vitis\ps_module_wrapper Browse

Platform
Project

= A system project is a container for multiple
applications that would run on different domains of
a platform at the same time.

= A domain is the BSP/OS that controls one or

Processor I Domain more isomorphic processars.

- A platform contains one or more domains.

XSA - A workspace can contain unlimited platforms and
unlimited system projects
t
1o
@ < Back Next = Finish Cancel

Select Create from hardware specification(XSA),click NEXT.

J
"| wd Mew Platform Project O x

Platform Project

Create new platform project

Create a platform praoject from the output of Vivado [Xilinx Shell Archive (XSA])] or from an existing platform. A platform will enable you to
specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for
embedded software developers.

(@ Create from hardware specification (XSA)
Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

(O Create from existing platform
Load the platform definition from an existing platform. ¥ou can choose any platform from the platform repository as a base for your

platform project.

@ <Back || Mewt Finish Cancel
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Open Browse..., select the previously generated xsa file.

) New Platform Project O *
Platform Project Specification i
Provide the hardware and software specification for the new platform project
| Hardware Specification |
— WA file: |D:\FZ3\4GB\uarl_cycle\vitis\ps_module_wrapper.xsa | | Browse., | E
Software Spt ) Hardware Specification File *
¢ - v 4 « 4GB » uvartcycle » vitis v O P vitis”
By Operating
Processol HER Y HEDTME =y I @
~ .
Architecty B TR & BB =8
=as .metadata 2020/11/4 14:46 it
@ :z = RemoteSystemsTempFiles 2020/11/4 14:46 i pe
¥ T | ] ps_module wrapper.xsa 2020/11/4 14:41 XSA 3%
D EF
Generat -
W =F
i RS (C)
- HE (D)
- R (E) f
)] ol= 5 7
IEE(N): | ps_module wrapper.xsa V| *xsa;*.dsa; V|
r
[0 | | = | !
G
® MNext = | Finish | | Cancel

Leave the default and click finish.
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<« New Platform Project O X
Platform Project Specification
Provide the hardware and software specification for the new platform project
| Hardware Specification |
q
— HSA file: | DAFZ3I\AGB\uart_cycle\vitis\ps_module wrapper.xsa Browse.. -

Software Specification

£ Operating system: | standalone ~
Processor psu_cortexad3 0 ~
Architecture: 64-bit ~

modified later to add new domains or change settings.

Generate boot components

@ MNote: A domain with selected operating system and processor will be added to the platform. The platform project can be

® = Back

Next =

Cancel

1.8 New uart_cycle Project

Right click the blank space of the project navigation bar on the left and select

NEW->Application Project.

 vitis - ps_module_wrapper/platform.spr - Vitis IDE - [m] pe
Fle Edit  Search Xiinx Project Window Help

R R T R F ] o] 4 oebus
. Explorer zﬂ B8 ks T = O |[«ps.module wrapper zﬂ = 8 |[5 outine zz] =8

s> B ps_module wrapper (Out-of-date)}
typefiterte 1B bl Platform: ps_module_wrapper

An outline is not available.

v [El ps_medule wrapper (Initi:
v {} psu_cortexa53_0
~ [ zyngmp fsbl

Name:

ps_module_wrapper

Hardware Specification: ps_module wrapperasa

/ 77

|2 Board Suppert P/ pescription: e
~ [ standalone on psu_t
|2 Board Support P
v {7} psu_pmu 0
s
~ & zynqmp_pmufw Samples: Browse, Q
[2 Board Support P
Generate boot components
Pre-built Components
FSBL: Browse
o Assistant 5 =8
= TR0 & - PMU Firrmware: Browse
ps_module wrapper [Platform]
< >
< >
Main| Hardware Speciﬁ:ﬁtinn‘
& Console zﬂ\i Problems [E] Vitis Log (D) Guidance Bepif|#B-~=0O

Platform Tcl Console

platform read {D:\FZ3\468\uart_cycle\vitis\ps_module_wrapper\platform.spr}

platform create -name {ps_module wrapper} -hw {D:\FZ3\4GB\uart_cycle\vitis\ps module wrapper.xsa} -proc {psu_cortexas3_e} -os {stan

>

0 items selected

Initializing the platfor..nable editing I &

Skip to the second page and select the platform project created above (default), next.
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New Application Project
N PP )

Platform

(% The selected platform has unbuilt changes in the workspace. Please generate the platform to use the latest version.

[m} X

™

Select a platform from reposihry} [ Create a new platform from hardware (XSA)

Name Board Flow Vendor  Path
[E* ps_module_wrapper [custam] Embedded SW Dev e DARZ P T il e i e
o
<
Platform Info
General Info Acceleration Resources Domain Details.
Neme:  [pemodule wrapper ‘ " The selected platform does not have application Domains
| Domain name Details
| Part: [xcaudeg-sfvc7Ba-1e | X
E | standalone_domain CPU: psu_cortexa53_00S: stan
| Family: [zynquplus |
Description:
P
s module wrapper
M v

< Back Next = Finish Cancel
L T
Project name enter uart_cycle, Next
« New Application Project -
| |
= Application Project Details
g Specify the application project name and its system project properties
~| Application project name: |uart_cycle | -
System Project
Create a new system project for the application or select an existing one from the workpsace [ ] E
: System project details 1
- Select a system project Y Bl b
| i
o axi_gpio_system
System project name: |uart_cycle_system
+Creale new...
Target processor
Select target processor for the Application project.
Processor Associated applications
psu_cortexa53 0 uart_cycle
l
b!
B - 3 3
Show all processors in the hardware specification [] [ ]
@ = Back Next = Finish Cancel L
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Next
-« New Application Project m| X b
Domain
Select a domain for your project or create a new domain [
E
Select the domain that the application would link to or create a new domain
Note: New domain created by this wizard will have all the requirements of the application template selected in the next step ke
h
Select a domain Domain details
standalone_domain
MName: standalone_domain
+Create New... =
Display Narne: standalone_domain
Operating Systern: [standalone :
Pracessor: psu_cortexa53_0
e
E
E
E
E
E
E
' ]
| @ < Back Next Finish Cancel

Select Empty Application, Finish

-« New Application Project m| X b

Templates
Select a template to create your project. [
]

Available Templates:

Find: l:l Z = Empty Application

~ SW development templates Ablank C project.
Empty Application (C++)
Hello Warld
IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server f
IwiP UDP Perf Client it
IwiP UDP Perf Server
Memory Tests

T

Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

| kiagisibg bikd b o)

| @ < Back New - | [[CAmsh ]| cancel

Copy the files in the example project to src, select the project, and click the compile buttom.
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<l vitis - uart_cycle/sre/helloworld.c - Vitis IDE - ] bd
File Edit  Search Project Window Help
D B { A DOm0y o [Guick Accew) | [ Besign] 4 Debus
. Explorer 31| S %en 7 = O |[Wpsmedue wrspper  Kusrtloop L usrtople system  usrtoycle | (8 hellowerlde 31 | = 8 (% outine | =g
> [B] ps_module wrapper [Minimize 3’ @ BN o % v
~ [=] vart_cycle_system [ ps module wrapper | 47 U stdioh
~ {2} uart_cycle [ standalone on psu_cortexas: fg % xparametersh
> @l Includes 0= int main() o ailioh
~ = sre 51 { U xuartlite Lh r
52 uchar rxdb;
> [ helloworid.c o i bl led 1 \n ) o wartps_hwh
> (8] platform_config.h 54 XUartLite_SetControlReg(XPAR_UARTLITE_@_BASEADDR,@x1@); //enable interrupt # uchar
s> @ platform.c 55 XUartLite SetControlReg(XPAR_UARTLITE 1 BASEADDR,@x18); //enable interrupt # uint
56
> Bl p|at.form‘h 57 shile(1) # UART 1 DEVICE ID
Tl Iscriptld 58 e uartl_inbyte(void) : ch:
README.bxt 59 //delay(1280); e uartl_outbyte(char) : v
. 68 rxdb = uartl_inbyte(); //usrtl Receive
> %JdE- o ol e ° pmfn(:?nsn char®) : ve
< > 52 XUartLite_SendByte(XPAR_UARTLITE @ BASEADDR,rxdb); //uartlite & Send ® main) : int
63
 Assistant £ =8 64 rxdb = XUartLite RecvByte(XPAR_UARTLITE_1_BASEADDR); //usrtlite_l Receive
55
B @GR 0% - 66 XUartLite_SendByte(XPAR_UARTLITE_1_BASEADDR,rxdb); //uartlite 1 Send
67
- .
B ps_module wrapper [Platform] 68 rxdb = XUartlLite_RecvByte(XPAR_UARTLITE @ BASEADDR); //uartlite @ Receive
> uart_cycle_system [System] 69
70 uartl_outbyte(rxdb); //uartl Send
7 ¥ v
< >
B Console 57 |2 Problems [ Vidis Log () Guidance LG EE=-&rB-H-=108
CDT Global Build Cansole
{5} 2 items selected
T r
19G OOT.bin fil
.9 Generate BOOT.bin file
4 vitis - vitis IDE - o ®
Fle Edit  Search Xilinx Project Window Help
SRR AT T R A R [Qwick Aceess] [ Design] 4 Debug
~L Explorer zﬂ BSw Y= 0O W ol ps_module_wrapper & axiuartsystem % axi_uart (@ xuartlite_low_level_example.c 2@] = 0 Outline Sﬂ = 8
> B axivarts - - - - I am "+ angte lNone. ~ AR o % <
New »
> B ps_modul - . ; 2 xparametersh
A App\[al\on.PrDJEd main(void) 4 xstatush
Add Library Project. ) o xusrtite L
Add Hw Kernel Project. int Status; o xil_printih
Paste cv |7 U xilioh
* Run the Uartlite Low level example, specify the BaseAddress that is U sleeph
*® Delete = generated in xparameters.h. o onsh
xgpiops.
& Refresh */ gpiop:
Status = UartLiteLowlevelexample(UARTLITE_BASEADDR); # UARTLITE BASEADDR
i3 Import Sources... if (Status I= XST_SUCCESS) { # TEST_BUFFER_SIZE
) xil_printf("Uartlite lowleyvel Example Failed\rin"); T
/i Export as Archive return XST FATLURE; @ Gpio: ¥GpioPs
v ——— 1 @® Confightr: XGpioPs C
. . R # GPIO_DEVICE ID
== Build Project L _printf( Suz:es?fully ran Wartlits lowleyel Exampleirin®); ++ UartliteLowLevelExam
= " return XST_SUCCESS; -
o Assistant Claan Project @ SendBuffer: ug]]
® RecvBuffer : ua[]
B g art s 2 Create Boot Image / @ main(void) : int
» {5} mi.uar Program Flash © UartliteLowLevelExam
C/C++ Build Settings
ps_modul 9 is function does a minimal test on the Uartlite device using the low-level v
Team > : ' o - o ' . ! . ’ ’ < >
Run As > |53 |[£L Problems ] Vitis Log_ (D) Guidance L oG BEE-BRME-8r=0
Debug As ? e [axi_uart, Debug]
Properties - -~
16:36:51 Build Finished (took 2s.613ms)
v
< >

[=] axi_uart_system

Click Create Image to generate BOOT.bin Startup file.
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-« Create Boot Image

*| Create Boot Image
Creates Zynq MP Boot Image in .bin format from given FSBL elf and partition files in specified output folder.

3 Architecture: |Zyng MP  ~

() Create new BIF file (®) Import from existing BIF file

X

B| Import BIF file path: |D:,’FZ3f4GB,!uarl_cyc\ej'vitis,luaﬂ_loop_systam,r‘_ide,r‘bootimaga,’uart_\oop_syslem‘bif | Browse...
9
Basic  Security
Output BIF file path: |D:,’FZ3,|’4GB,FUErlicyc\e,.l'vilisfuarliloopisyslem,ude}'boolimage,’uarljoopﬁsyslem‘bif | Browse...
UDF data: | | Browse...
[1split Output format: |BIN
Output path: |D:,‘FZBMGB,‘uarl_cyc\ejvitis,‘uaﬂ_loop_systemj’_idejbootimage,‘BDOT.bin | Browse...
= Boot image partitions
i File path Encrypted Authe | Add
(boaotloader) D:/FZ3/4GB/uart_cycle/vitis/ps_module_wrapper/fexport/ps_madule_wrapper/sw/ps_madule_wrapper/boot/fsbl.elf none nane|
D:/FZ3/4GB/uart cyclefvitisfuart loop/ ide/bitstream/ps_module wrapper.bit none none =z
Di/FZ3/4GBfuart_cyclefvitisfuart_loop/Debug/uart_loop.elf none none| | g

Up

Cancel

2]

T IserstTirffiAnnNatatilara T\ Temnthanteen tart Tonon svsTeml 39RSAIITI7RARSAT AR —-keFn

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD

card and run on the development board.

<l vitis - uart_cycle/sre/helloworld.c - Vitis IDE - ] bd
File Edit  Search Xilinx Project Window Help
IR -HE e -A-Eg@iE-0 s 0e-D- [Ouick Access] |2 Design | % Debug

> @l Includes Al % 3 ~
> = Debug 47
> e e
> % ide 0= int main()
% uart_cycle.prj 51 {
. 52 uchar rxdb;
Ve e 53 print1("hellowolrd! \n");
b 54 XUartlite_SetControlReg(XPAR_UARTLITE_G_BASEADDR,@x18); //enable interrupt
55 XUartLite SetControlReg(XPAR_UARTLITE 1 BASEADDR,@x1@); //enable interrupt
56
e . 57 while(1)
uart_cycle_system.bif 58 {
writebiflog 59 //delay(1280);
5 - i s fJuar i
& uart_cycle_system.sprj S Ei rxdb = uartl_inbyte(); //usrtl Receive
< > 62 XUartLite SendByte(XPAR_UARTLITE_ 6 BASEADDR,rxdb); //uartlite & Send
63
o Assistant 2 =8 64 rxdb = XUartlite RecvByte(XPAR_UARTLITE_1_BASEADDR); //uartlite 1 Receive
65
BEEaROt || e XUartLite SendByte(XPAR UARTLITE 1 BASEADDR,rxdb); //uartlite 1 Send
67
= .
ps_module wrapper [Flatform] 68 rxdb = XUartLite_RecvByte(XPAR_UARTLITE @ BASEADDR); //uartlite @ Receive
> % uart_cycle_system [System] 69
70 uartl_outbyte(rxdb); //uartl Send
71 b v

. Explorer 31| BEi ¥ = O |[wpsmodie wapper  Kuartloop & vartycle system  Kuartoyde | [ helloworldc 12 = 0 |[8 Outine =g
5

ElR s ow ¥

stdioh

xparameters.h

sl joh

suartlite_Lh
xuartps_hw.h

uchar

uint
UART_1_DEVICE ID
uart1_inbyte(void) : ch:
uart1_outbyte(char) : v
print1{const char”) : ve

main() : int

B Console 57 |2 Problems [ Vidis Log () Guidance

Bootgen

[INFO]  : Bootimage generated successfully

[=] uart_cycle_system

~— —
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Chapter 7 dma_loop

This section guides users to create a DMA project using vivado
through DMA Data transmission.

1.1 Add PS IP Core and Configure

Based on "ps_hello" project, save as dma_loop project.
Openreset,, HPMO,HPO, PL to PS interruptIRQO.

. High-speed PL and PS

T &T & T=TT

TS

4 Re-customize IP x
Zynq UltraScale+ MPSoC (3.3) /
@ Documentation IP Location
Page Navigator - PS-PL Configuration
1 g 1 R
O switchToAdvancedmode  * |Q | &
Search: Q-
P8 UltraScale+ Block Design
Name Select
% o configuration ‘ ~ PLwPS | 2
I IRQO[0-7] 1 v I
Clock Configuration
i IRQI[0-7] 0 v
DDR Configuration APU Legacy Interrupts(IRQ, FIQ)  []
RPU Legacy Interrupts(IRQ, nFIQ) |:|
PS-PL Configuration
» PStoPL
 Fabric Reset Enable ]
Number of Fabric Resets 1
> Address Fragmentation
> Others
~ PS-PLInterfaces
~ Master Interface
I > AXI HPMO FPD ] I
> AXI HPM1 FPD O
A > AXI HPMO LPD o
~ Slave Interface
i ~ MUHP
L » AXI HPCO FPD O
[ > AXI HPC1FPD ]
i | 5 AXI HPO FPD 7} | v
2]
)
ki
soTT T P TP T e ————

When the configuration is complete, the Zynq UltraScale + MPSoC core is shown in the following

figure.
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Diagram  » Address Editor  x 00

e @ X xH © Q + o F & R C Y = Defautview v o

r ynq_ultra_ps_e_1 ’

4+ s_AX|_HPO_FPD ‘ .

) o . M_AXI_HPMO_FPD +
: pd k P ]
pl_ps._ir ..w:‘.w‘ © ’

+
L :E‘” H?AS(\:LArLE\ -

1.2 Add IP Core and Configure

Calling DMA Core

Diagram x Address Editor  x 200

@ a 3 B o Q + & F E oA C Y = DefaultView - o

Search: | - dma (5 matches)

-7 AXl Cenfral Direct Memory Access
<7 AXI Direct Memory Access

¥ AX| Multi Channel Direct Memory Access zyng_ultra_ps_e_1

“F AXl Video Direct Memory Access

]

AXI_HPO_FPD ‘ M_AXI_HPMO_FPD +
SZYNQT

UltraSCALE*

Zyng Uliascales MPSGC <

#F Time-Aware DMA

ENTER to select, ESC to cancel, Ctrl+Q for IP details
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Double-click on the DMA IP core to set parameters.

|4, Re-customize IP

i| AXIDirect Memory Access (7.1)

IP Location

@ Documentation

Show disabled ports

+ S_aX_UTE
=4 S_aNs_S2MM
s_exi_lite_aclk
m_ad_minizs_achk

m_eoxi_s2mm_aclk

M_AXIM2S 4 [

M_AXI_S2MM 4

M_AXIS_MM2S o
mm2s_prmry_reset_out_n
s2min_prmry_reset_out_n

ComponentName ax_dma_0

Er ro cks (Auto

Enable Scatter Gather Engine

Enable Micro DMA

Mutti CF

Width of Buffer Length Register (8-23) 14

Address Width (32-64) 32

| Enable Read Channel

Allow Unaligned Transfers

bits

bits

| Enable Write Channel

ll e Dbt Number of Channels 1 Number of Channels
axi_resetn S2mim_introut
e0d_sima_tatec{31:0] Memory Map Data Widin | 32 ~ WMemory Map Data Widih
Stream Data Width 3z ~ Stream Data Width (Auto)
Max Burst Size 16 e Max Burst Size

Allow Unaligned Transfers

udength In S

1

& AX14 Data Inter:

32

32

When the setup is complete, the following figure is shown.

Diagram x Address Editor  x
a a X x O Q

J* Designer Assistance available. Run Connection Automation

+ % s A CoU

= Default View

zynqg_ultra_ps_e_1

H+ S_AXI_HPO_FPD
maxihpm0_fpd_aclk
saxihp0_fpd_aclk
pl_ps_irq0[0:0]

UltraSCALE*

ZYNQ

M_AXI_HPMO_FPD + i

pl_resetn0
pl_clk0

Zyng UltraScale+ MPSoC

2n

mm2:

out_n
introut
introut

r

L

00
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Add Axi Stream Data FIFO module and set it as follows: set the depth to 1024, Tdata
width to 4 bytes, and open TKEEP and TLAST.

/' Re-customize IP X

AX|4-Stream Data FIFO (2.0) '

n @ Documentation IP Location

() Show disabled ports Component Name | axis_data_fifa_0

General  Flags

-~
of FIFO depth 1024 ~
) Memory type Auto ~
3 Independent clocks No ~
CDC sync stages 3
Enable packet mode No ~
ACLKEN conversion mode None ~
i Enable ECC No
S+ s_axis M_ARIS +
L 5_axis_aresstn axis_wi_data_count[31:0] Include ECC error injection | No
5_axis_aclk axis_td_data_countf31:0]

Signal properties
| :m TDATA width (bytes) [0-256]
i Enable TSTRE | No |
L [ enavte keer  |fves -
[ =T enable TLAST Yes -
TID width (bits) 0
TDEST width (bits) 0
TUSER width (bits) |0

- EIEA Aimannminnn: AAB AT bR EIEA ima: 37000 hite e
I
I
4 Re-customize IP *
AX|4-Stream Data FIFO (2.0) [
@ Documentation IP Location
() Show disabled ports Component Name | axis_data_fifa_0

General | Flags

Write flags
Enable write data count Yes
Enable almostfull No ~
Enable programmable full No v E
Progammable full threshold 11 [5-1019] ;
Read flags
=+ S_AXIS M_AXIS + = Enable read data count Yes v
5_axis_aresetn axis_wr_data_count[31:0] E
5_axis_aclk axis_td_data_count31:0] Enable almast empty No v
Enable programmable empty No v r
Progammable empty threshold 5 [5-1019]
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Automatic connection, and connect the S_AXIS and M_AXIS of FIFO to DMA, add concat,
connect MM2S and S2MM, interrupt to pl_ps_irq the final result is shown in the figure below.

Diagram

a q

% Address Editor  x

bE R e §

s 4+ B o C o

= Default View

700
&

2yra_vara pe e 1
30 Drect ey Ao
i 4+ 5 0 p0 70 - M !
=2 ZYNQ G
I L . e
P e e UraSCALE*
R erconneet
hesis fil
1.3 Generate synthesis files
¢ dma_loop - [Dy/FZ3/4GB/dma_loop/dma_loop.xpr] - Vivado 2020.1
File  Edit Flow Tools Repors Window Layout  View Help Q- Quick Access
, E X b B BT ¥

v PROJECT MANAGER
'ﬂ Settings
Add Sources
Language Templates

F IP Catalog

¥ IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

~OSIMLIEATION

Flow Navigator —

PROJECT MANAGER - dma_loop

Sources
Q ¥ & 4+

~ - Design Sources (1)

> @ ps_module (ps_module.v) (8)
> Constraints (1)
> Simulation Sources (1)

> = Utility Sources

Hierarchy | P Sources  Libraries  Compile Ordi

? 00X

~ @ = ps_module_wrapper (ps_module_wrappery) (1)

~ - [0] ps_module_i : ps_module (ps_madule he.i11

Source Node Properties
[= OpenFile

Create HDL Wrapper

View Instantiation Template

Generate Output Products...

Reset Output Products....

Project Summary

Overview | Dashboard

Settings

Cirl+E

Alt+O

Edit

ime:
cation:
imily:

irt:

ile name:

\guage:

language:

dma_lo
D:IFZ3M
Zyng Ut
XcZu3deg
ps_moc
Werilog

Mixed
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1.4 Generating top-level file of FPGA

I dma_loop - [04/FZ3/4GB/dma_loop/dma_loop.xpr] - Vivado 2020.1

File Edit  Flow  Tools Reports Window Layout  View  Help Q- Quick Access

~) B X b, B & X ¥
low Navigator S e B PROJECT MANAGER - dma_loop
¢ PROJECT MANAGER
Sources 2?2 _ 00O X Project Sumn
'ﬂ' Settings
Q = £ + : & Overview |
Add Sources
w Design Sources (1)
Language Templates ~ @ = ps_module_wrapper (ps_module_wrappery) (1) Settings |
TP Catalog ~ o [0 ps_module_i: ps_modul " R - Project nar

Source Mode Properties... Ctrl+E
> @ ps_module (ps_modul

. - Projectloca
N @ OpenFile Alt+0
7 |PINTEGRATOR. ¥ Constraints (1) Product far
Create Block Design ¥ Simulation Sources (1) Create HDL Wrapper... Project part
» [ Ultility Sources View Instantiation Template Top module
Open Block Design D
Generate Output Products.. Target lang!
Generate Block Design . i
Reset Output Products... Simulator 1z
Hierarchy @ |P Sources Libraries
& CIRAL I AT R
1.5 Generate bit files
¢ dma_loop - [[4/FZ3/4GB/dma_loop/dma_loop.xpr] - Vivado 2020.1
File  Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access
=, B X »lu|e = ¥
Flow Navigator ERE A PRO canerate Bitstream 2_100P
w
PROJECT MANAGER Sources 2 _ 00O X Project Summary
£+ Settings . . ) )
aQ = & + L o Overview | Dashboar
Add Sources
~ Design Sources (1)
Language Templates « @ = ps_module_wrapper (ps_module_wrapperyv) (1) Settings  Edit

# IP Catalog v A st_rnodule_i:ps_module (ps_module.bd) (1) Project name:

> @ ps_module (ps_module.v) (8) Project location:

v P INTEGRATOR ¥ Constraints (1) Product family:

> Simulation Sources (1)

Create Block Design Project part:

> Utility Sources T dul .
Open Block Design Ui Gl
Targetlanguage:
Generate Block Design . X
Simulator language:

Hierarchy = |IP Sources Libraries Compile Order

v SIMULATION

1.6 Export Hardware Profile

Click File - > Export - > Export Hardware - > OK on the menu bar to export the hardware
configuration file
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¢ dma_loop - [D:FZ3/4GB/dma_loop/dma_loopxpr] - Vivado 2020.1
File Edit Flow Toals Reports Window Layout View Help ¢
b
Project , | ® F P, o X
Add Sources... s)t+2  BLOCK DESIGN - ps_module

1 Close Project ) ]
Sources w Design Signals

a T & +

w Design Sources (1)

Save Block Design As...

Close Block Design » oo [0 ps_module (ps_module bd) (1)

> Constraints (1)
» Simulation Sources (1)

1 » Utility Sources

Checkpoint 3

1P 3

Text Editor 3

Merarchy [P Sources  Libraries G

1 Export Export Hardware...

Print... Ctr|+P Export Block Design...

Exit
TR PR " Export Simulation...

1.7 Launch Vitis and create new platform project

Click Tools > launch Vitis ide on the menu bar to launch Vitis.

¢ dma_loop - [D:/FZ3/4GB/dma_loop/dma_loop.xpr] - Vivado 2020.1

File Edit Flow Tools Reports Window Layout View Help Q- Quick Access

E‘ ™ Create and Package Mew IP...
Flow Navigator Create Interface Definition...
~ PROJECT MANAGER Enable Dynamic Function eXchange ..
L} Settings Run Tcl Script...
Property Editor Ctrl+J

Add Sources

Associate ELF Files...
Language Templ:
Generate Memory Configuration File...

¥ |p catalog
Compile Simulation Libraries...

v |PINTEGRATOR XHub Stores...

Create Black Des Custom Commands ’

Open Block Desig Launch Vitis IDE

Generate BlockD| &  Language Templates

B Compile Order

Click File=>Switch Workspace-> Other...,

|_module_wrappery) (1)

# Settings.. e
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~ vitis - ps_module_wrapper/platform.spr - Vitis IDE

o x

File | Edit  Search Xiinx Project Window Help
New ARSSHILND | v @ w047 w100 G0 v o v [Quick Acce] | |7 Besign] 45 Debug
Open File...
O ||~ ps.module wrapper % | = O |[8: outine 5 | =0
Close Cirl+w =
: e filter te & .
Close Al Curlshiftew Eis EE % X1 platform: ps_module wrapper an outline is not available.
Save Cerl+s B
Save As.. ~ £} psu_cortexas3_0 Name: ps_module wrapper
Save Al Ctrl+Shife+S ~ =8 zyngmp _fsbl Hardware Specification: ps_module_wrapper.xsa
e E| Board Support P Description: g e e—
v [ standalone on psu_(
(Renmie= = | Board Support Py
&) Refresh = « £} psu_prmu 0
s
Import... v [ zynamp_pmutw Samples: Browse.. || Q
Export. | Board Support Py
port.. Generate boot components
Properties Alt+Enter Pre-built Components
Switch Workspace > DA\FZ3\dGB\axi_gpic\vitis FBL: Browse...
Restart DAFZ3\4GB\gpio_emiolyitis. BMU Firmare: Browee..
Exit DAFZAGBAhello_worldivitis
AR UE T SYSTET TS Y STE Di\vitis
> {8} axi_uart [Application] DAMPSOC\3EG\gpio_emic\vitis
= .
ps_module_wrapper [Platform] DAMPSOC\3EG\gpio._emio B
DAMPSOC\AEV hello_worldvitis
DAMPSOC\3EG hello_worldwitis Log (D Guidance BRpEER B-mNr=8

DAFZ\4GB\uart_cyclevitis

Other...

lre\vitis\ps_module_wrapper\platform.spr}
per}

0 items selected

elect the path, select the vitis folder under bram_test project. Click launch.

% Eclipse Launcher

Select a directory as workspace

Vitis IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | DAFZ3\4GB\dma Jooplvitis

VIl Browse...

» Recent Workspaces
» Restore other Workspace

b Copy Settings

Launch

Cancel

Click Create Platform Project
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«J vitis - Vitis IDE
File Edit  Search Xilinx Project Window Help

& [ Welcome 5 |

=1

o

& Vs
VITIS
IDE

— —
PROJECT PLATFORM
Create Application Project Add Custom Platform

Create Platform Project

Create Library Project

Import Project

RESOURCES

Vitis Documentation

Xilinx Developer

T T m
The project name uses the same name as the xsa file. Click next.
e - New Platform Project [m] x|
=| Create new platform project
| Enter a name for your platform project |
Project name: ps_module_wrapperl |
Use default location
Location: | DAFZ3\4GB\gpio_emio\vitis\ps_module wrapper Browse
Platt:orm = A system project is a container for multiple
Pr0]ect applications that would run on different domains of
a platform at the same time.
1 ) = A domain is the BSP/OS that controls one or
Processor I Domain more isomorphic processors.
- A platform contains one or more domains.
XSA » A workspace can contain unlimited platforms and
unlimited system projects
t
i
® = Back MNext = Finish Cancel
|
Select Create from hardware specification(XSA),click NEXT.
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«J New Platform Project O X

=| Platform Project

Create new platform project

Create a platform project from the output of Vivado [Xilinx Shell Archive (XSA)] or from an existing platform. A platform will enable you to

specify options for the kernels, BSPs, as well as settings required for creating new applications. Platforms are currently supported for
embedded software developers.

(®) Create from hardware specification (XSA)

Create a new platform project from a hardware specification file. You can specify the OS and processor to start with. The platform can
be customized later from the platform project editor.

(O Create from existing platform

Load the platform definition from an existing platform. You can choose any platform from the platform repository as a base for your
platform project.

t
1
® < Back Next = Finish Cancel
Open Browse..., select the previously generated xsa file.
<« Mew Platform Project [} xX E
Platform Project Specification Tl
Provide the hardware and software specification for the new platfarm project
Hardware Specification
XSA file: | | Browse...
Software Sp -« Hardware Specification File X
« v <« 4GB » dma_loop » vitis v D L B vitis” ~
Operating
Processa] BT FESTHEE =~ O @ L
~ =R EMHEs il
.metadata 2020/11/4 12:01 prat =
RemoteSystemsTempFiles 2020/11/4 12:01 ITiE n
I || ps_module_wrapper.xsa 2020/11/4 11:58 HSA i I T
e MRS (C)
- FTE (D3
- IR (E)
- B (R w = 5
SEFE(N): | ps_module_wrapper.xsa v| *xsa;*.dsa; ~
FIFHO) Bl

@ <se|NERE Cancel

Leave the default and click finish.
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) New Platform Project O XL
Platform Project Specification I
Provide the hardware and software specification for the new platform project
Hardware Specification
KSA file: | DAFZNAGB\dma_loop'witis\ps_module_wrapper.xsa Browse...
Software Specification
~
Operating system: |standalone ~
Processor: psu_cortexa53_0 ~ -
Architecture: 64-bit ~
Mote: A domain with selected operating system and processor will be added to the platform. The platform project can be ]
madified later to add new domains or change settings.
T
[~] Generate boot components
Tool would automatically generate the device specific boot components. i
® = Back MNext = Cancel
b
T FIOENETae DooT FTETIT
Right click the blank space of the project navigation bar on the left and select
NEW->Application Project.
«J vitis - dma_loap/sre/xaxidma_example_simple_pollc - Vitis IDE - o x

File Edit  Search Xilinx Project Window Help

N-HR - & - OB -0 -iF i [Quick Access| ! | Design | %5 Debug

. Explorer £1 | S Ses 7 = O |[apsmodule wispper & dmaloop system i dmaloop | el xaxidma_example_simple_pollc 51 | = O (5 outine | =g
+ [E] dma loopsystem | s module wrapper ] 118 |jerrrersssesssessssesesess Variable Definitions *r+rrerrrrsesssmsssssssssasany - T
11095 /%
= )
> B ps.module wrapper 120 * Device instance definitions o xaddmah ~
121 ¥/ 2l xparametersh
122 XAxiDma AxiDma; 8 xdebugh
123
124 & xuartns350_Lh
New ™ Project.. !/ ::’ DMAJJ.EV o]
Copy Ctrl+C D Application Proj s Ex:mgle‘ It invokes the example function, x,
=5 on status.
Paste Ctrl+V | #  Hw Kernel Project... # | ¥
) Refresh B2 Library Project... # DDR_BASE ADDR
1 MEM_BASE_ADDR
g Import from Archive B Platform Project.. o H#MEMBASE
' example finishes successfully # MEM_BASE ADDR
. 4 Export as Archive I Example.. cxample fails. 4 TX BUFFER BASE
§ g ¥
1 T Other # RX_BUFFER BASE
o Assistant 12 D || 237 # RX_BUFFER_HIGH
BE&SO% 7| o main({) ! # MAX PKTLEN
~ B dma_loop_system [System] 158 { # TEST START VALUE
+ £ dma loop (hpplicetior] L stotus; #  NUMBER_OF TRAN
dule_wrapper [Platform] O orinerce N . # il printf(const char
ml Ps_module_y pper || —— —— .
143 Xil_printf("\r\n--- Entering main() \Fint); “ + XeoiDems Simolbabio
< >
9 Corsole 32 | EL Problems [E) vitis Log (D Guidance O 4% EEE-&|MB-6-=0

onsole [dma loop, Debug]

make: Mothlng to be done for 'all'.

13:52:55 Build Finished (took 318ms)

0 items selected
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Skip to the second page and select the platform project created above (default), next

ad New Application Project

Platform

Iy, The selected platform has unbuilt changes in the workspace. Please generate the platform to use the latest version.

a X

]

Select a platform from reposiwy} 71 Create a new platform from hardware (XSA)

Name Board Flow Vendor

[E¥ ps_module_wrapper [custom] Embedded SW Dev ilink

== Add ¥ Manage

Path
DAFZ3MAGB\dma_looplvitis\ps_module_wrapperiexport\ps,

Platform Info

General Info Acceleration Resources

Name: ps_module_wrapper

The selected platform does not have

Domain Details

Domains

Part: xczuleg-sfuc78d-1-e
Family: zynquplus

Description:

ps_module_wrapper

‘ v

| Domain name Details
|standalane_domain | €PU: psu_cortexas3 o)

TRTT

v
< >
@ < Back Next > Finish Cancel
Project name enter dma_loop, Next
-« New Application Project m] b3
| Application Project Details
Specify the application project name and its system project properties =
Application project name: [dma_loop | £
System Project
Create a new system project for the application or select an existing one from the workpsace (@ E

Select a system project System project details

== Create new...

System project name: |dma_loop_system

Target processor

Select target processor for the Application project.

Processar Associated applications
psu_cortexa53 0 dma loop
Show all processars in the hardware specification [ [ ]

THTT

= Back Next = Finish Cancel
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Next

-« New Application Project m| X b

Domain
Select a domain for your project or create a new domain 7
E

Select the domain that the application would link to or create a new domain

Note: New domain created by this wizard will have all the requirements of the application template selected in the next step

T

Select a domain Domain details

standalone_domain
MName: standalone_domain
+Create New... =
Display Narne: standalone_domain

Operating Systern: [standalone ~

Pracessor: psu_cortexa53_0

| kiagisibg bikd b o)

| @ ] [

Select Empty Application, Finish

-« New Application Project m| X b

Templates
Select a template to create your project. 7
E

Available Templates:

~ SW development templates Ablank C project.
Empty Application (C++)
Hello Warld
IwIP Echo Server
IwIP TCP Perf Client
IwiP TCP Perf Server f
IwiP UDP Perf Client it,
IwiP UDP Perf Server
Memory Tests

Empty Application

T

Peripheral Tests
Zyng MP DRAM tests
Zyng MP FSBL

| kiagisibg bikd b o)

| @ e L [ o |
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Copy the files in the example project to src, select the project, and click the compile buttom.

~ vitis - dma_loop/srefxatidma_example_simple_pall.c - Vitis IDE - o x
File Edit  Search Xiinx Project Window Help

mig (8- ]&-{#-0-is9- DB D [Quick Accesz] : |[2 Design |4 Debug

R Explorer 22 B[Elis ¥ = O |[wpsmodie wiapper & dma loop system K dmaloop | [8 xaxidma sxample simple pollc 11| = O | Outine 11 =g

v [& dma_loop_system [ ps module wrapper | 136 * @note lone ~ AR o % ¢
. 137 * .

v {2} dma_loop [ standalone_domain | 13z p U xaxidmah ~
> [l Includes 139= int main() = xparameters.h
v s 40 { o xdebugh

> &) xaxidma_sxample_simple_poll.c s int Status; 8 xwarins550 Lh
B Iscriptld 143 xil printf("\r\n--- Entering main() --- \r\n"); # DMADEV D
[E) README.bxt 144 #
s 64 i 145 /* Run the poll example for simple transfer */ ¥
ae ) 146 Status = XAxiDma_SimplePollExample(DMA_DEV_ID);
% dma_loop.prj 147 # . BASE
% dma_loop_system.sprj 148 if (Status != XST_SUCCESS) { # DDR_BASE_ADDR
o 149 xil printf("XAxiDma_SimplePoll Example Failed\rin"); b
> [B] ps_module wrapper (Out-of-date) o e xs{rnnunz;’ P P ) # MEM_BASE_ADDR
151 3 # MEM BASE ADDR
152 N £ . . L) # TX BUFFER BASE
153 xil_printf("Successfully ran XAxiDma_SimplePoll Example\r\n”);
pw = = | 12 # RX_BUFFER BASE
sistant 155 xil_printf("--- Exiting main{) --- \r\n"); # RX_BUFFER HIGH
= || 136 # MAXPKT_LEN
; EEekow 157 return XST_SUCCESS; TEST_STA;%T VALUE
> % dma_loop_system [System] 158 # E A
ps_module wrapper [Flatform] 159} # NUMBER_OF_TRAN
160 +#+  xl_printf(const char
161 #if defined(XPAR_UARTNS556_8_BASEADDR) © 54 XADma SimolePo
Lo " iDma SimolePo
< >
B Console 57 |2 Problems [ Vidis Log () Guidance oG EE=&MB-8-=1

Build Cansole [dma_Joop, Debug]

{5} 2 items selected

1.9 Generate BOOT.bin file

Right-click the system of APP project and select Create boot image.

1 %) Create Boot Image hd

Create Boot Image

(1, BIF file already exists at the specified path and will be overwritten with the modified contents. Use 'Preview Bif Changes' button to view the changes in bif @
contents before overwriting.

Architecture: |Zyng MP  ~

(O Create new BIF file (@) Import from existing BIF file

Import BIF file path: |D:fFZSMGdema_loopfvilis,l’dma_loop_syslam,’_ide,l'boolimagefdma_loop_syslem.bif | Browse...

Basic  Security

Output BIF file path: ‘D:,fFZS,MGB)’dma_\oop{vilisfdma_loop_syslemf_idefboolimage,’dma_\oop_syslem.bif ‘ Browse...
UDF data: ‘ ‘ Browse...
[split Output format: BIN ~

Output path: ‘D:,J'FZ3,MGBJdma_\oop,fvitisfdma_loop_systemf_idefbootimage,’EOOT.bin ‘ Browse...

Boot image partitions

14 | File path Encrypted Authentici| | Add
(bootloader) [:;/FZ3/4GB/dma_loop/vitis/ps_module_ wrapper/export/ps_module wrapper/sw/ps_module wrapper/boot/fsbl.elf none none

I D:/FZ3/4GB/dma_loop/vitis/dma_loop/_ide/bitstream/ps_module_wrapper.bit none none BEEe
DA\FZ3\4GB\dma_loop\witis\dma_loop\Debug\dma_loop.elf none none Edit

o ® Preview BIF Changes Create Image Cancel

+ hi¥ FiTa far Ttha <usfem nrnierf

Type the development board into SD card startup mode, then copy the BOOT.bin file to SD
card and run on the development board.
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«J vitis - bram_test/src/main.c - Vitis IDE
7| File  Edit

EO~-HR ®-&-is-0-id-

Search Xilinx Project Window

Help

-4 HCRCR LR

a x

[ | @i o

. Explorer 31| B[Eis ¥ = O |[psmodie wiapper & bram testsystem K bramtest | (8 maine H | = 8 (% outine | =g
~ [=] bram test system [ ps_module wrapper ] 1 #include <stdio.h> ~ Bl R o % ~
» {2} bram test [ standalone on psu_cortexas3 0|| 2 #include Txil_fo.h” =1 stdioh
ram. psu Ol 3 #include "xparameters.h” - stdio.
v ide 2 0 ailioh
v (= bootimage 52 int main() U xparametersh
6 L
BOOT bin S L s o maing : int
bram_test_system.bif 8 int rev;
readelflog ] L
wiitebiflog ﬁ xil_printf( A\rT);
& bram_test_system.sprj 12 for (num = 8; num < 15; numi+)
> B ps_module_wrapper 13
14 Xil Out32(XPAR_AXI_BRAM CTRL @ S_AXI BASEADDR + num * 4, @x18000060 + num); //
15 T
16
17 for (num = B; num < 15; numt+)
< > 18
o s o - g 19 rev = Xil_In32(XPAR_AXI_BRAM_CTRL_1_S_AXI_BASEADDR + num * 4);
sistant 20 xil_printf("The data at %x is %x \n\r", XPAR_AXI_BRAM CTRL_1_S AXI_BASEADDR + num * 4, re
Emea/Ro% | 2
» [ bram_test_system [System] 23 xil_printf("------ The test is endl------ A\t
B dul Platf 24
ps_module_wrapper [Flatform] o retuen 0;
2 } v
- < >
B Console 57 |2 Problems [ Vidis Log () Guidance Ep P #B-8-=0
Bootgen
~
[INFO]  : Bootimage generated successfully
v

[=] bram test_system

w = v
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Appendix 1 Warranty & Technical Support

Services

MYIR Tech Limited is a global provider of ARM hardware and software tools, design
solutions for embedded applications. We support our customers in a wide range of
services to accelerate your time to market.

MYIR is an ARM Connected Community Member and work closely with ARM and many
semiconductor vendors. We sell products ranging from board level products such as
development boards, single board computers and CPU modules to help with your
evaluation, prototype, and system integration or creating your own applications. Our
products are used widely in industrial control, medical devices, consumer electronic,
telecommunication systems, Human Machine Interface (HMI) and more other embedded
applications. MYIR has an experienced team and provides custom design services based
on ARM processors to help customers make your idea a reality.

The contents below introduce to customers the warranty and technical support services
provided by MYIR as well as the matters needing attention in using MYIR’s products.

Service Guarantee

MYIR regards the product quality as the life of an enterprise. We strictly check and control
the core board design, the procurement of components, production control, product
testing, packaging, shipping and other aspects and strive to provide products with best
guality to customers. We believe that only quality products and excellent services can
ensure the long-term cooperation and mutual benefit.

Price

MYIR insists on providing customers with the most valuable products. We do not pursue
excess profits which we think only for short-time cooperation. Instead, we hope to
establish long-term cooperation and win-win business with customers. So we will offer
reasonable prices in the hope of making the business greater with the customers together
hand in hand.

Delivery Time

MYIR will always keep a certain stock for its regular products. If your order quantity is less
than the amount of inventory, the delivery time would be within three days; if your order
guantity is greater than the number of inventory, the delivery time would be always four to
six weeks. If for any urgent delivery, we can negotiate with customer and try to supply the
goods in advance.
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Technical Support

MYIR has a professional technical support team. Customer can contact us by email
(support@myirtech.com), we will try to reply you within 48 hours. For mass production
and customized products, we will specify person to follow the case and ensure the smooth
production.

After-sale Service

MYIR offers one year free technical support and after-sales maintenance service from the
purchase date. The service covers:
1. Technical support service

a) MYIR offers technical support for the hardware and software materials
which have provided to customers;

b) To help customers compile and run the source code we offer;

c) To help customers solve problems occurred during operations if users
follow the user manual documents;

d) To judge whether the failure exists;

e) To provide free software upgrading service.

However, the following situations are not included in the scope of our free technical
support service:

a) Hardware or software problems occurred during customers’ own
development;

b) Problems occurred when customers compile or run the OS which is tailored
by themselves;

¢) Problems occurred during customers’ own applications development;

d) Problems occurred during the modification of MYIR’s software source code.

2. After-sales maintenance service

The products except LCD, which are not used properly, will take the twelve months free
maintenance service since the purchase date. But following situations are not included in
the scope of our free maintenance service:

a) The warranty period is expired;
b) The customer cannot provide proof-of-purchase or the product has no serial number;
c) The customer has not followed the instruction of the manual which has caused the

damage the product;
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d) Due to the natural disasters (unexpected matters), or natural attrition of the

components, or unexpected matters leads the defects of appearance/function;

e) Due to the power supply, bump, leaking of the roof, pets, moist, impurities into the
boards, all those reasons which have caused the damage of the products or defects of
appearance;

f) Due to unauthorized weld or dismantle parts or repair the products which has caused
the damage of the products or defects of appearance;

g) Due to unauthorized installation of the software, system or incorrect configuration or

computer virus which has caused the damage of products.
Warm tips:

1) MYIR does not supply maintenance service to LCD. We suggest the customer first
check the LCD when receiving the goods. In case the LCD cannot run or no display,
customer should contact MYIR within 7 business days from the moment get the
goods.

2) Please do not use finger nails or hard sharp object to touch the surface of the LCD.

3) MYIR suggests user purchasing a piece of special wiper to wipe the LCD after long
time use, please avoid clean the surface with fingers or hands to leave fingerprint.

4) Do not clean the surface of the screen with chemicals.

5) Please read through the product user manual before you using MYIR’s products.

6) For any maintenance service, customers should communicate with MYIR to confirm
the issue first. MYIR’s support team will judge the failure to see if the goods need to be
returned for repair service, we will issue you RMA number for return maintenance
service after confirmation.

3. Maintenance period and charges

a) MYIR will test the products within three days after receipt of the returned goods and
inform customer the testing result. Then we will arrange shipment within one week for the
repaired goods to the customer. For any special failure, we will negotiate with customers
to confirm the maintenance period.

b) For products within warranty period and caused by quality problem, MYIR offers free
maintenance service; for products within warranty period but out of free maintenance
service scope, MYIR provides maintenance service but shall charge some basic material
cost; for products out of warranty period, MYIR provides maintenance service but shall
charge some basic material cost and handling fee.
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4. Shipping cost

During the warranty period, the shipping cost which delivered to MYIR should be
responsible by user; MYIR will pay for the return shipping cost to users when the product
is repaired. If the warranty period is expired, all the shipping cost will be responsible by
users.

5. Products Life Cycle

MYIR will always select mainstream chips for our design, thus to ensure at least ten years
continuous supply; if meeting some main chip stopping production, we will inform
customers in time and assist customers with products updating and upgrading.

Value-added Services

1. MYIR provides services of driver development base on MYIR'’s products, like serial
port, USB, Ethernet, LCD, etc.

2. MYIR provides the services of OS porting, BSP drivers’ development, API software
development, etc.

3. MYIR provides other products supporting services like power adapter, LCD panel, etc.

4., ODM/OEM services.

MYIR

MYIR Tech Limited
Room 1306, Wensheng Center, Wenjin Plaza,
North Wenjin Road, Luohu District, Shenzhen, China 518020

Support Email: support@myirtech.com

Sales Email: sales@myirtech.com

Phone: +86-755-22984836
Fax: +86-755-25532724

Website: www.myirtech.com

= ®
KIREBF | sales.cn@myirtech.com -/ www.myir-tech.com 139 / 139



mailto:sales.cn@myirtech.com
http://www.myir-tech.com/
mailto:support@myirtech.com
mailto:sales@myirtech.com
http://www.myirtech.com/

	Chapter 1 Hello_World
	1.1 New Vivado Project
	1.2 New Block Design
	1.3 Add PS IP Core and Configure
	1.4 Generate synthesis files
	1.5 Generating top-level file of FPGA
	1.6 Generate bit files
	1.7 Export Hardware Profile
	1.8 Start Vitis and create new project
	1.9 Generate BOOT.bin file

	Chapter 2 gpio_emio
	1.1 Create project and configure IP core of PS
	1.2 Generate synthesis files
	1.3 Generating top-level file of FPGA
	1.4 Adding xdc pin constraints
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New gpio_emio Project
	1.9 Generate BOOT.bin file

	Chapter 3 axi_gpio
	1.1 Create project and configure IP core of PS
	1.2 Add axi_gpio IP core and configure it
	1.3 Generate synthesis files
	1.4 Adding xdc pin constraints
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New axi_gpio Project
	1.9 Generate BOOT.bin file

	Chapter 4 axi_uart
	1.1 Create project and configure IP core of PS
	1.2 Add axi_uart IP core and configure it
	1.3 Generate synthesis files
	1.4 Adding xdc pin constraints
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New axi_uart Project
	1.9 Generate BOOT.bin file

	Chapter 5 bram_test
	1.1 Create project and configure IP core of PS
	1.2 Add Bram and axi_bram_controller cores and configure them
	1.3 Generate synthesis files
	1.4 Generating top-level file of FPGA
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New bram_test Project
	1.9 Generate BOOT.bin file

	Chapter 6 uart_cycle
	1.1 Create project and configure IP core of PS
	1.2 Add axi_uart IP core and configure them
	1.3 Generate synthesis files
	1.4 Generating top-level file of FPGA
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New uart_cycle Project
	1.9 Generate BOOT.bin file

	Chapter 7 dma_loop
	1.1 Add PS IP Core and Configure
	1.2 Add IP Core and Configure
	1.3 Generate synthesis files
	1.4 Generating top-level file of FPGA
	1.5 Generate bit files
	1.6 Export Hardware Profile
	1.7 Launch Vitis and create new platform project
	1.8 New dma_loop Project
	1.9 Generate BOOT.bin file

	Appendix 1 Warranty & Technical Support Services

